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Chapter 1. About IBM SPSS Modeler

IBM® SPSS® Modeler is a set of data mining tools that enable you to quickly develop predictive models
using business expertise and deploy them into business operations to improve decision making. Designed
around the industry-standard CRISP-DM model, IBM SPSS Modeler supports the entire data mining
process, from data to better business results.

IBM SPSS Modeler offers a variety of modeling methods taken from machine learning, artificial
intelligence, and statistics. The methods available on the Modeling palette allow you to derive new
information from your data and to develop predictive models. Each method has certain strengths and is
best suited for particular types of problems.

SPSS Modeler can be purchased as a standalone product, or used as a client in combination with SPSS
Modeler Server. A number of additional options are also available, as summarized in the following
sections. For more information, see |http://www.ibm.com/software/analytics/spss/products/modeler /}

IBM SPSS Modeler Products

The IBM SPSS Modeler family of products and associated software comprises the following.
* IBM SPSS Modeler

* IBM SPSS Modeler Server

* IBM SPSS Modeler Administration Console

* IBM SPSS Modeler Batch

* IBM SPSS Modeler Solution Publisher

* IBM SPSS Modeler Server adapters for IBM SPSS Collaboration and Deployment Services

IBM SPSS Modeler

SPSS Modeler is a functionally complete version of the product that you install and run on your personal
computer. You can run SPSS Modeler in local mode as a standalone product, or use it in distributed
mode along with IBM SPSS Modeler Server for improved performance on large data sets.

With SPSS Modeler, you can build accurate predictive models quickly and intuitively, without
programming. Using the unique visual interface, you can easily visualize the data mining process. With
the support of the advanced analytics embedded in the product, you can discover previously hidden
patterns and trends in your data. You can model outcomes and understand the factors that influence
them, enabling you to take advantage of business opportunities and mitigate risks.

SPSS Modeler is available in two editions: SPSS Modeler Professional and SPSS Modeler Premium. See
the topic ['IBM SPSS Modeler Editions” on page 2| for more information.

IBM SPSS Modeler Server

SPSS Modeler uses a client/server architecture to distribute requests for resource-intensive operations to
powerful server software, resulting in faster performance on larger data sets.

SPSS Modeler Server is a separately-licensed product that runs continually in distributed analysis mode
on a server host in conjunction with one or more IBM SPSS Modeler installations. In this way, SPSS
Modeler Server provides superior performance on large data sets because memory-intensive operations
can be done on the server without downloading data to the client computer. IBM SPSS Modeler Server
also provides support for SQL optimization and in-database modeling capabilities, delivering further
benefits in performance and automation.

© Copyright IBM Corporation 1994, 2015 1
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IBM SPSS Modeler Administration Console

The Modeler Administration Console is a graphical application for managing many of the SPSS Modeler
Server configuration options, which are also configurable by means of an options file. The application
provides a console user interface to monitor and configure your SPSS Modeler Server installations, and is
available free-of-charge to current SPSS Modeler Server customers. The application can be installed only
on Windows computers; however, it can administer a server installed on any supported platform.

IBM SPSS Modeler Batch

While data mining is usually an interactive process, it is also possible to run SPSS Modeler from a
command line, without the need for the graphical user interface. For example, you might have
long-running or repetitive tasks that you want to perform with no user intervention. SPSS Modeler Batch
is a special version of the product that provides support for the complete analytical capabilities of SPSS
Modeler without access to the regular user interface. SPSS Modeler Server is required to use SPSS
Modeler Batch.

IBM SPSS Modeler Solution Publisher

SPSS Modeler Solution Publisher is a tool that enables you to create a packaged version of an SPSS
Modeler stream that can be run by an external runtime engine or embedded in an external application. In
this way, you can publish and deploy complete SPSS Modeler streams for use in environments that do
not have SPSS Modeler installed. SPSS Modeler Solution Publisher is distributed as part of the IBM SPSS
Collaboration and Deployment Services - Scoring service, for which a separate license is required. With
this license, you receive SPSS Modeler Solution Publisher Runtime, which enables you to execute the
published streams.

For more information about SPSS Modeler Solution Publisher, see the IBM SPSS Collaboration and
Deployment Services documentation. The IBM SPSS Collaboration and Deployment Services Knowledge
Center contains sections called "IBM SPSS Modeler Solution Publisher" and "IBM SPSS Analytics Toolkit."

IBM SPSS Modeler Server Adapters for IBM SPSS Collaboration and
Deployment Services

A number of adapters for IBM SPSS Collaboration and Deployment Services are available that enable
SPSS Modeler and SPSS Modeler Server to interact with an IBM SPSS Collaboration and Deployment
Services repository. In this way, an SPSS Modeler stream deployed to the repository can be shared by

multiple users, or accessed from the thin-client application IBM SPSS Modeler Advantage. You install the
adapter on the system that hosts the repository.

IBM SPSS Modeler Editions

SPSS Modeler is available in the following editions.
SPSS Modeler Professional

SPSS Modeler Professional provides all the tools you need to work with most types of structured data,
such as behaviors and interactions tracked in CRM systems, demographics, purchasing behavior and
sales data.

SPSS Modeler Premium

SPSS Modeler Premium is a separately-licensed product that extends SPSS Modeler Professional to work
with specialized data such as that used for entity analytics or social networking, and with unstructured
text data. SPSS Modeler Premium comprises the following components.

IBM SPSS Modeler Entity Analytics adds an extra dimension to IBM SPSS Modeler predictive analytics.
Whereas predictive analytics attempts to predict future behavior from past data, entity analytics focuses
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on improving the coherence and consistency of current data by resolving identity conflicts within the
records themselves. An identity can be that of an individual, an organization, an object, or any other
entity for which ambiguity might exist. Identity resolution can be vital in a number of fields, including
customer relationship management, fraud detection, anti-money laundering, and national and
international security.

IBM SPSS Modeler Social Network Analysis transforms information about relationships into fields that
characterize the social behavior of individuals and groups. Using data describing the relationships
underlying social networks, IBM SPSS Modeler Social Network Analysis identifies social leaders who
influence the behavior of others in the network. In addition, you can determine which people are most
affected by other network participants. By combining these results with other measures, you can create
comprehensive profiles of individuals on which to base your predictive models. Models that include this
social information will perform better than models that do not.

IBM SPSS Modeler Text Analytics uses advanced linguistic technologies and Natural Language
Processing (NLP) to rapidly process a large variety of unstructured text data, extract and organize the key
concepts, and group these concepts into categories. Extracted concepts and categories can be combined
with existing structured data, such as demographics, and applied to modeling using the full suite of IBM
SPSS Modeler data mining tools to yield better and more focused decisions.

IBM SPSS Modeler Documentation

Documentation in online help format is available from the Help menu of SPSS Modeler. This includes
documentation for SPSS Modeler, SPSS Modeler Server, as well as the Applications Guide (also referred
to as the Tutorial), and other supporting materials.

Complete documentation for each product (including installation instructions) is available in PDF format
under the \Documentation folder on each product DVD. Installation documents can also be downloaded
from the web at fhttp:/ /www.ibm.com /support/docview.wss?uid=swg27046116,

Documentation in both formats is also available from the SPSS Modeler Knowledge Center at
http:/ /www-01.ibm.com /support/knowledgecenter /SS3RA7_17.1.0}

SPSS Modeler Professional Documentation
The SPSS Modeler Professional documentation suite (excluding installation instructions) is as follows.

+ IBM SPSS Modeler User's Guide. General introduction to using SPSS Modeler, including how to
build data streams, handle missing values, build CLEM expressions, work with projects and reports,
and package streams for deployment to IBM SPSS Collaboration and Deployment Services, Predictive
Applications, or IBM SPSS Modeler Advantage.

+ IBM SPSS Modeler Source, Process, and Output Nodes. Descriptions of all the nodes used to read,
process, and output data in different formats. Effectively this means all nodes other than modeling
nodes.

* IBM SPSS Modeler Modeling Nodes. Descriptions of all the nodes used to create data mining
models. IBM SPSS Modeler offers a variety of modeling methods taken from machine learning,
artificial intelligence, and statistics.

+ IBM SPSS Modeler Algorithms Guide. Descriptions of the mathematical foundations of the modeling
methods used in IBM SPSS Modeler. This guide is available in PDF format only.

» IBM SPSS Modeler Applications Guide. The examples in this guide provide brief, targeted
introductions to specific modeling methods and techniques. An online version of this guide is also
available from the Help menu. See the topic [“Application Examples” on page 4| for more information.

* IBM SPSS Modeler Python Scripting and Automation. Information on automating the system
through Python scripting, including the properties that can be used to manipulate nodes and streams.
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IBM SPSS Modeler Deployment Guide. Information on running IBM SPSS Modeler streams and
scenarios as steps in processing jobs under IBM SPSS Collaboration and Deployment Services
Deployment Manager.

» IBM SPSS Modeler CLEF Developer's Guide. CLEF provides the ability to integrate third-party
programs such as data processing routines or modeling algorithms as nodes in IBM SPSS Modeler.

* IBM SPSS Modeler In-Database Mining Guide. Information on how to use the power of your
database to improve performance and extend the range of analytical capabilities through third-party
algorithms.

* IBM SPSS Modeler Server Administration and Performance Guide. Information on how to configure
and administer IBM SPSS Modeler Server.

* IBM SPSS Modeler Administration Console User Guide. Information on installing and using the
console user interface for monitoring and configuring IBM SPSS Modeler Server. The console is
implemented as a plug-in to the Deployment Manager application.

* IBM SPSS Modeler CRISP-DM Guide. Step-by-step guide to using the CRISP-DM methodology for
data mining with SPSS Modeler.

* IBM SPSS Modeler Batch User's Guide. Complete guide to using IBM SPSS Modeler in batch mode,

including details of batch mode execution and command-line arguments. This guide is available in

PDF format only.

SPSS Modeler Premium Documentation
The SPSS Modeler Premium documentation suite (excluding installation instructions) is as follows.

» IBM SPSS Modeler Entity Analytics User Guide. Information on using entity analytics with SPSS
Modeler, covering repository installation and configuration, entity analytics nodes, and administrative
tasks.

* IBM SPSS Modeler Social Network Analysis User Guide. A guide to performing social network
analysis with SPSS Modeler, including group analysis and diffusion analysis.

* SPSS Modeler Text Analytics User's Guide. Information on using text analytics with SPSS Modeler,
covering the text mining nodes, interactive workbench, templates, and other resources.

Application Examples

While the data mining tools in SPSS Modeler can help solve a wide variety of business and
organizational problems, the application examples provide brief, targeted introductions to specific
modeling methods and techniques. The data sets used here are much smaller than the enormous data
stores managed by some data miners, but the concepts and methods involved should be scalable to
real-world applications.

You can access the examples by clicking Application Examples on the Help menu in SPSS Modeler. The
data files and sample streams are installed in the Demos folder under the product installation directory.
See the topic ["Demos Folder”| for more information.

Database modeling examples. See the examples in the IBM SPSS Modeler In-Database Mining Guide.

Scripting examples. See the examples in the IBM SPSS Modeler Scripting and Automation Guide.

Demos Folder

The data files and sample streams used with the application examples are installed in the Demos folder
under the product installation directory. This folder can also be accessed from the IBM SPSS

Modeler program group on the Windows Start menu, or by clicking Demos on the list of recent
directories in the File Open dialog box.
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Chapter 2. IBM SPSS Modeler Overview

Getting Started

As a data mining application, IBM SPSS Modeler offers a strategic approach to finding useful
relationships in large data sets. In contrast to more traditional statistical methods, you do not necessarily
need to know what you are looking for when you start. You can explore your data, fitting different
models and investigating different relationships, until you find useful information.

Starting IBM SPSS Modeler

To start the application, click:
Start > [All] Programs > IBM SPSS Modeler 17.1 > IBM SPSS Modeler 17.1

The main window is displayed after a few seconds.

File  Edit Inzert “iew Tools  Superblode  Window
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Figure 1. IBM SPSS Modeler main application window

Launching from the Command Line
You can use the command line of your operating system to launch IBM SPSS Modeler as follows:
1. On a computer where IBM SPSS Modeler is installed, open a DOS, or command-prompt, window.
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2. To launch the IBM SPSS Modeler interface in interactive mode, type the modelerclient command
followed by the required arguments; for example:

modelerclient -stream report.str -execute

The available arguments (flags) allow you to connect to a server, load streams, run scripts, or specify
other parameters as needed.

Connecting to IBM SPSS Modeler Server

IBM SPSS Modeler can be run as a standalone application, or as a client connected to IBM SPSS Modeler
Server directly or to an IBM SPSS Modeler Server or server cluster through the Coordinator of Processes
plug-in from IBM SPSS Collaboration and Deployment Services. The current connection status is
displayed at the bottom left of the IBM SPSS Modeler window.

Whenever you want to connect to a server, you can manually enter the server name to which you want
to connect or select a name that you have previously defined. However, if you have IBM SPSS
Collaboration and Deployment Services, you can search through a list of servers or server clusters from
the Server Login dialog box. The ability to browse through the Statistics services running on a network is
made available through the Coordinator of Processes.

To Connect to a Server

1. On the Tools menu, click Server Login. The Server Login dialog box opens. Alternatively, double-click
the connection status area of the IBM SPSS Modeler window.

2. Using the dialog box, specify options to connect to the local server computer or select a connection
from the table.

* Click Add or Edit to add or edit a connection. See the topic[’Adding and Editing the IBM SPSS|
[Modeler Server Connection” on page 7| for more information.

* Click Search to access a server or server cluster in the Coordinator of Processes. See the topic
[‘Searching for Servers in IBM SPSS Collaboration and Deployment Services” on page 7] for more
information.

Server table. This table contains the set of defined server connections. The table displays the default
connection, server name, description, and port number. You can manually add a new connection, as
well as select or search for an existing connection. To set a particular server as the default connection,
select the check box in the Default column in the table for the connection.

Default data path. Specify a path used for data on the server computer. Click the ellipsis button (...)
to browse to the required location.

Set Credentials. Leave this box unchecked to enable the single sign-on feature, which attempts to log
you in to the server using your local computer username and password details. If single sign-on is
not possible, or if you check this box to disable single sign-on (for example, to log in to an
administrator account), the following fields are enabled for you to enter your credentials.

User ID. Enter the user name with which to log on to the server.
Password. Enter the password associated with the specified user name.

Domain. Specify the domain used to log on to the server. A domain name is required only when the
server computer is in a different Windows domain than the client computer.

3. Click OK to complete the connection.

To Disconnect from a Server

1. On the Tools menu, click Server Login. The Server Login dialog box opens. Alternatively, double-click
the connection status area of the IBM SPSS Modeler window.

2. In the dialog box, select the Local Server and click OK.
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Adding and Editing the IBM SPSS Modeler Server Connection

You can manually edit or add a server connection in the Server Login dialog box. By clicking Add, you
can access an empty Add/Edit Server dialog box in which you can enter server connection details. By
selecting an existing connection and clicking Edit in the Server Login dialog box, the Add/Edit Server
dialog box opens with the details for that connection so that you can make any changes.

Note: You cannot edit a server connection that was added from IBM SPSS Collaboration and Deployment
Services, since the name, port, and other details are defined in IBM SPSS Collaboration and Deployment
Services. Best practice dictates that the same ports should be used to communicate with both IBM SPSS
Collaboration and Deployment Services and SPSS Modeler Client. These can be set as max_server_port
and min_server_port in the options.cfg file.

To Add Server Connections
1. On the Tools menu, click Server Login. The Server Login dialog box opens.
2. In this dialog box, click Add. The Server Login Add/Edit Server dialog box opens.

3. Enter the server connection details and click OK to save the connection and return to the Server
Login dialog box.
* Server. Specify an available server or select one from the list. The server computer can be identified by

an alphanumeric name (for example, myserver) or an IP address assigned to the server computer (for
example, 202.123.456.78).

* Port. Give the port number on which the server is listening. If the default does not work, ask your
system administrator for the correct port number.

* Description. Enter an optional description for this server connection.

* Ensure secure connection (use SSL). Specifies whether an SSL (Secure Sockets Layer) connection
should be used. SSL is a commonly used protocol for securing data sent over a network. To use this
feature, SSL must be enabled on the server hosting IBM SPSS Modeler Server. If necessary, contact your
local administrator for details.

To Edit Server Connections
1. On the Tools menu, click Server Login. The Server Login dialog box opens.

2. In this dialog box, select the connection you want to edit and then click Edit. The Server Login
Add/Edit Server dialog box opens.

3. Change the server connection details and click OK to save the changes and return to the Server Login
dialog box.

Searching for Servers in IBM SPSS Collaboration and Deployment Services

Instead of entering a server connection manually, you can select a server or server cluster available on the
network through the Coordinator of Processes, available in IBM SPSS Collaboration and Deployment
Services. A server cluster is a group of servers from which the Coordinator of Processes determines the
server best suited to respond to a processing request.

Although you can manually add servers in the Server Login dialog box, searching for available servers
lets you connect to servers without requiring that you know the correct server name and port number.

This information is automatically provided. However, you still need the correct logon information, such
as username, domain, and password.

Note: If you do not have access to the Coordinator of Processes capability, you can still manually enter the
server name to which you want to connect or select a name that you have previously defined. See the
topic [“Adding and Editing the IBM SPSS Modeler Server Connection”| for more information.

To search for servers and clusters
1. On the Tools menu, click Server Login. The Server Login dialog box opens.
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2. In this dialog box, click Search to open the Search for Servers dialog box. If you are not logged on to
IBM SPSS Collaboration and Deployment Services when you attempt to browse the Coordinator of
Processes, you will be prompted to do so.

3. Select the server or server cluster from the list.
4. Click OK to close the dialog box and add this connection to the table in the Server Login dialog box.

Changing the Temp Directory

Some operations performed by IBM SPSS Modeler Server may require temporary files to be created. By
default, IBM SPSS Modeler uses the system temporary directory to create temp files. You can alter the
location of the temporary directory using the following steps.

1. Create a new directory called spss and subdirectory called servertemp.

2. Edit options.cfg, located in the /config directory of your IBM SPSS Modeler installation directory. Edit
the temp_directory parameter in this file to read: temp_directory, "C:/spss/servertemp".

3. After doing this, you must restart the IBM SPSS Modeler Server service. You can do this by clicking
the Services tab on your Windows Control Panel. Just stop the service and then start it to activate the
changes you made. Restarting the machine will also restart the service.

All temp files will now be written to this new directory.

Note: The most common error when you are attempting to do this is to use the wrong type of slashes;
forward slashes are used.

Starting Multiple IBM SPSS Modeler Sessions

If you need to launch more than one IBM SPSS Modeler session at a time, you must make some changes
to your IBM SPSS Modeler and Windows settings. For example, you may need to do this if you have two
separate server licenses and want to run two streams against two different servers from the same client
machine.

To enable multiple IBM SPSS Modeler sessions:
1. Click:
Start > [All] Programs > IBM SPSS Modeler 17.1
2. On the IBM SPSS Modeler 17.1 shortcut (the one with the icon), right-click and select Properties.
In the Target text box, add -noshare to the end of the string.

w

4. In Windows Explorer, select:
Tools > Folder Options...
5. On the File Types tab, select the IBM SPSS Modeler Stream option and click Advanced.
In the Edit File Type dialog box, select Open with IBM SPSS Modeler and click Edit.
7. In the Application used to perform action text box, add -noshare before the -stream argument.

o

IBM SPSS Modeler Interface at a Glance

At each point in the data mining process, the easy-to-use IBM SPSS Modeler interface invites your
specific business expertise. Modeling algorithms, such as prediction, classification, segmentation, and
association detection, ensure powerful and accurate models. Model results can easily be deployed and
read into databases, IBM SPSS Statistics, and a wide variety of other applications.

Working with IBM SPSS Modeler is a three-step process of working with data.
* First, you read data into IBM SPSS Modeler.

* Next, you run the data through a series of manipulations.

* Finally, you send the data to a destination.
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This sequence of operations is known as a data stream because the data flows record by record from the
source through each manipulation and, finally, to the destination--either a model or type of data output.

-9 -0 -3

War. File Derive Select Tahle

Figure 2. A simple stream

IBM SPSS Modeler Stream Canvas

The stream canvas is the largest area of the IBM SPSS Modeler window and is where you will build and
manipulate data streams.

File  Edt Insert “iew Toolz Superfode  Window  Help

EEL PR TN T X e Al

e

VN

Dy Mav. K

—@ — A

CRIZP-DM

DRUG1R Na_to_K \ Na_to_K B (& (unsaved projech
; Iil Business Under:

ﬁfl Data Understanding
I:ﬂ Data Preparation
Iﬁ hadeling

] Evaluation

7] Deployment

Fatient Records

1]

|p|_ 4 F

2 Favorites || 4

Database  Var. File

® e

Select Sample  Aggregate

Auto Classifier Auto Numeric Auto Cluster

®

Auto Data Prep

®® e

Derive Type Filter

Graphboard

= B E

Table Flat File  Dat

Figure 3. IBM SPSS Modeler workspace (default view)

Streams are created by drawing diagrams of data operations relevant to your business on the main
canvas in the interface. Each operation is represented by an icon or node, and the nodes are linked
together in a stream representing the flow of data through each operation.

You can work with multiple streams at one time in IBM SPSS Modeler, either in the same stream canvas

or by opening a new stream canvas. During a session, streams are stored in the Streams manager, at the
upper right of the IBM SPSS Modeler window.
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Nodes Palette

Most of the data and modeling tools in IBM SPSS Modeler reside in the Nodes Palette, across the bottom
of the window below the stream canvas.

For example, the Record Ops palette tab contains nodes that you can use to perform operations on the
data records, such as selecting, merging, and appending.

To add nodes to the canvas, double-click icons from the Nodes Palette or drag and drop them onto the
canvas. You then connect them to create a stream, representing the flow of data.

L Favortes | @ Sources @ Record Ops || @ Field Ops | Mk Graphs | @ Modeling || @ Database Modeling | Bl Output | B Export 3} IBME SPSSE Statistics

L
> » > 3> = & O O &
Select Sample Balance Aggregate RFM Aggregate Sort herge Append Cristinct

Figure 4. Record Ops tab on the nodes palette

Each palette tab contains a collection of related nodes used for different phases of stream operations, such
as:

* Sources. Nodes bring data into IBM SPSS Modeler.
* Record Ops. Nodes perform operations on data records, such as selecting, merging, and appending.

* Field Ops. Nodes perform operations on data fields, such as filtering, deriving new fields, and
determining the measurement level for given fields.

* Graphs. Nodes graphically display data before and after modeling. Graphs include plots, histograms,
web nodes, and evaluation charts.

* Modeling. Nodes use the modeling algorithms available in IBM SPSS Modeler, such as neural nets,
decision trees, clustering algorithms, and data sequencing.

* Database Modeling. Nodes use the modeling algorithms available in Microsoft SQL Server, IBM DB2,
and Oracle and Netezza databases.

* Output. Nodes produce a variety of output for data, charts, and model results that can be viewed in
IBM SPSS Modeler.

* Export. Nodes produce a variety of output that can be viewed in external applications, such as IBM
SPSS Data Collection or Excel.

IBM SPSS Statistics. Nodes import data from, or export data to, IBM SPSS Statistics, as well as
running IBM SPSS Statistics procedures.

As you become more familiar with IBM SPSS Modeler, you can customize the palette contents for your
own use.

On the left side of the Nodes Palette, you can filter the nodes that display by selecting Analytic Server,
Classification, Association, or Segmentation. See [Overview of Modeling Nodes| for more information.

Located below the Nodes Palette, a report pane provides feedback on the progress of various operations,
such as when data is being read into the data stream. Also located below the Nodes Palette, a status pane
provides information on what the application is currently doing, as well as indications of when user
feedback is required.

IBM SPSS Modeler Managers

At the top right of the window is the managers pane. This has three tabs, which are used to manage
streams, output and models.
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You can use the Streams tab to open, rename, save, and delete the streams created in a session.

£

! | sveans | outps | wasess
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Figure 5. Streams tab
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Figure 6. Outputs tab

The Outputs tab contains a variety of files, such as graphs and tables, produced by stream operations in

IBM SPSS Modeler. You can display, save, rename, and close the tables, graphs, and reports listed on this

tab.

Figure 7. Models tab containing model nuggets

The Models tab is the most powerful of the manager tabs. This tab contains all model nuggets, which

contain the models generated in IBM SPSS Modeler, for the current session. These models can be browsed

directly from the Models tab or added to the stream in the canvas.

Chapter 2. IBM SPSS Modeler Overview
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IBM SPSS Modeler Projects

On the lower right side of the window is the project pane, used to create and manage data mining
projects (groups of files related to a data mining task). There are two ways to view projects you create in
IBM SPSS Modeler—in the Classes view and the CRISP-DM view.

.

I CRISP-DM | Classes |

Bl [ (unsaved project)
El - Business Understanding

'Lﬂ drug

'5__1!1 Patient Records (G fields, 200 records)
() Distribution of Drug

-+ Data Understanding

-[-—| Data Preparation

-] Modeling

- [= | Evaluation

== | Deployment

Figure 8. CRISP-DM view

The CRISP-DM tab provides a way to organize projects according to the Cross-Industry Standard Process
for Data Mining, an industry-proven, nonproprietary methodology. For both experienced and first-time
data miners, using the CRISP-DM tool will help you to better organize and communicate your efforts.

| CRISP-DM | Classes |

B [ (unzaved praject)
E||_‘| Streams
;\a drug
|_'| Modes
e[ enerated Models

E||_'| Takles, Graphs & Reports

----- \_-_TI Patient Records (8 fields, 200 recards)

© ) Distribution of Drug
e [] Other

Figure 9. Classes view

The Classes tab provides a way to organize your work in IBM SPSS Modeler categorically—by the types
of objects you create. This view is useful when taking inventory of data, streams, and models.

IBM SPSS Modeler Toolbar

At the top of the IBM SPSS Modeler window, you will find a toolbar of icons that provides a number of
useful functions. Following are the toolbar buttons and their functions.

oy :
Create new stream - Open stream
I—: I_'
; )
H Save stream [—J Print current stream
1 "
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Cut & move to clipboard
o0

.

=5 Paste selection

/ﬁ Redo

Edit stream properties

Run current stream

i v ©®@ B |5

stream is running)

Zoom in (SuperNodes only)

0 Stop stream (Active only while

)

L
No markup in stream
C— —
, . [k
j Hide stream markup (if any) 1
s =
£ > Open stream in IBM SPSS Modeler
4 Advantage

Copy to clipboard

Undo last action

Search for nodes

Preview SQL generation

Run stream selection

Add SuperNode

Zoom out (SuperNodes only)

Insert comment

Show hidden stream markup

Stream markup consists of stream comments, model links, and scoring branch indications.

Model links are described in the IBM SPSS Modeling Nodes guide.

Customizing the Toolbar

You can change various aspects of the toolbar, such as:
* Whether it is displayed

* Whether the icons have tooltips available

* Whether it uses large or small icons

To turn the toolbar display on and off:
1. On the main menu, click:
View > Toolbar > Display

Chapter 2. IBM SPSS Modeler Overview
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To change the tooltip or icon size settings:
1. On the main menu, click:
View > Toolbar > Customize

Click Show ToolTips or Large Buttons as required.

Customizing the IBM SPSS Modeler Window

Using the dividers between various portions of the IBM SPSS Modeler interface, you can resize or close
tools to meet your preferences. For example, if you are working with a large stream, you can use the
small arrows located on each divider to close the nodes palette, managers pane, and project pane. This
maximizes the stream canvas, providing enough work space for large or multiple streams.

Alternatively, on the View menu, click Nodes Palette, Managers, or Project to turn the display of these
items on or off.

File  Ecit Insert “iew Tools Superbode  Window  Help

NEHS AR BE QP e T2 G
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@ G G

Sr Sart Sr
EEEE _ FEE

Transactional Data EEE | Binned and Scored Da..

Aggregated Data

-

4 3

| [ Server: Local Server 1 | 235ME [ 41EME

Figure 10. Maximized stream canvas
As an alternative to closing the nodes palette, and the managers and project panes, you can use the

stream canvas as a scrollable page by moving vertically and horizontally with the scrollbars at the side
and bottom of the IBM SPSS Modeler window.

You can also control the display of screen markup, which consists of stream comments, model links, and
scoring branch indications. To turn this display on or off, click:

View > Stream Markup
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Changing the icon size for a stream

You can change the size of the stream icons in the following ways.
* Through a stream property setting

* Through a pop-up menu in the stream

* Using the keyboard

You can scale the entire stream view to one of a number of sizes between 8% and 200% of the standard
icon size.

To scale the entire stream (stream properties method)
1. From the main menu, choose

Tools > Stream Properties > Options > Layout.
2. Choose the size you want from the Icon Size menu.
3. Click Apply to see the result.
4. Click OK to save the change.

To scale the entire stream (menu method)
1. Right-click the stream background on the canvas.
2. Choose Icon Size and select the size you want.

To scale the entire stream (keyboard method)
1. Press Ctrl + [-] on the main keyboard to zoom out to the next smaller size.
2. Press Ctrl + Shift + [+] on the main keyboard to zoom in to the next larger size.

This feature is particularly useful for gaining an overall view of a complex stream. You can also use it to
minimize the number of pages needed to print a stream.

Using the Mouse in IBM SPSS Modeler

The most common uses of the mouse in IBM SPSS Modeler include the following:

* Single-click. Use either the right or left mouse button to select options from menus, open pop-up
menus, and access various other standard controls and options. Click and hold the button to move and
drag nodes.

* Double-click. Double-click using the left mouse button to place nodes on the stream canvas and edit
existing nodes.

* Middle-click. Click the middle mouse button and drag the cursor to connect nodes on the stream
canvas. Double-click the middle mouse button to disconnect a node. If you do not have a three-button
mouse, you can simulate this feature by pressing the Alt key while clicking and dragging the mouse.

Using Shortcut Keys

Many visual programming operations in IBM SPSS Modeler have shortcut keys associated with them. For
example, you can delete a node by clicking the node and pressing the Delete key on your keyboard.
Likewise, you can quickly save a stream by pressing the S key while holding down the Ctrl key. Control
commands like this one are indicated by a combination of Ctrl and another key--for example, Ctrl+S.

There are a number of shortcut keys used in standard Windows operations, such as Ctrl+X to cut. These
shortcuts are supported in IBM SPSS Modeler along with the following application-specific shortcuts.

Note: In some cases, old shortcut keys used in IBM SPSS Modeler conflict with standard Windows

shortcut keys. These old shortcuts are supported with the addition of the Alt key. For example,
Ctrl+Alt+C can be used to toggle the cache on and off.

Chapter 2. IBM SPSS Modeler Overview 15



Table 1. Supported shortcut keys

Shortcut Key Function

Ctrl+A Select all

Ctrl+X Cut

Ctrl+N New stream

Ctrl+O Open stream

Ctrl+P Print

Ctrl+C Copy

Ctrl+V Paste

Ctrl+Z Undo

Ctrl+Q Select all nodes downstream of the selected node
Ctrl+W Deselect all downstream nodes (toggles with Ctrl+Q)
Ctrl+E Run from selected node

Ctrl+S Save current stream

Alt+Arrow keys Move selected nodes on the stream canvas in the direction of the arrow used
Shift+F10 Open the pop-up menu for the selected node

Table 2. Supported shortcuts for old hot keys

Shortcut Key Function

Ctrl+Alt+D Duplicate node
Ctrl+Alt+L Load node

Ctrl+Alt+R Rename node
Ctrl+Alt+U Create User Input node
Ctrl+Alt+C Toggle cache on/off
Ctrl+Alt+F Flush cache

Ctrl+Alt+X Expand SuperNode
Ctrl+Alt+Z Zoom in/zoom out
Delete Delete node or connection
Printing

The following objects can be printed in IBM SPSS Modeler:

* Stream diagrams

* Graphs

* Tables

* Reports (from the Report node and Project Reports)

* Scripts (from the stream properties, Standalone Script, or SuperNode script dialog boxes)
* Models (Model browsers, dialog box tabs with current focus, tree viewers)

* Annotations (using the Annotations tab for output)

To print an object:

* To print without previewing, click the Print button on the toolbar.

* To set up the page before printing, select Page Setup from the File menu.
* To preview before printing, select Print Preview from the File menu.
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* To view the standard print dialog box with options for selecting printers, and specifying appearance
options, select Print from the File menu.

Automating IBM SPSS Modeler

Since advanced data mining can be a complex and sometimes lengthy process, IBM SPSS Modeler
includes several types of coding and automation support.

* Control Language for Expression Manipulation (CLEM) is a language for analyzing and
manipulating the data that flows along IBM SPSS Modeler streams. Data miners use CLEM extensively
in stream operations to perform tasks as simple as deriving profit from cost and revenue data or as
complex as transforming web log data into a set of fields and records with usable information.

* Scripting is a powerful tool for automating processes in the user interface. Scripts can perform the
same kinds of actions that users perform with a mouse or a keyboard. You can also specify output and
manipulate generated models.
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Chapter 3. Introduction to Modeling

A model is a set of rules, formulas, or equations that can be used to predict an outcome based on a set of
input fields or variables. For example, a financial institution might use a model to predict whether loan
applicants are likely to be good or bad risks, based on information that is already known about past
applicants.

The ability to predict an outcome is the central goal of predictive analytics, and understanding the

modeling process is the key to using IBM SPSS Modeler.

Credit rating

|_Categary % i
" Bad 40.944 ?035
18 Good 59.056 1014 |
1 Total 1DDBDD1?1?E
_____________ I__________.I_:'

Income level
Adj. P-value=0.000, Chi-square=481.188, df=2

HTh ij MeTum
Made 1 Maode 2 Maode 3
Category . % n Category . % n Category . % il
Bad 10969 &0 Bad 83378 311 Ead 41656 332
B Good 899.031 487 B Googd 16622 B2 B Googd 58.344 465
Tatal 31.858 847 Tatal 21.724 373 Total 46418 FO7
T T— T T<

Figure 11. A simple decision tree model

This example uses a decision tree model, which classifies records (and predicts a response) using a series
of decision rules, for example:

IF income = Medium
AND cards <5
THEN -> 'Good'

While this example uses a CHAID (Chi-squared Automatic Interaction Detection) model, it is intended as
a general introduction, and most of the concepts apply broadly to other modeling types in IBM SPSS
Modeler.

To understand any model, you first need to understand the data that go into it. The data in this example
contain information about the customers of a bank. The following fields are used:

Field name Description

Credit_rating Credit rating: 0=Bad, 1=Good, 9=missing values

Age Age in years

Income Income level: 1=Low, 2=Medium, 3=High

Credit_cards Number of credit cards held: 1=Less than five, 2=Five or more
Education Level of education: 1=High school, 2=College

Car_loans Number of car loans taken out: 1=None or one, 2=More than two
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The bank maintains a database of historical information on customers who have taken out loans with the
bank, including whether or not they repaid the loans (Credit rating = Good) or defaulted (Credit rating =
Bad). Using this existing data, the bank wants to build a model that will enable them to predict how
likely future loan applicants are to default on the loan.

Using a decision tree model, you can analyze the characteristics of the two groups of customers and
predict the likelihood of loan defaults.

This example uses the stream named modelingintro.str, available in the Demos folder under the streams
subfolder. The data file is tree_credit.sav. See the topic [“Demos Folder” on page 4 for more information.

Let's take a look at the stream.
1. Choose the following from the main menu:
File > Open Stream
2. Click the gold nugget icon on the toolbar of the Open dialog box and choose the Demos folder.
3. Double-click the streams folder.
4. Double-click the file named modelingintro.str.

Building the Stream

@

— (2

tree_credit.sav Type Creditrating

Tahle

Q

Analysis

Figure 12. Modeling stream

To build a stream that will create a model, we need at least three elements:

¢ A source node that reads in data from some external source, in this case an IBM SPSS Statistics data
file.

* A source or Type node that specifies field properties, such as measurement level (the type of data that
the field contains), and the role of each field as a target or input in modeling.

* A modeling node that generates a model nugget when the stream is run.
In this example, we're using a CHAID modeling node. CHAID, or Chi-squared Automatic Interaction
Detection, is a classification method that builds decision trees by using a particular type of statistics

known as chi-square statistics to work out the best places to make the splits in the decision tree.

If measurement levels are specified in the source node, the separate Type node can be eliminated.
Functionally, the result is the same.
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This stream also has Table and Analysis nodes that will be used to view the scoring results after the

model nugget has been created and added to the stream.

The Statistics File source node reads data in IBM SPSS Statistics format from the tree_credit.sav data file,

which is installed in the Demos folder. (A special variable named $CLEO_DEMOS is used to reference this
folder under the current IBM SPSS Modeler installation. This ensures the path will be valid regardless of

the current installation folder or version.)

O tree_credit.sav

- ' [} _P_review] [ @ Refre_sh]

$CLEO_DEMOSHree_credt.sav

Data Fiter  Types  Annotations

Vatizhle names: (O Read names and labelz @ Read labels as names

Yalues: ©) Read data and kabels @ Read labels as data

[i Use field formst information to determine storage

-

Import file:  [FCLEC_DEMOSHree_credt sav | B

Figure 13. Reading data with a Statistics File source node

The Type node specifies the measurement level for each field. The measurement level is a category that

indicates the type of data in the field. Our source data file uses three different measurement levels.

A Continuous field (such as the Age field) contains continuous numeric values, while a Nominal field

(such as the Credit rating field) has two or more distinct values, for example Bad, Good, or No credit history.
An Ordinal field (such as the Income level field) describes data with multiple distinct values that have an

inherent order—in this case Low, Medium and High.

Chapter 3. Introduction to Modeling
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Figure 14. Setting the target and input fields with the Type node

For each field, the Type node also specifies a role, to indicate the part that each field plays in modeling.
The role is set to Target for the field Credit rating, which is the field that indicates whether or not a given
customer defaulted on the loan. This is the target, or the field for which we want to predict the value.

Role is set to Input for the other fields. Input fields are sometimes known as predictors, or fields whose
values are used by the modeling algorithm to predict the value of the target field.

The CHAID modeling node generates the model.

On the Fields tab in the modeling node, the option Use predefined roles is selected, which means the

target and inputs will be used as specified in the Type node. We could change the field roles at this point,
but for this example we'll use them as they are.

1. Click the Build Options tab.
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Figure 15. CHAID modeling node, Fields tab

Here there are several options where we could specify the kind of model we want to build.
We want a brand-new model, so we'll use the default option Build new model.

We also just want a single, standard decision tree model without any enhancements, so we'll also
leave the default objective option Build a single tree.

While we can optionally launch an interactive modeling session that allows us to fine-tune the model,
this example simply generates a model using the default mode setting Generate model.
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Figure 16. CHAID modeling node, Build Options tab

For this example, we want to keep the tree fairly simple, so we'll limit the tree growth by raising the
minimum number of cases for parent and child nodes.

On the Build Options tab, select Stopping Rules from the navigator pane on the left.
Select the Use absolute value option.
Set Minimum records in parent branch to 400.

A A

Set Minimum records in child branch to 200.
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Figure 17. Setting the stopping criteria for decision tree building

We can use all the other default options for this example, so click Run to create the model. (Alternatively,
right-click on the node and choose Run from the context menu, or select the node and choose Run from
the Tools menu.)

Browsing the Model

When execution completes, the model nugget is added to the Models palette in the upper right corner of
the application window, and is also placed on the stream canvas with a link to the modeling node from
which it was created. To view the model details, right-click on the model nugget and choose Browse (on
the models palette) or Edit (on the canvas).
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Figure 18. Models palette

In the case of the CHAID nugget, the Model tab displays the details in the form of a rule set--essentially
a series of rules that can be used to assign individual records to child nodes based on the values of

different input fields.

() Credit rating

)]fhf L; File ‘{*_) Generate J e
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b Number of credit cards in ["& ar more"] [Mode: Bad] = Bad

Figure 19. CHAID model nugget, rule set

For each decision tree terminal node--meaning those tree nodes that are not split further--a prediction of
Good or Bad is returned. In each case the prediction is determined by the mode, or most common
response, for records that fall within that node.

To the right of the rule set, the Model tab displays the Predictor Importance chart, which shows the

relative importance of each predictor in estimating the model. From this we can see that Income level is
easily the most significant in this case, and that the only other significant factor is Number of credit cards.
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Figure 20. Predictor Importance chart

The Viewer tab in the model nugget displays the same model in the form of a tree, with a node at each
decision point. Use the Zoom controls on the toolbar to zoom in on a specific node or zoom out to see

the more of the tree.
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Figure 21. Viewer tab in the model nugget, with zoom out selected

Looking at the upper part of the tree, the first node (Node 0) gives us a summary for all the records in
the data set. Just over 40% of the cases in the data set are classified as a bad risk. This is quite a high
proportion, so let’s see if the tree can give us any clues as to what factors might be responsible.

We can see that the first split is by Income level. Records where the income level is in the Low category are
assigned to Node 2, and it’s no surprise to see that this category contains the highest percentage of loan
defaulters. Clearly lending to customers in this category carries a high risk.

However, 16% of the customers in this category actually didn’t default, so the prediction won’t always be
correct. No model can feasibly predict every response, but a good model should allow us to predict the
most likely response for each record based on the available data.

In the same way, if we look at the high income customers (Node 1), we see that the vast majority (89%)
are a good risk. But more than 1 in 10 of these customers has also defaulted. Can we refine our lending
criteria to minimize the risk here?

Notice how the model has divided these customers into two sub-categories (Nodes 4 and 5), based on the

number of credit cards held. For high-income customers, if we lend only to those with fewer than 5 credit
cards, we can increase our success rate from 89% to 97%--an even more satisfactory outcome.
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Figure 22. Tree view of high-income customers

But what about those customers in the Medium income category (Node 3)? They’re much more evenly
divided between Good and Bad ratings.

Again, the sub-categories (Nodes 6 and 7 in this case) can help us. This time, lending only to those
medium-income customers with fewer than 5 credit cards increases the percentage of Good ratings from
58% to 85%, a significant improvement.
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Figure 23. Tree view of medium-income customers

So, we’ve learnt that every record that is input to this model will be assigned to a specific node, and
assigned a prediction of Good or Bad based on the most common response for that node.

This process of assigning predictions to individual records is known as scoring. By scoring the same
records used to estimate the model, we can evaluate how accurately it performs on the training data—the
data for which we know the outcome. Let’s look at how to do this.
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Evaluating the Model

We've been browsing the model to understand how scoring works. But to evaluate how accurately it
works, we need to score some records and compare the responses predicted by the model to the actual
results. We're going to score the same records that were used to estimate the model, allowing us to
compare the observed and predicted responses.

tree_credit.say Type Lreditrating
#

" 4 Table

CHAID ¥
Credit rating \ O\

Analysis

Figure 24. Attaching the model nugget to output nodes for model evaluation

1.

30

To see the scores or predictions, attach the Table node to the model nugget, double-click the Table
node and click Run.

The table displays the predicted scores in a field named $R-Credit rating, which was created by the
model. We can compare these values to the original Credit rating field that contains the actual
responses.

By convention, the names of the fields generated during scoring are based on the target field, but with
a standard prefix. Prefixes $G and $GE are generated by the Generalized Linear Model, $R is the
prefix used for the prediction generated by the CHAID model in this case, $RC is for confidence
values, $X is typically generated by using an ensemble, and $XR, $XS, and $XF are used as prefixes
in cases where the target field is a Continuous, Categorical, Set, or Flag field, respectively. Different
model types use different sets of prefixes. A confidence value is the model’s own estimation, on a
scale from 0.0 to 1.0, of how accurate each predicted value is.
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|Numher of credit cards |Educstion | Car loans JR-Credit rating | $RC-Credi rating |
5 ar more College fore than 2 Bad 0.560
5 of mare College More than 2 Bad 0.560
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o OF more College More than 2 Bad 0,560
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o OF more High school More than 2 Bad 0532
5 ar more High school More than 2 Bad 0.560
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5 ar more High school More than 2 Bad 0532
5 of mare College More than 2 Bad 0532
o OF more College More than 2 Bad 0532
5 ar more College Iore than 2 Bad 0.560
o OF more College More than 2 Bad 0,560
5 ar more College hore than 2 Good 0527

5

Figure 25. Table showing generated scores and confidence values

As expected, the predicted value matches the actual responses for many records but not all. The
reason for this is that each CHAID terminal node has a mix of responses. The prediction matches the
most common one, but will be wrong for all the others in that node. (Recall the 16% minority of

low-income customers who did not default.)

To avoid this, we could continue splitting the tree into smaller and smaller branches, until every node
was 100% pure—all Good or Bad with no mixed responses. But such a model would be extremely
complicated and would probably not generalize well to other datasets.

To find out exactly how many predictions are correct, we could read through the table and tally the

number of records where the value of the predicted field $R-Credit rating matches the value of Credit
rating. Fortunately, there’s a much easier way--we can use an Analysis node, which does this
automatically.

2. Connect the model nugget to the Analysis node.

3. Double-click the Analysis node and click Run.

Chapter 3. Introduction to Modeling
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Figure 26. Attaching an Analysis node

The analysis shows that for 1899 out of 2464 records--over 77%--the value predicted by the model
matched the actual response.

E Analysis of [Credit rating] E]T
O .

\ad File |5 Edt

B Bl
‘ Analysis i!.-fl‘\'nnﬂ-ﬁ?ﬁﬁJ

& collapse an | | R Expand gg_u]

E-Results for autput field Credit rating
E- Cqmparing FR-Credi rating with Credi rating

: Correct 1899 77.O07%
‘| Wrong SES 2293%
Total 2 464

Figure 27. Analysis results comparing observed and predicted responses

This result is limited by the fact that the records being scored are the same ones used to estimate the
model. In a real situation, you could use a Partition node to split the data into separate samples for
training and evaluation.

By using one sample partition to generate the model and another sample to test it, you can get a much
better indication of how well it will generalize to other datasets.
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The Analysis node allows us to test the model against records for which we already know the actual
result. The next stage illustrates how we can use the model to score records for which we don't know the
outcome. For example, this might include people who are not currently customers of the bank, but who
are prospective targets for a promotional mailing.

Scoring Records

Earlier, we scored the same records used to estimate the model in order to evaluate how accurate the
model was. Now we're going to see how to score a different set of records from the ones used to create
the model. This is the goal of modeling with a target field: Study records for which you know the
outcome, to identify patterns that will allow you to predict outcomes you don't yet know.

£ -B> @1
__ =y — S
tree_creditsay Tyne Ao Targets
JI-f
_d'
z o
_ . =
) .
Tahle
7 -3'(
ScoringData.say ) \
Credit rating O\
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Figure 28. Attaching new data for scoring

You could update the Statistics File source node to point to a different data file, or you could add a new
source node that reads in the data you want to score. Either way, the new dataset must contain the same
input fields used by the model (Age, Income level, Education and so on) but not the target field Credit
rating.

Alternatively, you could add the model nugget to any stream that includes the expected input fields.
Whether read from a file or a database, the source type doesn't matter as long as the field names and
types match those used by the model.

You could also save the model nugget as a separate file, export the model in PMML format for use with
other applications that support this format, or store the model in an IBM SPSS Collaboration and
Deployment Services repository, which offers enterprise-wide deployment, scoring, and management of
models.

Regardless of the infrastructure used, the model itself works in the same way.

Summary

This example demonstrates the basic steps for creating, evaluating, and scoring a model.

* The modeling node estimates the model by studying records for which the outcome is known, and
creates a model nugget. This is sometimes referred to as training the model.

* The model nugget can be added to any stream with the expected fields to score records. By scoring the
records for which you already know the outcome (such as existing customers), you can evaluate how
well it performs.

* Once you are satisfied that the model performs acceptably well, you can score new data (such as
prospective customers) to predict how they will respond.
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* The data used to train or estimate the model may be referred to as the analytical or historical data; the
scoring data may also be referred to as the operational data.
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Chapter 4. Automated Modeling for a Flag Target

Modeling Customer Response (Auto Classifier)

The Auto Classifier node enables you to automatically create and compare a number of different models
for either flag (such as whether or not a given customer is likely to default on a loan or respond to a
particular offer) or nominal (set) targets. In this example we'll search for a flag (yes or no) outcome.
Within a relatively simple stream, the node generates and ranks a set of candidate models, chooses the
ones that perform the best, and combines them into a single aggregated (Ensembled) model. This
approach combines the ease of automation with the benefits of combining multiple models, which often
yield more accurate predictions than can be gained from any one model.

This example is based on a fictional company that wants to achieve more profitable results by matching
the right offer to each customer.

This approach stresses the benefits of automation. For a similar example that uses a continuous (numeric
range) target, see [Property Values (Auto Numeric)}

s -@> (o]
pm_customer_traint s.. Type Select ,'respnnse
*
II’"“:
+
’
y B L q
So @
response Analysis

Figure 29. Auto Classifier sample stream

This example uses the stream pm_binaryclassifier.str, installed in the Demo folder under streams. The data
file used is pm_customer_trainl.sav. See the topic |”Historical Data”| for more information.

Historical Data

The file pm_customer_trainl.sav has historical data tracking the offers made to specific customers in past
campaigns, as indicated by the value of the campaign field. The largest number of records fall under the
Premium account campaign.

The values of the campaign field are actually coded as integers in the data (for example 2 = Premium
account). Later, you'll define labels for these values that you can use to give more meaningful output.
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Figure 30. Data about previous promotions

The file also includes a response field that indicates whether the offer was accepted (0 = no, and 1 = yes).
This will be the target field, or value, that you want to predict. A number of fields containing
demographic and financial information about each customer are also included. These can be used to
build or "train" a model that predicts response rates for individuals or groups based on characteristics
such as income, age, or number of transactions per month.

Building the Stream

1. Add a Statistics File source node pointing to pm_customer_trainl.sav, located in the Demos folder of
your IBM SPSS Modeler installation. (You can specify $CLEO_DEMOS/ in the file path as a shortcut to
reference this folder. Note that a forward slash—rather than a backslash— must be used in the path,
as shown.)
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Figure 31. Reading in the data

2. Add a Type node, and select response as the target field (Role = Target). Set the Measurement for this
field to Flag.

E Type : .
B [CX]F=0 (m)
b

Tyees | Fomai | avectaions
b',. " Read YValues Clear Yalues Clear Al Yalues
Field Measurement Yalues Miz=ing Check Role
{} customer_id ﬁ Coartinuous [7,116993] Mare G Maone
{} campaign ‘f} Momiral 1234 Mone N It
{} rESpOnSE 8 Flag 110 Maone @ Target
E_Ej response_... ‘f Continuous [2006-04., .. Mone & Mone
{} purchasze ﬁ Continuous [01] Mone & Mone
E_Ej purchase_... ‘f Continuous [2006-04., .. Mone & Mone
3 product_id | Continuous [183421] Mone & Mone
3 Rowid & Continuous [1,19599] Mone & Mone
s AP orticnons r0 oE1 hana b

@ view current fislds Wiewy unused fisld settings

Figure 32. Setting the measurement level and role

3. Set the role to None for the following fields: customer_id, campaign, response_date, purchase,
purchase_date, product_id, Rowid, and X_random. These fields will be ignored when you are building
the model.

4. Click the Read Values button in the Type node to make sure that values are instantiated.

As we saw earlier, our source data includes information about four different campaigns, each
targeted to a different type of customer account. These campaigns are coded as integers in the data,
so to make it easier to remember which account type each integer represents, let's define labels for
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each one.
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Figure 33. Choosing to specify values for a field

5. On the row for the campaign field, click the entry in the Values column.
6. Choose Specify from the drop-down list.

B ™1
campaign Values
Measuremert storage: P teger

Wallgs: Read from dats Pass

@ Specify values and lakels

Values |Labels
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|
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3 Gold accourt ST
:

Platinum accourt

|:| Extend values from data

Check values:  |None 7T

|:| Define blanks

Mis=zing values

E White space

Description: |

Figure 34. Defining labels for the field values

7. In the Labels column, type the labels as shown for each of the four values of the campaign field.
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8. Click OK.

Now you can display the labels in output windows instead of the integers.
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Figure 35. Displaying the field value labels

9. Attach a Table node to the Type node.
10. Open the Table node and click Run.

11. On the output window, click the Display field and value labels toolbar button to display the labels.

12. Click OK to close the output window.

Although the data includes information about four different campaigns, you will focus the analysis on
one campaign at a time. Since the largest number of records fall under the Premium account campaign
(coded campaign=2 in the data), you can use a Select node to include only these records in the stream.

Chapter 4. Automated Modeling for a Flag Target
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Figure 36. Selecting records for a single campaign

Generating and Comparing Models

1. Attach an Auto Classifier node, and select Overall Accuracy as the metric used to rank models.

2. Set the Number of models to use to 3. This means that the three best models will be built when you
execute the node.
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Figure 37. Auto Classifier node Model tab

On the Expert tab you can choose from up to 11 different model algorithms.

3. Deselect the Discriminant and SVM model types. (These models take longer to train on these data, so

deselecting them will speed up the example. If you don't mind waiting, feel free to leave them
selected.)

Because you set Number of models to use to 3 on the Model tab, the node will calculate the accuracy
of the remaining nine algorithms and build a single model nugget containing the three most accurate.

Chapter 4. Automated Modeling for a Flag Target 41



response
@ | =
Estimated numbet of models to be executed: 9
fodels used:
Uze? |Model type |Model parameters  |Mo of models
.
[« l:?ﬁ s Defaut 1
il L/ Logistic r... Defaut 1
E % Decision ... Default 1
E ﬂ&} Eavesian... Default 1
] [
*
[+ 282 KNM Al Defaut 1
W ﬁf{ﬂ CER Tres Defaul 1
& AN QuestTr.. Defaut 1
QWIEST
] AD cHAD Tree Defaut 1
CHAID -
|:| Restrict maximum time spent building & single mode! to 15 : minutes
Stogging rules... | | Misclassification costs...
ok || | |_cancel

Figure 38. Auto Classifier node Expert tab

4. On the Settings tab, for the ensemble method, select Confidence-weighted voting. This determines
how a single aggregated score is produced for each record.

With simple voting, if two out of three models predict yes, then yes wins by a vote of 2 to 1. In the
case of confidence-weighted voting, the votes are weighted based on the confidence value for each
prediction. Thus, if one model predicts no with a higher confidence than the two yes predictions
combined, then no wins.
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Figure 39. Auto Classifier node: Settings tab

5. Click Run.

After a few minutes, the generated model nugget is built and placed on the canvas, and on the Models
palette in the upper right corner of the window. You can browse the model nugget, or save or deploy it
in a number of other ways.

Open the model nugget; it lists details about each of the models created during the run. (In a real
situation, in which hundreds of models may be created on a large dataset, this could take many hours.)
See [Figure 29 on page 35|

If you want to explore any of the individual models further, you can double-click on a model nugget icon
in the Model column to drill down and browse the individual model results; from there you can generate
modeling nodes, model nuggets, or evaluation charts. In the Graph column, you can double-click on a
thumbnail to generate a full-sized graph.
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Figure 40. Auto Classifier results

By default, models are sorted based on overall accuracy, because this was the measure you selected on
the Auto Classifier node Model tab. The C51 model ranks best by this measure, but the C&R Tree and
CHAID models are nearly as accurate.

You can sort on a different column by clicking the header for that column, or you can choose the desired
measure from the Sort by drop-down list on the toolbar.

Based on these results, you decide to use all three of these most accurate models. By combining
predictions from multiple models, limitations in individual models may be avoided, resulting in a higher
overall accuracy.

In the Use? column, select the C51, C&R Tree, and CHAID models.

Attach an Analysis node (Output palette) after the model nugget. Right-click on the Analysis node and
choose Run to run the stream.

The aggregated score generated by the ensembled model is shown in a field named $XF-response. When
measured against the training data, the predicted value matches the actual response (as recorded in the
original response field) with an overall accuracy of 92.82%.

While not quite as accurate as the best of the three individual models in this case (92.86% for C51), the

difference is too small to be meaningful. In general terms, an ensembled model will typically be more
likely to perform well when applied to datasets other than the training data.
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Figure 41. Analysis of the three ensembled models

Summary

To sum up, you used the Auto Classifier node to compare a number of different models, used the three
most accurate models and added them to the stream within an ensembled Auto Classifier model nugget.
* Based on overall accuracy, the C51, C&R Tree, and CHAID models performed best on the training data.

* The ensembled model performed nearly as well as the best of the individual models and may perform
better when applied to other datasets. If your goal is to automate the process as much as possible, this
approach allows you to obtain a robust model under most circumstances without having to dig deeply

into the specifics of any one model.
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Chapter 5. Automated Modeling for a Continuous Target

Property Values (Auto Numeric)

The Auto Numeric node enables you to automatically create and compare different models for
continuous (numeric range) outcomes, such as predicting the taxable value of a property. With a single
node, you can estimate and compare a set of candidate models and generate a subset of models for
further analysis. The node works in the same manner as the Auto Classifier node, but for continuous
rather than flag or nominal targets.

The node combines the best of the candidate models into a single aggregated (Ensembled) model nugget.
This approach combines the ease of automation with the benefits of combining multiple models, which
often yield more accurate predictions than can be gained from any one model.

This example focuses on a fictional municipality responsible for adjusting and assessing real estate taxes.
To do this more accurately, they will build a model that predicts property values based on building type,
neighborhood, size, and other known factors.

@ — @ 77

-,
property_values_trai.. Type ._o"taxable_\talue

taxable_value Analysis
Figure 42. Auto Numeric sample stream

This example uses the stream property_values_numericpredictor.str, installed in the Demos folder under
streams. The data file used is property_values_train.sav. See the topic [“Demos Folder” on page 4| for more
information.

Training Data

The data file includes a field named taxable_value, which is the target field, or value, that you want to
predict. The other fields contain information such as neighborhood, building type, and interior volume
and may be used as predictors.

Field name Label

property_id Property ID

neighborhood Area within the city

building_type Type of building

year_built Year built

volume_interior Volume of interior

volume_other Volume of garage and extra buildings
lot_size Lot size
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Field name Label

taxable_value Taxable value

A scoring data file named property_values_score.sav is also included in the Demos folder. It contains the
same fields but without the taxable_value field. After training models using a dataset where the taxable
value is known, you can score records where this value is not yet known.

Building the Stream

1. Add a Statistics File source node pointing to property_values_train.sav, located in the Demos folder of
your IBM SPSS Modeler installation. (You can specify $CLEO_DEMOS/ in the file path as a shortcut to

reference this folder. Note that a forward slash—rather than a backslash—must be used in the path, as
shown. )

0 property_values_train.sav

f WI [ 2] Retresh ]

FCLEC DEMOS oroperty _values_train.say

Data || Fiter | Types | Annatations

o

Import file;  (FCLEC_DEMOSiroperty_values_train say |

variahle names: (@ Read names and labelz  ©) Read labels as names

Walues: @ Read data and labels Read labels a3 data

Efl Usze field format information to determine starage

-

Figure 43. Reading in the data

2. Add a Type node, and select taxable_value as the target field (Role = Target). Role should be set to
Input for all other fields, indicating that they will be used as predictors.
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Figure 44. Setting the target field

3. Attach an Auto Numeric node, and select Correlation as the metric used to rank models.

4. Set the Number of models to use to 3. This means that the three best models will be built when you
execute the node.

taxable_value
KR

Estimated number of models to be executed: 7

Fieis Mose | Exper Setings. Ameteons.
hadel name: @ auto Custom

[¥] Use partitioned data
@ Builed maodel for each split

Rank models using Training partition @) Test partition
Mumber of models to use:

@ Calculate predictor importance

Do not keep models if:

2 F.

[T Correlstion iz less than 0.3
a

[ Mumber of fislds is grester than 105
Py

[ Relative error is grester than 105

[ OF; Hh _Bun” Can_cELJ

Figure 45. Auto Numeric node Model tab

5. On the Expert tab, leave the default settings in place; the node will estimate a single model for each
algorithm, for a total of seven models. (Alternatively, you can modify these settings to compare
multiple variants for each model type.)
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Because you set Number of models to use to 3 on the Model tab, the node will calculate the accuracy
of the seven algorithms and build a single model nugget containing the three most accurate.

[ taxable_value

|

Estimated number of models to be executed: 7

e s

Models used:
Uze? |Model type Model parameters Mo of models
.
i E Fegression  Default 1
E % Generalized ... Default 1
¥
B e
7] Sk svM Defautt 1
7 FS:,EH CARTree  Defaut 1
[+ A% cHaD Tree  Defaut 1
CHAID
¥ 'ﬁ- MeuralMet  Default 1 =
estrict maximum time spent building a single model to o minutes
[7] Restrict i it bl | del t 15 B

e

Figure 46. Auto Numeric node Expert tab

6. On the Settings tab, leave the default settings in place. Since this is a continuous target, the ensemble
score is generated by averaging the scores for the individual models.
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rEnzemble Settings -
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m Calculste standard error

=

Figure 47. Auto Numeric node Settings tab

Comparing the Models
1. Click the Run button.

The model nugget is built and placed on the canvas, and also on the Models palette in the upper right
corner of the window. You can browse the nugget, or save or deploy it in a number of other ways.

Open the model nugget; it lists details about each of the models created during the run. (In a real
situation, in which hundreds of models are estimated on a large dataset, this could take many hours.) See

Figure 42 on page 47]

If you want to explore any of the individual models further, you can double-click on a model nugget icon
in the Model column to drill down and browse the individual model results; from there you can generate

modeling nodes, model nuggets, or evaluation charts.
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Figure 48. Auto Numeric results

By default, models are sorted by correlation because this was the measure you selected in the Auto
Numeric node. For purposes of ranking, the absolute value of the correlation is used, with values closer
to 1 indicating a stronger relationship. The Generalized Linear model ranks best on this measure, but
several others are nearly as accurate. The Generalized Linear model also has the lowest relative error.

You can sort on a different column by clicking the header for that column, or you can choose the desired
measure from the Sort by list on the toolbar.

Each graph displays a plot of observed values against predicted values for the model, providing a quick
visual indication of the correlation between them. For a good model, points should cluster along the
diagonal, which is true for all the models in this example.

In the Graph column, you can double-click on a thumbnail to generate a full-sized graph.

Based on these results, you decide to use all three of these most accurate models. By combining
predictions from multiple models, limitations in individual models may be avoided, resulting in a higher
overall accuracy.

In the Use? column, ensure that all three models are selected.

Attach an Analysis node (Output palette) after the model nugget. Right-click on the Analysis node and
choose Run to run the stream.

The averaged score generated by the ensembled model is added in a field named $XR-taxable_value, with
a correlation of 0.922, which is higher than those of the three individual models. The ensemble scores also
show a low mean absolute error and may perform better than any of the individual models when
applied to other datasets.
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Figure 49. Auto Numeric sample stream

Summary

To sum up, you used the Auto Numeric node to compare a number of different models, selected the
three most accurate models and added them to the stream within an ensembled Auto Numeric model
nugget.

* Based on overall accuracy, the Generalized Linear, Regression, and CHAID models performed best on
the training data.

* The ensembled model showed performance that was better than two of the individual models and may
perform better when applied to other datasets. If your goal is to automate the process as much as
possible, this approach allows you to obtain a robust model under most circumstances without having
to dig deeply into the specifics of any one model.
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Chapter 6. Automated Data Preparation (ADP)

Preparing data for analysis is one of the most important steps in any data-mining project—and
traditionally, one of the most time consuming. The Automated Data Preparation (ADP) node handles the
task for you, analyzing your data and identifying fixes, screening out fields that are problematic or not
likely to be useful, deriving new attributes when appropriate, and improving performance through
intelligent screening techniques. You can use the node in fully automated fashion, allowing the node to
choose and apply fixes, or you can preview the changes before they are made and accept or reject them
as desired.

Using the ADP node enables you to make your data ready for data mining quickly and easily, without
needing to have prior knowledge of the statistical concepts involved. If you run the node with the default
settings, models will tend to build and score more quickly.

This example uses the stream named ADP_basic_demo.str, which references the data file named telco.sav to
demonstrate the increased accuracy that may be found by using the default ADP node settings when
building models. These files are available from the Demos directory of any IBM SPSS Modeler installation.
This can be accessed from the IBM SPSS Modeler program group on the Windows Start menu. The
ADP_basic_demo.str file is in the streams directory.

Building the Stream

1. To build the stream, add a Statistics File source node pointing to telco.sav located in the Demos
directory of your IBM SPSS Modeler installation.

Bl) —» (=) —» (o)

telco.say Type Mo ADF - chlikn
L3

c&. — & N Q

fler ADF - cHium Mo ADP -ghum Mo ADP - LogReg
*

Auto Data Prep

After ADP - churn After ADP - LogReg

Figure 50. Building the stream

2. Attach a Type node to the source node, set the measurement level for the churn field to Flag, and set
the role to Target. All other fields should have their role set to Input.
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Figure 51. Selecting the target

3. Attach a Logistic node to the Type node.

4. In the Logistic node, click the Model tab and select the Binomial procedure. In the Model name field,
select Custom and enter No ADP - churn.

w |
s v e s v,

Model name:  (©) Auto @ Custom |ND ADP - churn

[¥] Use partitioned data

@ Buildd maodel for each split

Procedure: ©) Multinomisl @ Binomial
rBinomial Procedure

Categarical Inputs:

Field Marme |Cc-ntrast Eaze Category

@ Include constant in equation

Figure 52. Choosing model options
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5. Attach an ADP node to the Type node. On the Objectives tab, leave the default settings in place to
analyze and prepare your data by balancing both speed and accuracy.

6. At the top of the Objectives tab, click Analyze Data to analyze and process your data.

Other options on the ADP node enable you to specify that you want to concentrate more on accuracy,
more on the speed of processing, or to fine tune many of the data preparation processing steps.

U Auto Data Prep

’l{) Generate @’ = [P‘Prewewlh Analyze Da_ta.I X (;Iear Ana_lysi;}

>

_ Ohjectives l_-'inlaldsl Seftings ‘ lA_naI';-'sis Annotations .
Automated Data Preparation can recommend data preparation steps that will speed up model building and improve predictive power. This can include transforming,
constructing and selecting features. The target can also be transformed.
What is your objective?
@ Balance speed and accuracy
Transform the data with an emphasis on building models with a balance of speed and accuracy.

© Optimize for speed
() Optimize for accuracy

@) Custom analysis

Figure 53. ADP default objectives

The results of the data processing are displayed on the Analysis tab. The Field Processing Summary
shows that of the 41 data features brought in to the ADP node, 19 have been transformed to aid
processing, and 3 have been discarded as unused.
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Figure 54. Summary of data processing

7. Attach a Logistic node to the ADP node.

8. In the Logistic node, click the Model tab and select the Binomial procedure. In the Modeling name
field, select Custom and enter After ADP - churn.
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Figure 55. Choosing model options

Comparing Model Accuracy

1. Run both Logistic nodes to create the model nuggets, which are added to the stream and to the
Models palette in the upper-right corner.

®-®—-0

telco.sav M ADP - chiin
*

®» -0 "W

fter ADP - chian Mo ADP - churn
*

After ADF - churn

Figure 56. Attaching the model nuggets
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2. Attach Analysis nodes to the model nuggets and run the Analysis nodes using their default settings.

~ R
v N

Mo ADP - churn Mo ADP - LogReq

L3
\ [~ |
v — &8
7.
After ADF - churn After A0F - LogReqy

Figure 57. Attaching the Analysis nodes

The Analysis of the non ADP-derived model shows that just running the data through the Logistic
Regression node with its default settings gives a model with low accuracy - just 10.6%.

Mo ADP - LogReg

lad File | Eoit

—
‘ Analysis H.MJ
| & cotspse i | | % eanaa

E-Results for output field churn
E--Cqmparing FL-churn with churn

Correct 106/  10.6%
| WWrong G4 89.4%
Total 1,000

Figure 58. Non ADP-derived model results

The Analysis of the ADP-derived model shows that running the data through the default ADP settings,
you have built a much more accurate model that is 78.8% correct.
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Figure 59. ADP-derived model results

In summary, by just running the ADP node to fine tune the processing of your data, you were able to
build a more accurate model with little direct data manipulation.

Obviously, if you are interested in proving or disproving a certain theory, or want to build specific
models, you may find it beneficial to work directly with the model settings; however, for those with a
reduced amount of time, or with a large amount of data to prepare, the ADP node may give you an
advantage.

Explanations of the mathematical foundations of the modeling methods used in IBM SPSS Modeler are
listed in the IBM SPSS Modeler Algorithms Guide, available from the \Documentation directory of the
installation disk.

Note that the results in this example are based on the training data only. To assess how well models

generalize to other data in the real world, you would use a Partition node to hold out a subset of records
for purposes of testing and validation.
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Chapter 7. Preparing Data for Analysis (Data Audit)

The Data Audit node provides a comprehensive first look at the data you bring into IBM SPSS Modeler.
Often used during the initial data exploration, the data audit report shows summary statistics as well as
histograms and distribution graphs for each data field, and it allows you to specify treatments for
missing values, outliers, and extreme values.

This example uses the stream named telco_dataaudit.str, which references the data file named telco.sav.
These files are available from the Demos directory of any IBM SPSS Modeler installation. This can be
accessed from the IBM SPSS Modeler program group on the Windows Start menu. The telco_dataaudit.str
file is in the streams directory.

Building the Stream

1. To build the stream, add a Statistics File source node pointing to telco.sav located in the Demos
directory of your IBM SPSS Modeler installation.

-g>

@) — (=) — o |EL

telco.sav / Type 47 Fields

—_— R e (51

Missing Yalue Imputa.. (generated)\ Anomaly

£

churn

=]

Figure 60. Building the stream

2. Add a Type node to define fields, and specify churn as the target field (Role = Target). Role should be
set to Input for all of the other fields so that this is the only target.
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Figure 61. Setting the target

3. Confirm that field measurement levels are defined correctly. For example, most fields with values 0
and 1 can be regarded as flags, but certain fields, such as gender, are more accurately viewed as a
nominal field with two values.
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Figure 62. Setting measurement levels

Tip: To change properties for multiple fields with similar values (such as 0/1), click the Values column
header to sort fields by that column, and use the Shift key to select all of the fields you want to
change. You can then right-click on the selection to change the measurement level or other attributes
for all selected fields.

4. Attach a Data Audit node to the stream. On the Settings tab, leave the default settings in place to
include all fields in the report. Since churn is the only target field defined in the Type node, it will
automatically be used as an overlay.
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Figure 63. Data Audit node, Settings tab

On the Quality tab, leave the default settings for detecting missing values, outliers, and extreme values in

place, and click Run.

Chapter 7. Preparing Data for Analysis (Data Audit)
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Figure 64. Data Audit node, Quality tab

Browsing Statistics and Charts

The Data Audit browser is displayed, with thumbnail graphs and descriptive statistics for each field.
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Figure 65. Data Audit browser

Use the toolbar to display field and value labels, and to toggle the alignment of charts from horizontal to

vertical (for categorical fields only).

1. You can also use the toolbar or Edit menu to choose the statistics to display.

Display Statistics
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Figure 66. Display Statistics

Double-click on any thumbnail graph in the audit report to view a full-sized version of that chart.
Because churn is the only target field in the stream, it is automatically used as an overlay. You can toggle

the display of field and value labels using the graph window toolbar, or click the Edit mode button to

further customize the chart.

Chapter 7. Preparing Data for Analysis (Data Audit)
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Figure 67. Histogram of tenure

Alternatively, you can select one or more thumbnails and generate a Graph node for each. The generated
nodes are placed on the stream canvas and can be added to the stream to re-create that particular graph.
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Figure 68. Generating a Graph node

Handling Outliers and Missing Values

The Quality tab in the audit report displays information about outliers, extremes, and missing values.
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Figure 69. Data Audit browser, Quality tab

You can also specify methods for handling these values and generate SuperNodes to automatically apply
the transformations. For example you can select one or more fields and choose to impute or replace
missing values for these fields using a number of methods, including the C&RT algorithm.
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Figure 70. Choosing an impute method

After specifying an impute method for one or more fields, to generate a Missing Values SuperNode, from
the menus choose:
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Figure 71. Generating the SuperNode

The generated SuperNode is added to the stream canvas, where you can attach it to the stream to apply
the transformations.
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Figure 72. Stream with Missing Values SuperNode

The SuperNode actually contains a series of nodes that perform the requested transformations. To
understand how it works, you can edit the SuperNode and click Zoom In.
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Figure 73. Zooming in on the SuperNode

For each field imputed using the algorithm method, for example, there will be a separate C&RT model,
along with a Filler node that replaces blanks and nulls with the value predicted by the model. You can
add, edit, or remove specific nodes within the SuperNode to further customize the behavior.

Alternatively, you can generate a Select or Filter node to remove fields or records with missing values.
For example, you can filter any fields with a quality percentage below a specified threshold.

Generate Filter from Quality

mode: @ inciude O Exclude

@) Selerted fields

@ Fields with guality percentage higher than % ﬂ

Figure 74. Generating a Filter node

Outliers and extreme values can be handled in a similar manner. Specify the action you want to take for
each field—either coerce, discard, or nullify—and generate a SuperNode to apply the transformations.
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Figure 75. Generating a Filter node

After completing the audit and adding the generated nodes to the stream, you can proceed with your
analysis. Optionally, you may want to further screen your data using Anomaly Detection, Feature
Selection, or a number of other methods.
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Figure 76. Stream with Missing Values SuperNode
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Chapter 8. Drug Treatments (Exploratory Graphs/C5.0)

For this section, imagine that you are a medical researcher compiling data for a study. You have collected
data about a set of patients, all of whom suffered from the same illness. During their course of treatment,
each patient responded to one of five medications. Part of your job is to use data mining to find out
which drug might be appropriate for a future patient with the same illness.

This example uses the stream named druglearn.str, which references the data file named DRUGIn. These
files are available from the Demos directory of any IBM SPSS Modeler installation. This can be accessed
from the IBM SPSS Modeler program group on the Windows Start menu. The druglearn.str file is in the

streams directory.

The data fields used in the demo are:

Data field Description

Age (Number)

Sex Mor F

BP Blood pressure: HIGH, NORMAL, or LOW
Cholesterol Blood cholesterol: NORMAL or HIGH

Na Blood sodium concentration

K Blood potassium concentration

Drug Prescription drug to which a patient responded

Reading in Text Data

=l
==
=]
5=

war. File

U —

pre—

_________________

Latabase “far. File Auto Data Frep

M

Figure 77. Adding a Variable File node

You can read in delimited text data using a Variable File node. You can add a Variable File node from
the palettes—-either click the Sources tab to find the node or use the Favorites tab, which includes this
node by default. Next, double-click the newly placed node to open its dialog box.
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Click the button just to the right of the File box marked with an ellipsis (...) to browse to the directory in
which IBM SPSS Modeler is installed on your system. Open the Demos directory and select the file called
DRUGIn.

Ensuring that Read field names from file is selected, notice the fields and values that have just been
loaded into the dialog box.
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e, i

o — |
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Figure 78. Variable File dialog box

74

IBM SPSS Modeler 17.1 Applications Guide




|_ Crverrice ‘[ ~ Sforage | It Formest
Fl £7% Integer

Sex D @ String
BP [ |A] string
Cholesteral [« [alsting =/
Ma ] 7 (Unknowyn)
K o @ String
Drug (] {} Integer %

@ Feal

G} Titne

&R Date

E Timestathp

@ view current fields @ View unused field zettings

(ox] (cancel]

Figure 79. Changing the storage type for a field
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Figure 80. Selecting Value options on the Types tab

Click the Data tab to override and change Storage for a field. Note that storage is different from
Measurement, that is, the measurement level (or usage type) of the data field. The Types tab helps you
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learn more about the type of fields in your data. You can also choose Read Values to view the actual
values for each field based on the selections that you make from the Values column. This process is
known as instantiation.

Adding a Table

Now that you have loaded the data file, you may want to glance at the values for some of the records.
One way to do this is by building a stream that includes a Table node. To place a Table node in the
stream, either double-click the icon in the palette or drag and drop it on to the canvas.

| —
DRUGIN Table

Figure 81. Table node connected to the data source
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Figure 82. Running a stream from the toolbar

Double-clicking a node from the palette will automatically connect it to the selected node in the stream

canvas. Alternatively, if the nodes are not already connected, you can use your middle mouse button to
connect the Source node to the Table node. To simulate a middle mouse button, hold down the Alt key

while using the mouse. To view the table, click the green arrow button on the toolbar to run the stream,
or right-click the Table node and choose Run.
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Creating a Distribution Graph

During data mining, it is often useful to explore the data by creating visual summaries. IBM SPSS

Modeler offers several different types of graphs to choose from, depending on the kind of data that you

want to summarize. For example, to find out what proportion of the patients responded to each drug, use

a Distribution node.

Add a Distribution node to the stream and connect it to the Source node, then double-click the node to

edit options for display.

Select Drug as the target field whose distribution you want to show. Then, click Run from the dialog box.

Drug
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Figure 83. Selecting drug as the target field
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Figure 84. Distribution of response to drug type

The resulting graph helps you see the "shape” of the data. It shows that patients responded to drug Y

most often and to drugs B and C least often.
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Figure 85. Results of a data audit

Alternatively, you can attach and execute a Data Audit node for a quick glance at distributions and
histograms for all fields at once. The Data Audit node is available on the Output tab.

Creating a Scatterplot

Now let's take a look at what factors might influence Drug, the target variable. As a researcher, you know
that the concentrations of sodium and potassium in the blood are important factors. Since these are both
numeric values, you can create a scatterplot of sodium versus potassium, using the drug categories as a

color overlay.

Place a Plot node in the workspace and connect it to the Source node, and double-click to edit the node.
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Figure 86. Creating a scatterplot

On the Plot tab, select Na as the X field, K as the Y field, and Drug as the overlay field. Then, click Run.

The plot clearly shows a threshold above which the correct drug is always drug Y and below which the

correct drug is never drug Y. This threshold is a ratio--the ratio of sodium (Na) to potassium (K).
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Figure 87. Scatterplot of drug distribution

Creating a Web Graph

Since many of the data fields are categorical, you can also try plotting a web graph, which maps
associations between different categories. Start by connecting a Web node to the Source node in your
workspace. In the Web node dialog box, select BP (for blood pressure) and Drug. Then, click Run.
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Figure 88. Web graph of drugs vs. blood pressure

From the plot, it appears that drug Y is associated with all three levels of blood pressure. This is no
surprise--you have already determined the situation in which drug Y is best. To focus on the other drugs,
you can hide drug Y. On the View menu, choose Edit Mode, then right-click over the drug Y point and
choose Hide and Replan.

In the simplified plot, drug Y and all of its links are hidden. Now, you can clearly see that only drugs A
and B are associated with high blood pressure. Only drugs C and X are associated with low blood
pressure. And normal blood pressure is associated only with drug X. At this point, though, you still don't
know how to choose between drugs A and B or between drugs C and X, for a given patient. This is
where modeling can help.
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Figure 89. Web graph with drug Y and its links hidden

Deriving a New Field

Since the ratio of sodium to potassium seems to predict when to use drug Y, you can derive a field that
contains the value of this ratio for each record. This field might be useful later when you build a model

to predict when to use each of the five drugs. To simplify the stream layout, start by deleting all the
nodes except the DRUGIn source node. Attach a Derive node (Field Ops tab) to DRUGIn, then
double-click the Derive node to edit it.
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Figure 90. Editing the Derive node

Name the new field Na_to_K. Since you obtain the new field by dividing the sodium value by the
potassium value, enter Na/K for the formula. You can also create a formula by clicking the icon just to the
right of the field. This opens the Expression Builder, a way to interactively create expressions using
built-in lists of functions, operands, and fields and their values.

You can check the distribution of your new field by attaching a Histogram node to the Derive node. In
the Histogram node dialog box, specify Na_to_K as the field to be plotted and Drug as the overlay field.
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Figure 91. Editing the Histogram node

When you run the stream, you get the graph shown here. Based on the display, you can conclude that
when the Na_to_K value is about 15 or above, drug Y is the drug of choice.
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Figure 92. Histogram display
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Building a Model

By exploring and manipulating the data, you have been able to form some hypotheses. The ratio of
sodium to potassium in the blood seems to affect the choice of drug, as does blood pressure. But you
cannot fully explain all of the relationships yet. This is where modeling will likely provide some answers.
In this case, you will use try to fit the data using a rule-building model, C5.0.

Since you are using a derived field, Na_to_K, you can filter out the original fields, Na and K, so that they
are not used twice in the modeling algorithm. You can do this using a Filter node.

Ed Filter

b
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= e
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Field Fitter Field
Age —_— Age
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K > I
Drug — Drug
Ma_to_k — P _to_K

@) view current figlds “iewy unuzed field settings

Figure 93. Editing the Filter node

On the Filter tab, click the arrows next to Na and K. Red Xs appear over the arrows to indicate that the
fields are now filtered out.

Next, attach a Type node connected to the Filter node. The Type node allows you to indicate the types of
fields that you are using and how they are used to predict the outcomes.

On the Types tab, set the role for the Drug field to Target, indicating that Drug is the field you want to
predict. Leave the role for the other fields set to Input so they will be used as predictors.
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Figure 94. Editing the Type node
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To estimate the model, place a C5.0 node in the workspace and attach it to the end of the stream as
shown. Then click the green Run toolbar button to run the stream.
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Figure 95. Adding a C5.0 node
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Browsing the Model
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Figure 96. Browsing the model

When the C5.0 node is executed, the model nugget is added to the stream, and also to the Models palette
in the upper-right corner of the window. To browse the model, right-click either of the icons and choose
Edit or Browse from the context menu.

The Rule browser displays the set of rules generated by the C5.0 node in a decision tree format. Initially,
the tree is collapsed. To expand it, click the All button to show all levels.

| Mode! || viewer | Summary | Seftings | Annotations

B - _— = - -

-- Ma_to_K==14.64
e MWa_to_k = 14 B4 = drugy

Figure 97. Rule browser

Now you can see the missing pieces of the puzzle. For people with an Na-to-K ratio less than 14.64 and
high blood pressure, age determines the choice of drug. For people with low blood pressure, cholesterol
level seems to be the best predictor.
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Figure 98. Rule browser fully expanded

The same decision tree can be viewed in a more sophisticated graphical format by clicking the Viewer
tab. Here, you can see more easily the number of cases for each blood pressure category, as well as the
percentage of cases.
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Figure 99. Decision tree in graphical format

Using an Analysis Node

You can assess the accuracy of the model using an analysis node. Attach an Analysis node (from the
Output node palette) to the model nugget, open the Analysis node and click Run.
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Figure 100. Adding an Analysis node

The Analysis node output shows that with this artificial dataset, the model correctly predicted the choice
of drug for every record in the dataset. With a real dataset you are unlikely to see 100% accuracy, but you
can use the Analysis node to help determine whether the model is acceptably accurate for your particular

application.
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Figure 101. Analysis node output
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Chapter 9. Screening Predictors (Feature Selection)

The Feature Selection node helps you to identify the fields that are most important in predicting a certain
outcome. From a set of hundreds or even thousands of predictors, the Feature Selection node screens,
ranks, and selects the predictors that may be most important. Ultimately, you may end up with a quicker,
more efficient model—one that uses fewer predictors, executes more quickly, and may be easier to
understand.

The data used in this example represent a data warehouse for a hypothetical telephone company and
contain information about responses to a special promotion by 5,000 of the company's customers. The
data include a large number of fields containing customers' age, employment, income, and telephone
usage statistics. Three "target” fields show whether or not the customer responded to each of three offers.
The company wants to use this data to help predict which customers are most likely to respond to
similar offers in the future.

This example uses the stream named featureselection.str, which references the data file named
customer_dbase.sav. These files are available from the Demos directory of any IBM SPSS Modeler
installation. This can be accessed from the IBM SPSS Modeler program group on the Windows Start
menu. The featureselection.str file is in the streams directory.

This example focuses on only one of the offers as a target. It uses the CHAID tree-building node to
develop a model to describe which customers are most likely to respond to the promotion. It contrasts
two approaches:

* Without feature selection. All predictor fields in the dataset are used as inputs to the CHAID tree.

* With feature selection. The Feature Selection node is used to select the top 10 predictors. These are then
input into the CHAID tree.

By comparing the two resulting tree models, we can see how feature selection produces effective results.

Building the Stream
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Figure 102. Feature Selection example stream

1. Place a Statistics File source node onto a blank stream canvas. Point this node to the example data
file customer_dbase.sav, available in the Demos directory under your IBM SPSS Modeler installation.
(Alternatively, open the example stream file featureselection.str in the streams directory.)

2. Add a Type node. On the Types tab, scroll down to the bottom and change the role for response_01 to
Target. Change the role to None for the other response fields (response_02 and response_03) as well as
for the customer ID (custid) at the top of the list. Leave the role set to Input for all other fields, and
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click the Read Values button, then click OK.
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Figure 103. Adding a Type node

3. Add a Feature Selection modeling node to the stream. On this node, you can specify the rules and
criteria for screening, or disqualifying, fields.

4. Run the stream to create the Feature Selection model nugget.

5. Right-click the model nugget on the stream or in the Models palette and choose Edit or Browse to
look at the results.
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Figure

104. Model tab in Feature Selection model nugget

The top panel shows the fields found to be useful in the prediction. These are ranked based on
importance. The bottom panel shows which fields were screened from the analysis and why. By
examining the fields in the top panel, you can decide which ones to use in subsequent modeling
sessions.

6. Now we can select the fields to use downstream. Although 34 fields were originally identified as
important, we want to reduce the set of predictors even further.

7. Select only the top 10 predictors using the check marks in the first column to deselect the unwanted
predictors. (Click the check mark in row 11, hold down the Shift key and click the check mark in
row 34.) Close the model nugget.

8. To compare results without feature selection, you must add two CHAID modeling nodes to the
stream: one that uses feature selection and one that does not.

9. Connect one CHAID node to the Type node, and the other one to the Feature Selection model
nugget.

10. Open each CHAID node, select the Build Options tab and ensure that the options Build new model,

Build a single tree and Launch interactive session are selected in the Objectives pane.
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On the Basics pane, make sure that Maximum Tree Depth is set to 5.

2 With All Fields

P
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Figure 105. Objectives settings for CHAID modeling node for all predictor fields

Building the Models

1. Execute the CHAID node that uses all of the predictors in the dataset (the one connected to the Type
node). As it runs, notice how long it takes to execute. The results window displays a table.

2. From the menus, choose Tree > Grow Tree to grow and display the expanded tree.
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Figure 106. Growing the tree in the Tree Builder

3. Now do the same for the other CHAID node, which uses only 10 predictors. Again, grow the tree
when the Tree Builder opens.

The second model should have executed faster than the first one. Because this dataset is fairly small, the
difference in execution times is probably a few seconds; but for larger real-world datasets, the difference
may be very noticeable—minutes or even hours. Using feature selection may speed up your processing
times dramatically.

The second tree also contains fewer tree nodes than the first. It is easier to comprehend. But before you
decide to use it, you need to find out whether it is effective and how it compares to the model that uses
all predictors.

Comparing the Results

To compare the two results, we need a measure of effectiveness. For this, we will use the Gains tab in the

Tree Builder. We will look at lift, which measures how much more likely the records in a node are to fall

under the target category when compared to all records in the dataset. For example, a lift value of 148%

indicates that records in the node are 1.48 times more likely to fall under the target category than all

records in the dataset. Lift is indicated in the Index column on the Gains tab.

1. In the Tree Builder for the full set of predictors, click the Gains tab. Change the target category to 1.0.
Change the display to quartiles by first clicking the Quantiles toolbar button. Then select Quartile
from the drop-down list to the right of this button.

2. Repeat this procedure in the Tree Builder for the set of 10 predictors so that you have two similar
Gains tables to compare, as shown in the following figures.
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Figure 107. Gains charts for the two CHAID models

Each Gains table groups the terminal nodes for its tree into quartiles. To compare the effectiveness of the
two models, look at the lift (Index value) for the top quartile in each table.

When all predictors are included, the model shows a lift of 221%. That is, cases with the characteristics in
these nodes are 2.2 times more likely to respond to the target promotion. To see what those characteristics
are, click to select the top row. Then switch to the Viewer tab, where the corresponding nodes are now
outlined in black. Follow the tree down to each highlighted terminal node to see how the predictors were
split. The top quartile alone includes 10 nodes. When translated into real-world scoring models, 10
different customer profiles can be difficult to manage.

With only the top 10 predictors (as identified by feature selection) included, the lift is nearly 194%.
Although this model is not quite as good as the model that uses all predictors, it is certainly useful. Here,
the top quartile includes only four nodes, so it is simpler. Therefore, we can determine that the feature
selection model is preferable to the one with all predictors.

Summary

Let's review the advantages of feature selection. Using fewer predictors is less expensive. It means that
you have less data to collect, process, and feed into your models. Computing time is improved. In this
example, even with the extra feature selection step, model building was noticeably faster with the smaller
set of predictors. With a larger real-world dataset, the time savings should be greatly amplified.

Using fewer predictors results in simpler scoring. As the example shows, you might identify only four
profiles of customers who are likely to respond to the promotion. Note that with larger numbers of
predictors, you run the risk of overfitting your model. The simpler model may generalize better to other
datasets (although you would need to test this to be sure).
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You could have used a tree-building algorithm to do the feature selection work, allowing the tree to
identify the most important predictors for you. In fact, the CHAID algorithm is often used for this
purpose, and it is even possible to grow the tree level-by-level to control its depth and complexity.
However, the Feature Selection node is faster and easier to use. It ranks all of the predictors in one fast
step, allowing you to identify the most important fields quickly. It also allows you to vary the number of
predictors to include. You could easily run this example again using the top 15 or 20 predictors instead of
10, comparing the results to determine the optimal model.
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Chapter 10. Reducing Input Data String Length (Reclassify
Node)

Reducing Input Data String Length (Reclassify)

For binomial logistic regression, and auto classifier models that include a binomial logistic regression
model, string fields are limited to a maximum of eight characters. Where strings are more than eight
characters, they can be recoded using a Reclassify node.

This example uses the stream named reclassify_strings.str, which references the data file named
drug_long_name. These files are available from the Demos directory of any IBM SPSS Modeler installation.
This can be accessed from the IBM SPSS Modeler program group on the Windows Start menu. The
reclassify_strings.str file is in the streams directory.

This example focuses on a small part of a stream to show the sort of errors that may be generated with
overlong strings and explains how to use the Reclassify node to change the string details to an acceptable
length. Although the example uses a binomial Logistic Regression node, it is equally applicable when
using the Auto Classifier node to generate a binomial Logistic Regression model.

Reclassifying the Data

1. Using a Variable File source node, connect to the dataset drug_long_name in the Demos folder.

-g>

—_— B O

drug_long_name Tie Cholesterol_long

o = =3
+> - —» - -A> - |-£
Cholesterol Filter Type Cholesteral

Figure 108. Sample stream showing string reclassification for binomial logistic regression

2. Add a Type node to the Source node and select Cholesterol_long as the target.
3. Add a Logistic Regression node to the Type node.
4. In the Logistic Regression node, click the Model tab and select the Binomial procedure.
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Figure 109. Long string details in the "Cholesterol_long" field

5. When you execute the Logistic Regression node in reclassify_strings.str, an error message is displayed
warning that the Cholesterol_long string values are too long.

If you encounter this type of error message, follow the procedure explained in the rest of this
example to modify your data.

Meszage

@ Stream execution started

Q Field 'Cholestercl_long' has walue 'High level of cholesterol’ that is too long.
Q Field "Cholesterol_long' has value 'Mormal level of cholesteral' that is too long.
@ Stream execution complete, Elapsed=0.39 zec, CPU=0.02 zec

& Execution was interrupted

Figure 110. Error message displayed when executing the binomial logistic regression node

6. Add a Reclassify node to the Type node.

7. In the Reclassify field, select Cholesterol_long.

8. Type Cholesterol as the new field name.

9. Click the Get button to add the Cholesterol_long values to the original value column.

10. In the new value column, type High next to the original value of High level of cholesterol and
Normal next to the original value of Normal level of cholesterol.
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Figure 111. Reclassifying the long strings

11. Add a Filter node to the Reclassify node.
12. In the Filter column, click to remove Cholesterol_long.
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Figure 112. Filtering the "Cholesterol_long" field from the data

13. Add a Type node to the Filter node and select Cholesterol as the target.
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Figure 113. Short string details in the "Cholesterol” field

14. Add a Logistic Node to the Type node.
15. In the Logistic node, click the Model tab and select the Binomial procedure.

16. You can now execute the Binomial Logistic node and generate a model without displaying an error
message.

100 1BM SPSS Modeler 17.1 Applications Guide



Cholesterol

1|
b

al e

| o
2t iipehizey | Snactations)

Model name: @ Auto © Custom

E Use partitioned data

@ Build model for each split

Procedure: tuttinomial @ Binomial
rBinomial Procecdure
Methoc:  |Enter =
Categoarical Inputs:
Field Mame |C0r|tra31 Base Category

X\

@ Include constant in equation

Figure 114. Choosing Binomial as the procedure

This example only shows part of a stream. If you require further information about the types of streams
in which you may need to reclassify long strings, the following examples are available:

* Auto Classifier node. See the topic [“Modeling Customer Response (Auto Classifier)” on page 35| for

more information.

* Binomial Logistic Regression node. See the topic [Chapter 13, “Telecommunications Churn (Binomiall

[Logistic Regression),” on page 137| for more information.

More information on how to use IBM SPSS Modeler, such as a user's guide, node reference, and
algorithms guide, are available from the \Documentation directory of the installation disk.
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Chapter 11. Modeling Customer Response (Decision List)

The Decision List algorithm generates rules that indicate a higher or lower likelihood of a given binary
(yes or no) outcome. Decision List models are widely used in customer relationship management, such as
call center or marketing applications.

This example is based on a fictional company that wants to achieve more profitable results in future
marketing campaigns by matching the right offer to each customer. Specifically, the example uses a
Decision List model to identify the characteristics of customers who are most likely to respond favorably,
based on previous promotions, and to generate a mailing list based on the results.

Decision List models are particularly well suited to interactive modeling, allowing you to adjust
parameters in the model and immediately see the results. For a different approach that allows you to
automatically create a number of different models and rank the results, the Auto Classifier node can be
used instead.

-8

[ — | —l--?*—h-.}

pm_customer_traind s.. Tvpv\ Selec\ ‘.rfaspunse[ﬂ
i

EEE = % e
Tahle campaign response(1] (1} Table

Figure 115. Decision List sample stream

This example uses the stream pm_decisionlist.str, which references the data file pm_customer_trainl.sav.
These files are available from the Demos directory of any IBM SPSS Modeler installation. This can be
accessed from the IBM SPSS Modeler program group on the Windows Start menu. The pm_decisionlist.str
file is in the streams directory.

Historical Data

The file pm_customer_trainl.sav has historical data tracking the offers made to specific customers in past
campaigns, as indicated by the value of the campaign field. The largest number of records fall under the
Premium account campaign.
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18 a2 Premium account 0 Frull% 0 Frullf Frulls
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20 29 Premium account 0 Frulls 0 Frulls Frulls - |
ry I

Figure 116. Data about previous promotions

The values of the campaign field are actually coded as integers in the data, with labels defined in the Type
node (for example, 2 = Premium account). You can toggle display of value labels in the table using the
toolbar.

The file also includes a number of fields containing demographic and financial information about each
customer that can be used to build or "train" a model that predicts response rates for different groups
based on specific characteristics.

Building the Stream

1. Add a Statistics File node pointing to pm_customer_trainl.sav, located in the Demos folder of your IBM
SPSS Modeler installation. (You can specify $CLEO_DEMOS/ in the file path as a shortcut to reference this
folder.)
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Figure 117. Reading in the data

2. Add a Type node, and select response as the target field (Role = Target). Set the measurement level for
this field to Flag.

Clear Walues Clear Al Walues

Field Measurement Yalues Miz=ing Check Role
{} cLstomer_id ﬁ Cortinuous [7,116993] Mare @ Maone e
G campaign ‘f) Momiral 1234 Mone & Mone
{} rESpOnSE 8 Flag 110 Maone @ Target
E_Ej response_... ‘f Continuous [2006-04. .. Mone & Mone
{} purchasze ﬁ Continuous [01] Mone & Mone
E_Ej purchase_... ‘f Continuous [2006-04. .. Mone & Mone
Cdproduct_id | Continuous [183421] Mone & Mone
3 Rowid & Continuous [1,19599] Mone & Mone
P R, AP orticnons r40 oE1 hlana b !

@ view current fislds Wiewy unused fisld settings

Figure 118. Setting the measurement level and role

3. Set the role to None for the following fields: customer_id, campaign, response_date, purchase,
purchase_date, product_id, Rowid, and X_random. These fields all have uses in the data but will not be
used in building the actual model.

4. Click the Read Values button in the Type node to make sure that values are instantiated.

Although the data includes information about four different campaigns, you will focus the analysis on
one campaign at a time. Since the largest number of records fall under the Premium campaign (coded
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campaign = 2 in the data), you can use a Select node to include only these records in the stream.

Select .

w—ay
. Settings : AD_HQ}%EQ;SJ

Mol @ Include © Dizcard

campsign = 2

Condition:

oo |

Figure 119. Selecting records for a single campaign

Creating the Model

1. Attach a Decision List node to the stream. On the Model tab, set the Target value to 1 to indicate the
outcome you want to search for. In this case, you are looking for customers who responded Yes to a

previous offer.
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Figure 120. Decision List node, Model tab

2. Select Launch interactive session.

To keep the model simple for purposes of this example, set the maximum number of segments to 3.

3
4. Change the confidence interval for new conditions to 85%.
5

On the Expert tab, set the Mode to Expert.
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Figure 121. Decision List node, Expert tab

6. Increase the Maximum number of alternatives to 3. This option works in conjunction with the
Launch interactive session setting that you selected on the Model tab.

7. Click Run to display the Interactive List viewer.
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Figure 122. Interactive List viewer

Since no segments have yet been defined, all records fall under the remainder. Out of 13,504 records
in the sample, 1,952 said Yes, for an overall hit rate of 14.45%. You want to improve on this rate by

identifying segments of customers more (or less) likely to give a favorable response.
In the Interactive List viewer, from the menus choose:

@

Tools > Find Segments
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Figure 123. Interactive List viewer
This runs the default mining task based on the settings you specified in the Decision List node. The

completed task returns three alternative models, which are listed in the Alternatives tab of the Model
Albums dialog box.

110 1BM SPSS Modeler 17.1 Applications Guide



™ Model Albums

5

Mame |Target Mo. of Segments Cover |
Alternative 1 1 2375 1,348 26 76%
Afternative 2 1 2365 1,326 5E6.00%
1 2,380 1329 5584%
Afternative Preview
id Segmernt Rules |Cc-ver (0] |Frequency Probakility
All zegments inchuding Remainder 13,504 1,952 14.45%
=l income, number_products
1 incotne = 55267000 and 12 795 7T
number_products = 1.000
I=I rfm_score, number_transactions
2 rim_score = 12.333 and 737 360 45.85%
number_transactions = 2.000
= number_transactions, income
3 number_tranzactions = 0.000 and 731 174 o5 B0%
number_transactions <= 1.000 and
incame = 4507 2.000
Remainder 11,124 B23 5.60%

i 5 hiot: i
.ﬂ\lternatwes!!_naps EJ

Figure 124. Available alternative models

9. Select the first alternative from the list; its details are shown in the Alternative Preview panel.
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Afternative 3 1.0 3 2,380 1,328 53.54%
Alternative Preview
id Segment Rules Score |Cover (nj |Frequency Probahility
Al segments including Femsainder 13,504 (Ea52 14 45%
=l income, number_products
1 incotme = 55267 000 and 1.0 12 793 B7AT%
number_products = 1.000
=l fm_score, number_transactions
2 rfm_score = 10.535 and 1.0 725 357 49.24%
number_transactions = 3.000
=l average#balanceffeed#index, numbe
averagethalancedfecddindex: = 0.000 :
3 averagetbalancedfesditindex == 349.01.0 738 196 26.56%
number_products == 2.000 and
rfm_score = 3.239
Remainder 11,129 E04 5.43%
Alternatives || Snapshots

Figure 125. Alternative model selected

10.

112

The Alternative Preview panel allows you to quickly browse any number of alternatives without
changing the working model, making it easy to experiment with different approaches.

Note: To get a better look at the model, you may want to maximize the Alternative Preview panel
within the dialog, as shown here. You can do this by dragging the panel border.

Using rules based on predictors, such as income, number of transactions per month, and RFM score,
the model identifies segments with response rates that are higher than those for the sample overall.
When the segments are combined, this model suggests that you could improve your hit rate to
56.76%. However, the model covers only a small portion of the overall sample, leaving over 11,000
records—with several hundred hits among them—to fall under the remainder. You want a model
that will capture more of these hits while still excluding the low-performing segments.

To try a different modeling approach, from the menus choose:

Tools > Settings
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Create/Edit Mining Task: response[1] '

Losd Settings: |i’esponse[1] *§| e | |2

~Target

@Target Figld:  O® response Target Walue: 1

[*]
|§'| Allowy attribute re-use within segment

rEimple Settings
Find segmerts with: High Probabilty =
Maximum number of new segments: E
Winimum segment size
Az percentage of previous segment (9%); E
Az absolute value (M) E
Maithum number of alternatives: E
Maximum attributes per segment: E
[ esg]

Confidence interval for new conditions (9% 850 E
rExpert Settings
Binning methoc: Equal Count Mumber of hins: 10
Madel search width: & Rule search width: =)
Bin merging factor: 2.00
Allowy missing values in conditions: True Discard intermediste results; True
rData

Buill Selection: | &ll Data - @

Availahle fielks: @ al fislds Custom

Figure 126. Create/Edit Mining Task dialog box

11. Click the New button (upper right corner) to create a second mining task, and specify Down Search

as the task name in the New Settings dialog box.
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Create/Edit Mining Task: response[1]

Load Settings: | Down Search T| New...

rTaroet-
@} Target Figld: 08 rezponze Target Walue: 1
Simple Settings -
Fird zegments with: i_ltow Probahility = |
Maximum number of new segments: 3 B

Minimum segment size

Az percentage of previous segment (%) E
Az absolute value (M) mu
" =
Maxithum number of aternatives: E
Mazximum sttributes per segment; E
@ Allowy aftribute re-use within segment
Confidence interval for nevy conditions (9% E
rExpert Settings
Binning method: Equal Count Mumber of hins: 10
Madlel search width: & Rule search width: )
Ein merging factor: 2.00
Allowy missing values in conditions: True Discard intermediste results; True
rData
Build Selection: IAII Data - |®

Luailable fields: @ Al fields © Custom

Figure 127. Create/Edit Mining Task dialog box

12. Change the search direction to Low probability for the task. This will cause the algorithm to search
for segments with the lowest response rates rather than the highest.

13. Increase the minimum segment size to 1,000. Click OK to return to the Interactive List viewer.

14. In Interactive List viewer, make sure that the Segment Finder panel is displaying the new task details

and click Find Segments.

Segment Finder

Find segments with: LLDW Probability = |
Max. no. of new segments; SH‘ P Find Segments |

Figure 128. Find segments in new mining task

The task returns a new set of alternatives, which are displayed in the Alternatives tab of the Model
Albums dialog box and can be previewed in the same manner as previous results.
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& JModel Albums

Mame |Target Mo. of Segments Caver Freqg. Prob. |
I.glternative 1 1 3 9183 232 253%
Afternative 2 1 3 9183 232 253%
Alternative 3 1 3 §,749 144 165%

Afternative Preview
id Segmernt Rules Score |Cover ] |Frequency Probakility
All zegments inchuding Remainder 13,504 1,952 14.45%

=
" =l months_customer 1 1747 a 0. a0

mornths_custamer = "0"

=
S 1= rfm_score 1 5,003 0 0.00%

rim_score == 0.000

=l income, rfm_score
incame = 40297 000 and
3 income == S5267.000 and 1 1,433 232 16.19%
rim_score = 0.000 and
rim_score == 10.535
Remainder 4.3 1,720 39.81%

Atternatives || Snapshots

Figure 129. Down Search model results

This time each model identifies segments with low response probabilities rather than high. Looking
at the first alternative, simply excluding these segments will increase the hit rate for the remainder to
39.81%. This is lower than the model you looked at earlier but with higher coverage (meaning more
total hits).
By combining the two approaches—using a Low Probability search to weed out uninteresting
records, followed by a High Probability search—you may be able to improve this result.

15. Click Load to make this (the first Down Search alternative) the working model and click OK to close
the Model Albums dialog box.
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M Interactive List: response[1] #2

i File  |SEdt & view Tools ¥ Gererate | L)

viewer | Gains || Annotations

B Take Snapshot Segment Finder
Find segments with: iLDW Probability = |
Target field: O® response sy -
Marc. no. of neve segments: 3 kzl‘ P Find Segmerts | M

id Segment Rules Score |C0ver [ |Frequency |Pr0babil'rty
All zegments including Remainder 13,504 1,952 14.45%

- o]

Target value: 1

4 =/ months_customer Evcluded 1,747 1] 0.00%
maonths_customer = "0"

2 | @ rfm_score Excluded 5,003 1] 0.00%
rfth_score == 0,000

=l income, rffm_score
income = 40297 000 and
3 income == 55267 .000 and 1 1,433 232 16.19%

X B0

rfm_gcore = 0.000 and
rfm_scaore == 10.535

Remainder 4,321 1,720 3081%

hodel Summary; Cover 1 433 Frequency 232: Probability 16.19%

Figure 130. Excluding a segment

16. Right-click on each of the first two segments and select Exclude Segment. Together, these segments
capture almost 8,000 records with zero hits between them, so it makes sense to exclude them from
future offers. (Excluded segments will be scored as null to indicate this.)

17. Right-click on the third segment and select Delete Segment. At 16.19%, the hit rate for this segment
is not that different than the baseline rate of 14.45%, so it doesn't add enough information to justify
keeping it in place.

Note: Deleting a segment is not the same as excluding it. Excluding a segment simply changes how it
is scored, while deleting it removes it from the model entirely.

Having excluded the lowest-performing segments, you can now search for high-performing
segments in the remainder.

18. Click on the remainder row in the table to select it, so that the next mining task will apply to the
remainder only.
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.3 Interactive List: response[1] #2

Vi File | SiEdt & view Tools ) Generate | [ @ BB

Wiswer || Gaing Aénotéiéés_.
o ————

_‘k Take Snapshat | Segment Finder -
| Find segments with: Loy Probakbilty =

Target field: O® response |
ll‘u1a><. no. of nevy segments:|

3'%' [P Firct Segm_ents_] |

Target value: 1

Fema\nder

id Segment Rules Score |C0ver [ |Frequency |Pr0babil'rty
All zegments including Remainder 13504 1,952 14.45%
4 | ®months_customer Excluded 1747 i) 0.00%
months_customer = "0"
5 |@rmiscare Excluded £,003 i) 0.00%
rfm_score == 0.000
5754 1,952 33.92%

Model Summary; Cover 0 Freguency 0 Probahility 0%

Figure 131. Selecting a segment

19. With the remainder selected, click Settings to reopen the Create/Edit Mining Task dialog box.

20. At the top, in Load Settings, select the default mining task: response[1].

21. Edit the Simple Settings to increase the number of new segments to 5 and the minimum segment

size to 500.
22. Click OK to return to the Interactive List viewer.
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Create/Edit Mining Task: Down Search

Load Settings: Iresponse[‘l] v| Mewy...

rTarget-
@ Target Figld: 08 rezponze Target Walue: 1
Simple Settings -
Fird zegments with: !Eﬁgh Probahility = |
Mzzximum number of new segments: ] =

Minimum segment size

Az percentage of previous segment (%) 50 E

Az absolute value ()

o
!
EQ

Maximum number of atternatives: 3 =

Maximum attributes per seament: 4 =

E Allowy aftribute re-use within segment

Lol
=)
[+

Confidence interval for nevy conditions (9%

rExpert Settings

Binning method: Equal Count Mumber of hins: 10
Maclel zearch width: 5 Rule zearch width: 5
Ein merging factor: 2.00

Allowy missing values in conditions: True Discard intermediste results; True

rData
Build Selectior: &l Data - .

Luailable fields: @ Al fields © Custom

Figure 132. Selecting the default mining task

23. Click Find Segments.

This displays yet another set of alternative models. By feeding the results of one mining task into
another, these latest models contain a mix of high- and low-performing segments. Segments with
low response rates are excluded, which means that they will be scored as null, while included
segments will be scored as 1. The overall statistics reflect these exclusions, with the first alternative
model showing a hit rate of 45.63%, with higher coverage (1,577 hits out of 3,456 records) than any
of the previous models.
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[ |
 Model Albums
Mame |Target Mo. of Segments Cover Fredg. Prob. |
I.glternative 1 1 it 3,456 1577 43 63%
Atternative 2 1 7 3,456 1577 45 E3%
Alternative 3 1 7 3,436 1577 43 63%
Aternative Preview
idd Segment Rules Score |C0ver ini |Frequency Probahility
Al zegments including Remainder 13,504 1,352 14 45% <
=
1 ST Excluded 1,747 o 0.00%
morths_customer = "0"
=
2 =il =core Exccluded 5,003 o 0.00%
rfth_score == 0.000
= rffm_score, income
3 rfm_zcore = 12.333 and 1 393 436 §2.16%
income = 52213.000
4 i 1 B3 551 55 59%
income = 55267000
=l number_transactions, fm_score
5 number_transactions = 2.000 and 1 533 206 35.65%
rftn_score = 12.333
=
| Alternatives |L Enapshots
L J ’

Figure 133. Alternatives for combined model

24. Preview the first alternative and then click Load to make it the working model.

Calculating Custom Measures Using Excel

1. To gain a bit more insight as to how the model performs in practical terms, choose Organize Model

Measures from the Tools menu.
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.3 Interactive List: response[1] #4

B Find Segments

Bl
Viewer| Gains || Annatations
Settings...
B Ta e Snapshat | Organize Model Measures...

@ Crganize Data Selections...
Target field: O® responze =

@ Change Target Yalue. ..
Target value: 1

B Take Snapshot

].;. Fie | =Bt o view Tools ¢ Generste @@%@ ® m

Segment Fincer -

Find segments with: High Probability =

[ B Find S_egments] [ |

Maz. no. of new segmems:|

id Segment Rules

| Scare | Cover () |Frequency

| Prokaitty |

All zegments including Remainder

=l months_customer
months_customer = "0"

1

= rfm_score
rfm_score == 0.000

= rfm_score, income
3 rfm_score = 12.333 and
income = 52213.000

= income
income = 55267 .000

= number_transactions, rfm_score
5 number_transactions = 2.000 and
rfm_score = 12.333

13,504

Excluded 1,747

Excluded 6,003

1 643

1,852

i}

456

291

206

14.45% <

0.00%

0.00%

82.16%

§9.69% |

38.69%

Model Summary; Cover 3 456: Freguency 1 577: Probahbility 45.63%

8 x|« )

Figure 134. Organizing model measures

The Organize Model Measures dialog box allows you to choose the measures (or columns) to show in
the Interactive List viewer. You can also specify whether measures are computed against all records or
a selected subset, and you can choose to display a pie chart rather than a number, where applicable.
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0 reanize Model Measures

] Hint: Use thiz dialog to define the Model Meazures which are dizplayed in the Vieweer table.

Mame Type Display Data Selection |Show |
Cover Coverage Pie Chart Al Data E| -
Cover (1) Coverage Mumeric Al Data B ‘F‘
Freguency Frequency Mumeric Al Data @ 3
Probability Probability Mumeric All Data E
Error Error Mumeric Al Diata D x
-Custom Measures

Calculate custom measures in Excel (TH): @ ves © No

Conned to Exce_IU(TM Warkbook: | |

hlame | Drezcription Showe |

i

Figure 135. Organize Model Measures dialog box

In addition, if you have Microsoft Excel installed, you can link to an Excel template that will calculate
custom measures and add them to the interactive display.

2. In the Organize Model Measures dialog box, set Calculate custom measures in Excel (TM) to Yes.
Click Connect to Excel (TM)
Select the template_profit.xIt workbook, located under streams in the Demos folder of your IBM SPSS

w

Modeler installation, and click Open to launch the spreadsheet.
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|=] Microsoft Excel - template_profit1
EI_] File Edit Yiew Insert Format  Tools Data  Window Help  Adobe PDF
el G Al -0 -|B J U |SE=Z=HEEy . 5 E
iR 0N |
F4 - A =IF(H4=""0 L4} Settings!Flx_1
A | B & | 3] | E R | G|~
=
1 ‘
2
Metric: Imported Metric:  Calculated Metric: Calculated Metric:
3| # Use |Frequency Cover Profit Margin Cumulative Profit Target
1 4| 1 -2 500.00
= 2 =
W« » w\Model Measures { Settings { Configuration /< | (2]
Ready (A

Figure 136. Excel Model Measures worksheet

The Excel template contains three worksheets:

* Model Measures displays model measures imported from the model and calculates custom
measures for export back to the model.

* Settings contains parameters to be used in calculating custom measures.

* Configuration defines the measures to be imported from and exported to the model.
The metrics exported back to the model are:

* Profit Margin. Net revenue from the segment

* Cumulative Profit. Total profit from campaign

As defined by the following formulas:

Profit Margin = Frequency * Revenue per respondent - Cover * Variable cost
Cumulative Profit = Total Profit Margin - Fixed cost
Note that Frequency and Cover are imported from the model.

The cost and revenue parameters are specified by the user on the Settings worksheet.
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|&] Microsoft Excel - template_profit1
@_] File Edit Yiew Insert Format  Tools Data  Window Help  Adobe PODF
=0 HG o - BIT|U | ESE A @ % 0 W
il 5N |
J12 - p3
A | B JD] E = ™
3 1
)
5]
7
8
9
10
11
12 |Costs and revenue b X
13 |- Fixed costs 2 500,00 7
14 |- Wariable cost 0.50
15 |- Rewenue per respondent 100.00
16
17
18
19
20 g |
L e . A o : 1]
W« » nly Model Measures Y Settings { Configuration /[ <] M ™
Ready LM

Figure 137. Excel Settings worksheet

Fixed cost is the setup cost for the campaign, such as design and planning.

Variable cost is the cost of extending the offer to each customer, such as envelopes and stamps.

Revenue per respondent is the net revenue from a customer who responds to the offer.

5. To complete the link back to the model, use the Windows taskbar (or press Alt+Tab) to navigate back

to the Interactive List viewer.

Choose inputs for Custom Measures

Hint: Use this dislog to choose which model measures will be uzed by Excel (TM) as
inputs to calculste custom measures.

Input |M0del Messure |
Frequency Frequency'
Cover k:over (ni |

Figure 138. Choosing inputs for custom measures

The Choose Inputs for Custom Measures dialog box is displayed, allowing you to map inputs from
the model to specific parameters defined in the template. The left column lists the available measures,
and the right column maps these to spreadsheet parameters as defined in the Configuration

worksheet.

6. In the Model Measures column, select Frequency and Cover (n) against the respective inputs and

click OK.
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In this case, the parameter names in the template—Frequency and Cover (n)—happen to match the
inputs, but different names could also be used.

7. Click OK in the Organize Model Measures dialog box to update the Interactive List viewer.

Organize Model Measures

l#] Hint: Use thiz dialog to define the Model Meazures which are displayed in the Viewer table.

Mame Type Display Data Selection |Show | *f:
Cover Coverage Pie Chart Al Data E| .
cover (m) COvEerage Mumeric Al Data E 3‘
Freguency Frequency Mumeric Al Data E 3
Probability Probability Mumeric: All Data E

Error Errar Mumeric Al Data D )(.

-Zustom Measures

Calculste custom measures in Excel (TH): @ ves © No

Warkbook: |=iIeSEPSSInc\PASIMv10deIer14\.Dem031CIassification_MUduIe'demplateJumf'rt.xlt|

hlame |Description |Show |
Profit margin Exxcel calculated profit margin @
Cumulative profit Excel calculated cumulstive profit @

Figure 139. Organize Model Measures dialog box showing custom measures from Excel

The new measures are now added as new columns in the window and will be recalculated each time the
model is updated.
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2 Interactive List: response[1] #4 E]@@
g File | et o view Toos ¥ Gererate | ) BB

| Wiewer || Gains || Annotations

E Take Snapshat Segment Finder

Find segmerts: with: iHigh Probabilty + ,'
Targetfield: o® - —
3 feabill= Mz, no. of nevy seqments: E >
[>]
Target value: 1
id Segment Rules Score |C0ver [n Frequency |Pr0babil'rty |Pr0f'rt Mmargin |Cumulative... | 'Ji':
All zegments including Remainder 13,504 1,952 14.45% 1] o} .ﬁ
= nth: st
1 T CLLOTI Excluded 1747 0 0.00% 8735 2,500 .
maonths_customer = "0" 2
= rfi +
2 m_gcore Excluded 6,003 ) 000% 30015 2,500
rfm_score == 0.000 k,\
>
= rfm_score, income o
-t

3 rfm_score = 12.333 and 1 3955 436 G216% 453225 425225
income = 52213.000
= income

4 1 643 251 §5.69% 547785 a7 601
income = 55267000 I

= number_transactions, rfm_score
3 number_transactions = 2.000 and 1 533 206 3865% 20,3335 117 9345
rfm_score = 12.333

Model Summary; Cover 3 456: Frequency 1 577: Probahbility 45.63%

Figure 140. Custom measures from Excel displayed in the Interactive List viewer

By editing the Excel template, any number of custom measures can be created.

Modifying the Excel template

Although IBM SPSS Modeler is supplied with a default Excel template to use with the Interactive List
viewer, you may want to change the settings or add your own. For example, the costs in the template
may be incorrect for your organization and need amending.

Note: If you do modify an existing template, or create you own, remember to save the file with an Excel
2003 .xIt suffix.

To modify the default template with new cost and revenue details and update the Interactive List viewer
with the new figures:

1. In the Interactive List viewer, choose Organize Model Measures from the Tools menu.
In the Organize Model Measures dialog box, click Connect to Excel .

3. Select the template_profit.xIt workbook, and click Open to launch the spreadsheet.
4. Select the Settings worksheet.
5. Edit the Fixed costs to be 3,250.00, and the Revenue per respondent to be 150.00.
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| || Microseft Excel - template_profit1.xIt

@ File Edit Wiew Insert Format  Tools Data  Window Help  Adobe PDF

ﬁ_ﬁénrial 210 o B LU S S SFE Sy o )

GAIN_1 - A 150
A [ B JbD] E B e T i

i 18
a

53

7

8

9

10

11

12 | Costs and revenue ‘_ | X
13 |- Fixed costs 3,250.00 1
14 |- Wariable cost 0.50

15 |- Revenue per respondent I 150.00!

16

7

18

19 =
21 ™
Mo« v wfy Model Measures 'y Settings { Configuration / 1< 1 | (=11
Ready MM e

Figure 141. Modified values on Excel Settings worksheet

6. Save the modified template with a unique, relevant filename. Ensure it has an Excel 2003 .xIt
extension.

Save As W
Save in: |E:| Classification_Madule M @~ | Q X T B3 - Tooks -

My Recent
Documents

emplate_profitl, x|k
2] temmplate_profit, xIk

My Documents

My Computer

-

[ File name: |template;roﬁt_3250[xlt M [ Save i
My Hebwork —

Places Save as bype! | Template (%, ) vl Cancel
|

Figure 142. Saving modified Excel template

7. Use the Windows taskbar (or press Alt+Tab) to navigate back to the Interactive List viewer.

In the Choose Inputs for Custom Measures dialog box, select the measures you want to display and
click OK.
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8. In the Organize Model Measures dialog box, click OK to update the Interactive List viewer.

Obviously, this example has only shown one simple way of modifying the Excel template; you can make
further changes that pull data from, and pass data to, the Interactive List viewer, or work within Excel to
produce other output, such as graphs.

& Interactive List: response[1] #4 E]@
@ File | sEdt o view Tools ¥ Gererate | ()
Viewer | Gains | Annotations
B Take Snapshot Segment Finder
Find segments with: !High Probabilty = '
Targetfield: O® response —
Mz, no. of new segments: ﬂ >
Target value: 1
id Segment Rules Score |C0ver (] Frequency |Pr0babil'rty |Pr0frt margin |Cumulative “:I
Al zegments including Remainder 13,504 1,952 14.45% o (1} [£
= nth: st =
1 - CLmeT Excluded 1747 i) 0.00% 8735 .3.250 i
maonths_customer = "0" 2
1= rfi ¥
2 m_care Excluded 6,003 0 0.00% 30015 .3.250
rfm_score == 0.000 r g
b
=l rfm_score, income 3
-
3 rim_score = 12.333 and 1 955 436 G216% B8122.5 64,5725
income = 52213.000
i [EeAnEame: 1 £43 551 a5 6% 23285 147 201
income = 55267 .000 I
= number_transactions, fm_score
3 number_transactions = 2.000 and 1 533 206 3865% 306335 177 8345
rfm_score = 12.333
Model Summary; Cover 3 456: Freguency 1,577: Probahility 45 63%

Figure 143. Modified custom measures from Excel displayed in the Interactive List viewer

Saving the Results

To save a model for later use during your interactive session, you can take a snapshot of the model,
which will be listed on the Snapshots tab. You can return to any saved snapshot at any time during the
interactive session.

Continuing in this manner, you can experiment with additional mining tasks to search for additional
segments. You can also edit existing segments, insert custom segments based on your own business rules,
create data selections to optimize the model for specific groups, and customize the model in a number of
other ways. Finally, you can explicitly include or exclude each segment as appropriate to specify how
each will be scored.

When you are satisfied with your results, you can use the Generate menu to generate a model that can be
added to streams or deployed for purposes of scoring.

Alternatively, to save the current state of your interactive session for another day, choose Update
Modeling Node from the File menu. This will update the Decision List modeling node with the current
settings, including mining tasks, model snapshots, data selections, and custom measures. The next time
you run the stream, just make sure that Use saved session information is selected in the Decision List
modeling node to restore the session to its current state.

Chapter 11. Modeling Customer Response (Decision List) 127



128 1BM SPSS Modeler 17.1 Applications Guide



Chapter 12. Classifying Telecommunications Customers
(Multinomial Logistic Regression)

Logistic regression is a statistical technique for classifying records based on values of input fields. It is
analogous to linear regression but takes a categorical target field instead of a numeric one.

For example, suppose a telecommunications provider has segmented its customer base by service usage
patterns, categorizing the customers into four groups. If demographic data can be used to predict group
membership, you can customize offers for individual prospective customers.

This example uses the stream named telco_custcat.str, which references the data file named telco.sav. These
files are available from the Demos directory of any IBM SPSS Modeler installation. This can be accessed
from the IBM SPSS Modeler program group on the Windows Start menu. The telco_custcat.str file is in the
streams directory.

The example focuses on using demographic data to predict usage patterns. The target field custcat has
four possible values that correspond to the four customer groups, as follows:

Value Label

1 Basic Service
2 E-Service

3 Plus Service
4 Total Service

Because the target has multiple categories, a multinomial model is used. In the case of a target with two
distinct categories, such as yes/no, true/false, or churn/don't churn, a binomial model could be created
instead. See the topic [Chapter 13, “Telecommunications Churn (Binomial Logistic Regression),” on page]
for more information.

Building the Stream

1. Add a Statistics File source node pointing to telco.sav in the Demos folder.

R
v 5
% f Tahle

custeat
124

13 Fields

telco.sav Type Demulraphc »7 custeat
*

Figure 144. Sample stream to classify customers using multinomial logistic regression
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a. Add a Type node and click Read Values, making sure that all measurement levels are set correctly.
For example, most fields with values 0 and 1 can be regarded as flags.

= ml

v
|
=
=)
? Read Yalues Clear Walues Clear Al ¥alues
Field Meazurement ‘Values Mizzing Check Rale
{} gender a;) Mominal 01 Mone A Input e
{:}reside ftorftinuous [1.8] Mone \ It
{} tollfree 8 Flag 140 Mone Y Input 3
{} Ecjuip 8 Flag 10 Mone \ It
{} callcard 8 Flag 140
{:} Wirgless 8 Flag e o Dol
@} longman ﬁ Continuo Select All Continuous
?\.} tollrrlmn &; Eorrf!nuo Select Mane Categorical E
@ View current fields ki SEEEARS r =0 [%
L|'l'_'] Copy Cirl+C Maominal
EE Paste Special... Ciri+y Ordinsl @

Figure 145. Setting the measurement level for multiple fields

Tip: To change properties for multiple fields with similar values (such as 0/1), click the Values
column header to sort fields by value, and then hold down the shift key while using the mouse or
arrow keys to select all the fields you want to change. You can then right-click on the selection to
change the measurement level or other attributes of the selected fields.

Notice that gender is more correctly considered as a field with a set of two values, instead of a flag,
so leave its Measurement value as Nominal.

b. Set the role for the custcat field to Target. All other fields should have their role set to Input.

Type

i |
Types | Farmat II[ Annotations |
I it Lol o =2
M g b Read Yalues Cleat YWalues Clear &1l ¥alues
Field easurement ‘alues Missing Check Role
v L= 4]11] @ riay [ e m Ipul Y
{#}} loglong ﬁ Continuous [-0.10536. .. Mone N Irupouat
P lagtal & Cortinuaus [1.74919... Mone M Input
'@} logecui f Continuous [2.73436... Mone S Irupouat
{#}}Iogcard &Cominuous [1.01160... Mone h It
Q}Iogwire ﬁ(:orrtinuous [2.70136... Mone S Irupoat
& Ininc: & Cortinuaus [219722... Mone M Input
{} custcat &’3 Mominal 1234 Mane @ Target
{} churn &3 Mamirial 01 Mone h It *

@ view current fields “iewe unuzed field settings

Figure 146. Setting field role
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Since this example focuses on demographics, use a Filter node to include only the relevant fields
(region, age, marital, address, income, ed, employ, retire, gender, reside, and custcat). Other fields can be

excluded for the purpose of this analysis.

G Demographic

&

Fields: 42 in, 31 filtered, 0 renamed, 11 out

Field Fitter Field
region — regian %
tenure —— tenUre
age — age A
marital — > marital
address —_— address
income — > income
ed —_— ed
employ —_— employ
retfire —_— retire
gender o ] gender E
@ Viewr currert fields @ Wiew unused field settings

Figure 147. Filtering on demographic fields

(Alternatively, you could change the role to None for these fields rather than exclude them, or select
the fields you want to use in the modeling node.)

Effects, and Include constant in equation as well.

Chapter 12. Classifying Telecommunications Customers (Multinomial Logistic Regression)

In the Logistic node, click the Model tab and select the Stepwise method. Select Multinomial, Main
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Figure 148. Choosing model options

Leave the Base category for target as 1. The model will compare other customers to those who
subscribe to the Basic Service.

3. On the Expert tab, select the Expert mode, select Output, and, in the Advanced Output dialog box,
select Classification table.

Lugistié Regression: Advanced Output
[ Summary statistics [ Parameter estimates

D Likelihood ratio tests Confidence interval 930 :
D A=zymptotic correlstion D Azymptotic covarisnce

D Goodness of fit chi-square statistics E Clazsification table
[ teration history for every 1 : stepl=)

D Stepwize variable loadings D Monctonicity measures

[ Information criteria

)

[Cancel” Help ]

Figure 149. Choosing output options

Browsing the Model

1. Execute the node to generate the model, which is added to the Models palette in the upper-right
corner. To view its details, right-click on the generated model node and choose Browse.
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The model tab displays the equations used to assign records to each category of the target field. There are
four possible categories, one of which is the base category for which no equation details are shown.
Details are shown for the remaining three equations, where category 3 represents Plus Service, and so on.

e

teat

v

W ‘ fﬂﬁile ) Generate Jiiew
-

RN

E-Equstion For 3

0.02137 * address +
0.555E * [ed=1] +
07185 * [ed=2] +
06729 * [ed=3] +
04647 * [ed=4] +
002133 * employ +
0.03447 * reside +
+-1.551

=-Equation For 2

003685 * address +
247 = [ed=1] +
-1.508 * [ed=2] +
-0.9709 * [ed=3] +
-0.6764 * [ed=4] +
0.02635 * employ +
01477 * reside +
+0.04901

[=-Equstion Faor 1
| Base categary

+ 0.00000000000000000000

E-Exqustion Far 4

002184 * address +
3762 * [ed=1] +
-1.955 * [ed=2] +

-1 453 * [ed=3] +
-0.5543 * [ec=4] +
00424 * employ +
0.257E * reside +

+ 01806

Predictor Importance

Target: custcat

ed

employ—]

address—

reside—]

0o 0z 04 06 08 1.0

% 4

Least Important Most Important

- Wiew: |Predictor Importance T

Figure 150. Browsing the model results

The Summary tab shows (among other things) the target and inputs (predictor fields) used by the model.
Note that these are the fields that were actually chosen based on the Stepwise method, not the complete
list submitted for consideration.

Chapter 12. Classifying Telecommunications Customers (Multinomial Logistic Regression)
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Figure 151. Model summary showing target and input fields

The items shown on the Advanced tab depend on the options selected on the Advanced Output dialog
box in the modeling node.

One item that is always shown is the Case Processing Summary, which shows the percentage of records
that falls into each category of the target field. This gives you a null model to use as a basis for
comparison.

Without building a model that used predictors, your best guess would be to assign all customers to the
most common group, which is the one for Plus service.

L3 custeat

\9 }na File f) Generate (EiEW
ww Aolvanced W" w

Case Processing Summary -
H Marginal Percentage
Basic service 266 266%
. E-service 27| 21.7%
| Plus service 281 | 28.1%
| Total service 236 | 235% |
T T T

ok [cancal oot oot

Figure 152. Case processing summary
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Based on the training data, if you assigned all customers to the null model, you would be correct
281/1000 = 28.1% of the time. The Advanced tab contains further information that enables you to
examine the model's predictions. You can then compare the predictions with the null model's results to
see how well the model works with your data.

At the bottom of the Advanced tab, the Classification table shows the results for your model, which is
correct 39.9% of the time.

In particular, your model excels at identifying Total Service customers (category 4) but does a very poor
job of identifying E-service customers (category 2). If you want better accuracy for customers in category
2, you may need to find another predictor to identify them.

ﬂ custcat

=g " al
P Preview

';;p File f) Generate diiew

Pad

| Madel | Summary || Advanced | Seffings | Annotations

[a]
Classification
Predicted
Basic Eigeg Plus Total Percent
Observed service service service Correct
Basic service 122 g 73 &1 459%
E-service a8 10 63 a1 4 6%
Plus service [atz] g 133 a1 47 3%
Total service 47 12 43 134 56.5%
Bverall 3 % 3 8% 3 9% F27% 70.9%
Percentage
o=

Figure 153. Classification table

Depending on what you want to predict, the model may be perfectly adequate for your needs. For
example, if you are not concerned with identifying customers in category 2, the model may be accurate
enough for you. This may be the case where the E-service is a loss-leader that brings in little profit.

If, for example, your highest return on investment comes from customers who fall into category 3 or 4,
the model may give you the information you need.

To assess how well the model actually fits the data, a number of diagnostics are available in the
Advanced Output dialog box when you are building the model. Explanations of the mathematical
foundations of the modeling methods used in IBM SPSS Modeler are listed in the IBM SPSS Modeler
Algorithms Guide, available from the \Documentation directory of the installation disk.

Note also that these results are based on the training data only. To assess how well the model generalizes

to other data in the real world, you can use a Partition node to hold out a subset of records for purposes
of testing and validation.
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Chapter 13. Telecommunications Churn (Binomial Logistic
Regression)

Logistic regression is a statistical technique for classifying records based on values of input fields. It is
analogous to linear regression but takes a categorical target field instead of a numeric one.

This example uses the stream named telco_churn.str, which references the data file named telco.sav. These
files are available from the Demos directory of any IBM SPSS Modeler installation. This can be accessed
from the IBM SPSS Modeler program group on the Windows Start menu. The telco_churn.str file is in the
streams directory.

For example, suppose a telecommunications provider is concerned about the number of customers it is
losing to competitors. If service usage data can be used to predict which customers are liable to transfer
to another provider, offers can be customized to retain as many customers as possible.

This example focuses on using usage data to predict customer loss (churn). Because the target has two
distinct categories, a binomial model is used. In the case of a target with multiple categories, a
multinomial model could be created instead. See the topic [Chapter 12, “Classifying Telecommunications
Customers (Multinomial Logistic Regression),” on page 129| for more information.

Building the Stream

1. Add a Statistics File source node pointing to telco.sav in the Demos folder.

-@> i
) & @ — 75 — 9 — X
Vs .
telco.say Tyte important features Missing Vaue Imputa.. ‘e' chyirn Analysis
I o’
+
+
b
Hv G L& e
cr@m 28 Fields churn Tahle
1

y
Be

churn

Figure 154. Sample stream to classify customers using binomial logistic regression

2. Add a Type node to define fields, making sure that all measurement levels are set correctly. For
example, most fields with values 0 and 1 can be regarded as flags, but certain fields, such as gender,
are more accurately viewed as a nominal field with two values.
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Figure 155. Setting the measurement level for multiple fields

Tip: To change properties for multiple fields with similar values (such as 0/1), click the Values
column header to sort fields by value, and then hold down the Shift key while using the mouse or
arrow keys to select all of the fields that you want to change. You can then right-click on the
selection to change the measurement level or other attributes of the selected fields.

3. Set the measurement level for the churn field to Flag, and set the role to Target. All other fields
should have their role set to Input.

Types || Formet | Annotstions

= . S = =E =
Q L " Read Yalues l Clear Yalues I Clear &1 Yalues ]

Field Measurement ‘alues Mis=sing Check Fale
a7 BRI i rag (KT [RETR (= ™ IR
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2 lagtal & Cortinuaus 174919, . Mone M Input
{1‘3} logecui ﬁ Continuous [2.73436... Mone N Irupouat
{{e}logcard &Cominuous [1.01160... Mone b It
{{#}Iogwire &Corﬂinuous [270136... Mone S Irupouat
& Ininc & Cortinuaus [219722... Mone M Input
{,} custcat é:’j Mominal 1234 Mone S Irupoat
{:} churn 8 Flag 1m0 Mane @ Taroet

@ view current fields  © View unused field seftings

Figure 156. Setting the measurement level and role for the churn field

4. Add a Feature Selection modeling node to the Type node.

Using a Feature Selection node enables you to remove predictors or data that do not add any useful
information with respect to the predictor/target relationship.

5. Run the stream.
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6. Open the resulting model nugget, and from the Generate menu, choose Filter to create a Filter node.
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Figure 157. Generating a Filter node from a Feature Selection node

Not all of the data in the telco.sav file will be useful in predicting churn. You can use the filter to
only select data considered to be important for use as a predictor.

7. In the Generate Filter dialog box, select All fields marked: Important and click OK.
8. Attach the generated Filter node to the Type node.
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Figure 158. Selecting important fields

9. Attach a Data Audit node to the generated Filter node.
Open the Data Audit node and click Run.

10. On the Quality tab of the Data Audit browser, click the % Complete column to sort the column by
ascending numerical order. This lets you identify any fields with large amounts of missing data; in
this case the only field you need to amend is logtoll, which is less than 50% complete.

11. In the Impute Missing column for logtoll, click Specify.

Data Audit of [28 fields] =2

SRl | Edt &) Generste . = |E
Audit | Quality || Annotations
Complete fields () Complete records (%)
Field Measurement Outliers Extremes Action Impute Mizsing Methiod % Complete “alic

{:} logtoll f Continuous 2 0 Mone [Mever = |Fixed 475
{}tenure ﬁ Continuaous 1} 0 Mone Mesver 100
{} age ﬁ Cartinuous o 0 Mone Blank Yalues 100
{1‘?} address ﬁ Continuaous 12 0 Mane Mull Yalues 100
{} incame ﬁ CortinuaLs 9 G Maone Bilank & Mull Yalu 100
{Ped ol orcinal P me Py 100
{} emplay ﬁ CortinuaLs =] 0 Mane Specify 100

Ui 8 Flag -- e 100
{} callcard 8 Flag -- - - Mlerer 100
*@} wirgless 8 Flag -- - - Merver 100
{1‘}} Ionggman ﬁ Continuaous 18 4 Mane Mlerver 100
{#}}tollmon ‘f Continuous a 1 Mone Merver 100
{1‘}} euipman ﬁ Continuous 2 0 Mane Mlerver 100
{@} cardmian ﬁ CortinuaLs 11 3 Maone Mever 100
{1‘}} wyireman ﬁ Continuous & 1 Mane Mlerver 100
{@} langten ﬁ CortinuaLs 20 4 Maone Mever 100
{#?}tolrten f Continuaous 18 2 Mane Mlewer 100
{} carcten ﬁ CortinuaLs 11 G Maone Mever 100
3 voice & Flao -- -l Mewver 100

Figure 159. Imputing missing values for logtoll

12. For Impute when, select Blank and Null values. For Fixed As, select Mean and click OK.

Selecting Mean ensures that the imputed values do not adversely affect the mean of all values in the
overall data.
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Figure 160. Selecting imputation settings

13. On the Data Audit browser Quality tab, generate the Missing Values SuperNode. To do this, from

the menus choose:

Generate > Missing Values SuperNode
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Figure 161. Generating a missing values SuperNode

In the Missing Values SuperNode dialog box, increase the Sample Size to 50% and click OK.
The SuperNode is displayed on the stream canvas, with the title: Missing Value Imputation.

14. Attach the SuperNode to the Filter node.

Chapter 13. Telecommunications Churn (Binomial Logistic Regression)
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Figure 162. Specifying sample size

15. Add a Logistic node to the SuperNode.

16. In the Logistic node, click the Model tab and select the Binomial procedure. In the Binomial Procedure
area, select the Forwards method.

Echurn

e [
@

Expert Ansyze Annctations|

Model name: @ Auts © Custom
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X\

m Include constant in eguation

[ OK ”.“Run-” Cancel.]

Figure 163. Choosing model options

17. On the Expert tab, select the Expert mode and then click Output. The Advanced Output dialog box
is displayed.

18. In the Advanced Output dialog, select At each step as the Display type. Select Iteration history and
Parameter estimates and click OK.
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Figure 164. Choosing output options

Browsing the Model

1. On the Logistic node, click Run to create the model.

The model nugget is added to the stream canvas, and also to the Models palette in the upper-right
corner. To view its details, right-click on the model nugget and select Edit or Browse.

The Summary tab shows (among other things) the target and inputs (predictor fields) used by the

model. Note that these are the fields that were actually chosen based on the Forwards method, not the

complete list submitted for consideration.

Chapter 13. Telecommunications Churn (Binomial Logistic Regression)
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Figure 165. Model summary showing target and input fields

The items shown on the Advanced tab depend on the options selected on the Advanced Output
dialog box in the Logistic node. One item that is always shown is the Case Processing Summary,
which shows the number and percentage of records included in the analysis. In addition, it lists the
number of missing cases (if any) where one or more of the input fields are unavailable and any cases
that were not selected.
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Figure 166. Case processing summary

2. Scroll down from the Case Processing Summary to display the Classification Table under Block 0:
Beginning Block.
The Forward Stepwise method starts with a null model - that is, a model with no predictors - that can
be used as a basis for comparison with the final built model. The null model, by convention, predicts
everything as a 0, so the null model is 72.6% accurate simply because the 726 customers who didn't
churn are predicted correctly. However, the customers who did churn aren't predicted correctly at all.
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Figure 167. Starting classification table- Block 0

3. Now scroll down to display the Classification Table under Block 1: Method = Forward Stepwise.

This Classification Table shows the results for your model as a predictor is added in at each of the
steps. Already, in the first step - after just one predictor has been used - the model has increased the
accuracy of the churn prediction from 0.0% to 29.9%
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Figure 168. Classification table - Block 1

4. Scroll down to the bottom of this Classification Table.

The Classification Table shows that the last step is step 8. At this stage the algorithm has decided that it
no longer needs to add any further predictors into the model. Although the accuracy of the non-churning

customers has decreased a little to 91.2%, the accuracy of the prediction for those who did churn has

risen from the original 0% to 47.1%. This is a significant improvement over the original null model that
used no predictors.

Chapter 13. Telecommunications Churn (Binomial Logistic Regression)

147



—
churn
s B 0o (Ei
[Summar | Advancedd LSeﬂ'n J[-;ﬂ.nnmatio s
s ,\an- -.::..wru-.lwg?r fic i -:J:'na:zJ
. e =
Overall i
a7
Percentage
Ho || 657 B9 905
churn
Step 7 Yes 144 [ 130 47 .4
Pe?::::ge ha
E |
Ho |662 | &4 1.2
churn
Step 8 Yes 145 | 129 471
Overall
791
Percentage
a. The cut walue iz 500
Variables in the Equation
B S.E. | Wald || df |Sig. || Exp(B)
tenure -046 | 004 §123.346 | 1 || .000 55
Step 1(a) ~
Coanctandt AR 428 A4 =T 4 (nluk] 4 ird _|P|

Figure 169. Classification table - Block 1

For a customer who wants to reduce churn, being able to reduce it by nearly half would be a major step
in protecting their income streams.

Note: This example also shows how taking the Overall Percentage as a guide to a model's accuracy may;,
in some cases, be misleading. The original null model was 72.6% accurate overall, whereas the final
predicted model has an overall accuracy of 79.1%; however, as we have seen, the accuracy of the actual
individual category predictions were vastly different.

To assess how well the model actually fits the data, a number of diagnostics are available in the
Advanced Output dialog box when you are building the model. Explanations of the mathematical
foundations of the modeling methods used in IBM SPSS Modeler are listed in the IBM SPSS Modeler
Algorithms Guide, available from the \Documentation directory of the installation disk.

Note also that these results are based on the training data only. To assess how well the model generalizes

to other data in the real world, you would use a Partition node to hold out a subset of records for
purposes of testing and validation.
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Chapter 14. Forecasting Bandwidth Utilization (Time Series)

Forecasting with the Time Series Node

An analyst for a national broadband provider is required to produce forecasts of user subscriptions in
order to predict utilization of bandwidth. Forecasts are needed for each of the local markets that make up
the national subscriber base. You will use time series modeling to produce forecasts for the next three
months for a number of local markets. A second example shows how you can convert source data if it is
not in the correct format for input to the Time Series node.

These examples use the stream named broadband_create_models.str, which references the data file named
broadband_1.sav. These files are available from the Demos folder of any IBM SPSS Modeler installation.
This can be accessed from the IBM SPSS Modeler program group on the Windows Start menu. The
broadband_create_models.str file is in the streams folder.

The last example demonstrates how to apply the saved models to an updated dataset in order to extend
the forecasts by another three months.

In IBM SPSS Modeler, you can produce multiple time series models in a single operation. The source file
you'll be using has time series data for 85 different markets, although for the sake of simplicity you will
only model five of these markets, plus the total for all markets.

The broadband_1.sav data file has monthly usage data for each of 85 local markets. For the purposes of
this example, only the first five series will be used; a separate model will be created for each of these five
series, plus a total.

The file also includes a date field that indicates the month and year for each record. This field will be
used in a Time Intervals node to label records. The date field reads into IBM SPSS Modeler as a string,
but in order to use the field in IBM SPSS Modeler you will convert the storage type to numeric Date
format using a Filler node.

g e -a-»
e -E->
—-y v AP

s B
broadbaid_'l.sav Fier Filler / Type
= © —
Table [Market_1 Market_2 M.. Time iewals ”’ B fields

L
+
¥

- i y  — )
Table G fields [Market_1 $TS-Market.

Figure 170. Sample stream to show Time Series modeling

The Time Series node requires that each series be in a separate column, with a row for each interval. IBM
SPSS Modeler provides methods for transforming data to match this format if necessary.
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Figure 171. Monthly subscription data for broadband local markets

Creating the Stream

1. Create a new stream and add a Statistics File source node pointing to broadband_1.sav.

2. Use a Filter node to filter out the Market_6 to Market_85 fields and the MONTH_and YEAR_ fields to
simplify the model.

Tip: To select multiple adjacent fields in a single operation, click the Market_6 field, hold down the left

mouse button and drag the mouse down to the Market_85 field. Selected fields are highlighted in blue. To
add the other fields, hold down the Ctrl key and click the MONTH_ and YEAR_ fields.
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Figure 172. Simplifying the model

Examining the Data

It is always a good idea to have a feel for the nature of your data before building a model. Do the data

exhibit seasonal variations? Although the Expert Modeler can automatically find the best seasonal or
nonseasonal model for each series, you can often obtain faster results by limiting the search to

nonseasonal models when seasonality is not present in your data. Without examining the data for each of

the local markets, we can get a rough picture of the presence or absence of seasonality by plotting the

total number of subscribers over all five markets.
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Figure 173. Plotting the total number of subscribers

O p -

From the Graphs palette, attach a Time Plot node to the Filter node.
Add the Total field to the Series list.
Deselect the Display series in separate panels and Normalize check boxes.
Click Run.

I Fle | S Edt ) Generste  &F Wiew

Graph || g

Record number

2soo000f -4+ e e
2000000~ =47 e i — e poe SLEEELPEE F--
1500000~ =47 === CRCEER P e SRPTP ot EERELEERR! FEPPRRRRE: B
1000000 -+ y ----_-:.-.-J:-'-"-"- ------ e
500000 | ------ | —————————— | ---------- | --------- IP ......... | _________ |

0 10 20 30 40 50 &0

— Total

Figure 174. Time plot of Total field
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The series exhibits a very smooth upward trend with no hint of seasonal variations. There might be

individual series with seasonality, but it appears that seasonality is not a prominent feature of the

data in general.

Of course you should inspect each of the series before ruling out seasonal models. You can then
separate out series exhibiting seasonality and model them separately.

IBM SPSS Modeler makes it easy to plot multiple series together.

‘ Plot

P & 4
| 1| 1 |
iapneaEnel kvt EEpnctRionsl

Ed[Total]

Piet: @) Selected series © Selected Time Series models

& Markst_1
Series: & Market_2
& Market 3

W awis label @ Defaut © Custom
|:| Display seties in separate panels D Marmalize:

Displary: m Line
[ Paint
D Smoother

E Limit records  Maximum number of records to plat; 2000

|| Cancel

Figure 175. Plotting multiple time series

Reopen the Time Plot node.

© N O

Click Run.

Remove the Total field from the Series list (select it and click the red X button).
Add the Market_1 through Market_5 fields to the list.
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Figure 176. Time plot of multiple fields

Inspection of each of the markets reveals a steady upward trend in each case. Although some markets are
a little more erratic than others, there is no evidence of seasonality to be seen.

Defining the Dates
Now you need to change the storage type of the DATE_ field to Date format.
1. Attach a Filler node to the Filter node.

2. Open the Filler node and click the field selector button.
3. Select DATE_ to add it to Fill in fields.

4. Set the Replace condition to Always.

5. Set the value of Replace with to to_date(DATE_).
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Figure 177. Setting the date storage type

Change the default date format to match the format of the Date field. This is necessary for the
conversion of the Date field to work as expected.

6. On the menu, choose Tools > Stream Properties > Options to display the Stream Options dialog box.
7. Set the default Date format to MON YYYY .
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Figure 178. Setting the date format

Defining the Targets

1. Add a Type node and set the role to None for the DATE_ field. Set the role to Target for all others
(the Market_n fields plus the Total field).

2. Click the Read Values button to populate the Values column.
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Figure 179. Setting the role for multiple fields

Setting the Time Intervals

—_

Select the Build from data option.
Select DATE_ as the build field.

Add a Time Intervals node (from the Field Operations palette).
On the Intervals tab, select Months as the time interval.
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Figure 180. Setting the time interval

5. On the Forecast tab, select the Extend records into the future check box.

6. Set the value to 3.
7. Click OK.
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Figure 181. Setting the forecast period

Creating the Model

1. From the Modeling palette, add a Time Series node to the stream and attach it to the Time Intervals

node.

2. Click Run on the Time Series node using all default settings. Doing so enables the Expert Modeler to
decide the most appropriate model to use for each time series.
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Figure 182. Choosing the Expert Modeler for Time Series

3. Attach the Time Series model nugget to the Time Intervals node.
4. Attach a Table node to the Time Series model and click Run.
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Figure 183. Sample stream to show Time Series modeling

There are now three new rows (61 through 63) appended to the original data. These are the rows for the
forecast period, in this case January to March 2004.

Several new columns are also present now--a number of $TI_ columns added by the Time Intervals node

and the $TS- columns added by the Time Series node. The columns indicate the following for each row
(i.e., each interval in the time series data):
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Column

Description

$TI_Timelndex

The time interval index value for this row.

$TI_TimeLabel

The time interval label for this row.

$TI_Year The year and month indicators for the generated data in
this row.

$TI_Month

$TI_Count The number of records involved in determining the new
data for this row.

$TI_Future Indicates whether this row contains forecast data.

$TS-colname

The generated model data for each column of the
original data.

$TSLCI-colname

the generated model data.

The lower confidence interval value for each column of

$TSUCI-colname

the generated model data.

The upper confidence interval value for each column of

$TS-Total The total of the $TS-colname values for this row.
$TSLCI-Total The total of the $TSLCI-colname values for this row.
$TSUCI-Total The total of the $TSUCI-colname values for this row.

The most significant columns for the forecast operation are the $TS-Market_n, $TSLCI-Market_n, and
$TSUCI-Market_n columns. In particular, these columns in rows 61 through 63 contain the user
subscription forecast data and confidence intervals for each of the local markets.

Examining the Model

1. Double-click the Time Series model nugget to display data about the models generated for each of

the markets.

Note how the Expert Modeler has chosen to generate a different type of model for Market 5 from
the type it has generated for the other markets.
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Figure 184. Time Series models generated for the markets
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The Predictors column shows how many fields were used as predictors for each target—in this case,
none.

The remaining columns in this view show various goodness-of-fit measures for each model. The
StationaryR**2 column shows the Stationary R-squared value. This statistic provides an estimate of
the proportion of the total variation in the series that is explained by the model. The higher the
value (to a maximum of 1.0), the better the fit of the model.

The Q, df, and Sig. columns relate to the Ljung-Box statistic, a test of the randomness of the residual
errors in the model--the more random the errors, the better the model is likely to be. Q is the
Ljung-Box statistic itself, while df (degrees of freedom) indicates the number of model parameters
that are free to vary when estimating a particular target.

The Sig. column gives the significance value of the Ljung-Box statistic, providing another indication
of whether the model is correctly specified. A significance value less than 0.05 indicates that the
residual errors are not random, implying that there is structure in the observed series that is not
accounted for by the model.

Taking both the Stationary R-squared and Significance values into account, the models that the
Expert Modeler has chosen for Market_1, Market_3, and Market_5 are quite acceptable. The Sig.
values for Market_2 and Market_4 are both less than 0.05, indicating that some experimentation with
better-fitting models for these markets might be necessary.

The summary values in the lower part of the display provide information on the distribution of the
statistics across all models. For example, the mean Stationary R-squared value across all the models
is 0.247, while the minimum such value is 0.049 (that of the Total model) and the maximum is 0.544
(the value for Market_5).
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SE denotes the standard error across all the models for each statistic. For example, the standard error
for Stationary R-squared across all models is 0.169.

The summary section also includes percentile values that provide information on the distribution of
the statistics across models. For each percentile, that percentage of models have a value of the fit
statistic below the stated value.

Thus for example, only 25% of the models have a Stationary R-squared value that is less than 0.121.
2. Click the View drop-down list and select Advanced.

The display shows a number of additional goodness-of-fit measures. R**2 is the R-squared value, an
estimation of the total variation in the time series that can be explained by the model. As the
maximum value for this statistic is 1.0, our models are fine in this respect.
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Figure 185. Time Series models advanced display

RMSE is the root mean square error, a measure of how much the actual values of a series differ from
the values predicted by the model, and is expressed in the same units as those used for the series
itself. As this is a measurement of an error, we want this value to be as low as possible. At first sight
it appears that the models for Market_2 and Market_3, while still acceptable according to the statistics
we have seen so far, are less successful than those for the other three markets.

These additional goodness-of-fit measure include the mean absolute percentage errors (MAPE) and
its maximum value (MaxAPE). Absolute percentage error is a measure of how much a target series
varies from its model-predicted level, expressed as a percentage value. By examining the mean and
maximum across all models, you can get an indication of the uncertainty in your predictions.

The MAPE value shows that all models display a mean uncertainty of less than 1%, which is very
low. The MaxAPE value displays the maximum absolute percentage error and is useful for
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imagining a worst-case scenario for your forecasts. It shows that the largest percentage error for each
of the models falls in the range of roughly 1.8 to 2.5%, again a very low set of figures.

The MAE (mean absolute error) value shows the mean of the absolute values of the forecast errors.
Like the RMSE value, this is expressed in the same units as those used for the series itself. MaxAE
shows the largest forecast error in the same units and indicates worst-case scenario for the forecasts.

Interesting though these absolute values are, it is the values of the percentage errors (MAPE and
MaxAPE) that are more useful in this case, as the target series represent subscriber numbers for
markets of varying sizes.

Do the MAPE and MaxAPE values represent an acceptable amount of uncertainty with the models?
They are certainly very low. This is a situation in which business sense comes into play, because
acceptable risk will change from problem to problem. We'll assume that the goodness-of-fit statistics
fall within acceptable bounds and go on to look at the residual errors.

Examining the values of the autocorrelation function (ACF) and partial autocorrelation function
(PACF) for the model residuals provides more quantitative insight into the models than simply
viewing goodness-of-fit statistics.

A well-specified time series model will capture all of the nonrandom variation, including seasonality,
trend, and cyclic and other factors that are important. If this is the case, any error should not be
correlated with itself (autocorrelated) over time. A significant structure in either of the
autocorrelation functions would imply that the underlying model is incomplete.

3. Click the Residuals tab to display the values of the autocorrelation function (ACF) and partial
autocorrelation function (PACF) for the residual errors in the model for the first of the local markets.
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Figure 186. ACF and PACF values for the markets
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In these plots, the original values of the error variable have been lagged by up to 24 time periods
and compared with the original value to see if there is any correlation over time. For the model to be
acceptable, none of the bars in the upper (ACF) plot should extend outside the shaded area, in either
a positive (up) or negative (down) direction.

Should this occur, you would need to check the lower (PACF) plot to see whether the structure is
confirmed there. The PACF plot looks at correlations after controlling for the series values at the
intervening time points.

The values for Market_1 are all within the shaded area, so we can continue and check the values for
the other markets.

4. Click the Display plot for model drop-down list to display these values for the other markets and
the totals.

The values for Market_2 and Market_4 give a little cause for concern, confirming what we suspected
earlier from their Sig. values. We'll need to experiment with some different models for those markets
at some point to see if we can get a better fit, but for the rest of this example, we'll concentrate on
what else we can learn from the Market_1 model.

5. From the Graphs palette, attach a Time Plot node to the Time Series model nugget.

6. On the Plot tab, uncheck the Display series in separate panels check box.

7. At the Series list, click the field selector button, select the Market_1 and $TS-Market_1 fields, and
click OK to add them to the list.

8. Click Run to display a line graph of the actual and forecast data for the first of the local markets.
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Figure 187. Selecting the fields to plot

Notice how the forecast ($TS-Market_1) line extends past the end of the actual data. You now have a
forecast of expected demand for the next three months in this market.

The lines for actual and forecast data over the entire time series are very close together on the graph,
indicating that this is a reliable model for this particular time series.
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Figure 188. Time Plot of actual and forecast data for Market_1

Save the model in a file for use in a future example:
9. Click OK to close the current graph.
10. Open the Time Series model nugget.
11. Choose File > Save Node and specify the file location.
12. Click Save.

You have a reliable model for this particular market, but what margin of error does the forecast
have? You can get an indication of this by examining the confidence interval.

13. Double-click the last Time Plot node in the stream (the one labeled Market_1 $TS-Market_1) to open
its dialog box again.

14. Click the field selector button and add the $TSLCI-Market_1 and $TSUCI-Market_1 fields to the Series
list.

15. Click Run.
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Figure 189. Adding more fields to plot

Now you have the same graph as before, but with the upper ($TSUCI) and lower ($TSLCI) limits of the

confidence interval added.

Notice how the boundaries of the confidence interval diverge over the forecast period, indicating
increasing uncertainty as you forecast further into the future.

However, as each time period goes by, you will have another (in this case) month's worth of actual usage
data on which to base your forecast. You can read the new data into the stream and reapply your model

now that you know it is reliable. See the topic [“Reapplying a Time Series Model” on page 168| for more

information.
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Figure 190. Time Plot with confidence interval added

Summary

You have learned how to use the Expert Modeler to produce forecasts for multiple time series, and you
have saved the resulting models to an external file.

In the next example, you will see how to transform nonstandard time series data into a format suitable
for input to a Time Series node.

Reapplying a Time Series Model

This example applies the time series models from the first time series example but can also be used
independently. See the topic [“Forecasting with the Time Series Node” on page 149| for more information.

As in the original scenario, an analyst for a national broadband provider is required to produce monthly
forecasts of user subscriptions for each of a number of local markets, in order to predict bandwidth
requirements. You have already used the Expert Modeler to create models and to forecast three months
into the future.

Your data warehouse has now been updated with the actual data for the original forecast period, so you
would like to use that data to extend the forecast horizon by another three months.

This example uses the stream named broadband_apply_models.str, which references the data file named
broadband_2.sav. These files are available from the Demos folder of any IBM SPSS Modeler installation.
This can be accessed from the IBM SPSS Modeler program group on the Windows Start menu. The
broadband_apply_models.str file is in the streams folder.
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Retrieving the Stream

In this example, you'll be recreating a Time Series node from the Time Series model saved in the first
example. Don't worry if you don't have a model saved—we've provided one in the Demos folder.

1. Open the stream broadband_apply_models.str from the streams folder under Demos.

hroadband_2 sav Filter Filler Type Titne Igtervals

Table
Figure 191. Opening the stream
Table (89 fields, 63 records) E]@]]

\ad File | Edit £ Generate 3 m
Table || Annatations

1 |Mtarket_82 [Market_83 |Market_64 |Market_85 [Total | vEAR_ [MONTH_ [DATE. |
44 5620 20462 14326 16935 17917..2002 & A0G 2002 |=]
45 G018 21211 14348 17178 18249..2002 @ SEP 2002
45 1320 21893 14333 17601 18604.. 2002 1O OCT 2002
47 F3099 22471 14228 A7RI6  18945.. 2002 11 MOV 2002
45 B4EG7 23112 14514 17937 193432002 12 DEC 2002
43 FS518 23666 14856 18003 197522003 1 JAN 2003
50 BSS70 24668 15182 17675 20M4@.. 2003 2 FEE 2003
51 FGSE7 25468 15708 18214 205402003 3 MAR 2003
52 G757 25868 16155 18557 200222003 4 APR 2003
53 7724 26284 16521 19190 213002003 5 Ma 2003
54 BGE44 26468 16567 19933 216692003 & JUN 2003
55 FOET8 26781  1GR18 20876 20004.. 2003 7 JUL 2003
56 71538 27568 16553 21514 203982003 & A1G 2003
57 7362 26164 16597 21779 227732003 @ SEP 2003
58 74167 28693 16669 22266 23160, 2003 10 OCT 2003
53 76036 28922 16748 22559 23616..2003 11 MO 2003
B0 76630 29811 16798 23018 240672003 12 DEC 2003
61 79002 30034 17122 23160 24509 2004 1 JA&N 2004
f2 §1123 30091 17581 23698 240682004 2 FEE 2004
63 3903 30162 17894 24355  25383.. 2004 3 MaR 2004 |+

11 R ¥ |

Figure 192. Updated sales data

The updated monthly data is collected in broadband_2.sav.

2. Attach a Table node to the IBM SPSS Statistics File source node, open the Table node and click Run.

Note: The data file has been updated with the actual sales data for January through March 2004, in

rows 61 to 63.
3. Open the Time Intervals node on the stream.
4. Click the Forecast tab.
5. Ensure that Extend records into the future is set to 3.
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Figure 193. Checking the setting of the forecast period

Retrieving the Saved Model

1. On the IBM SPSS Modeler menu, choose Insert > Node From File and select the TSmodel.nod file from
the Demos folder (or use the Time Series model you saved in the first time series example).

This file contains the time series models from the previous example. The insert operation places the
corresponding Time Series model nugget on the canvas.

-a»

—FE:' —- 3B @B —

broadband_2.sav Filter Filler Type Time Intervals

FEE

G fields Tahle

Figure 194. Adding the model nugget

Generating a Modeling Node

1. Open the Time Series model nugget and choose Generate > Generate Modeling Node.

This places a Time Series modeling node on the canvas.
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Figure 195. Generating a modeling node from the model nugget

Generating a New Model

1. Close the Time Series model nugget and delete it from the canvas.
The old model was built on 60 rows of data. You need to generate a new model based on the updated

sales data (63 rows).

2. Attach the newly generated Time Series build node to the stream.

L — -+
— (3 (3
broadband_2.sav Filter Filler

Figure 196. Attaching the modeling node to the stream
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A
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Figure 197. Reusing stored settings for the time series model

3. Open the Time Series node.
4. On the Model tab, ensure that Continue estimation using existing models is checked.

5. Click Run to place a new model nugget on the canvas and in the Models palette.
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Examining the New Model

[E Table (30 fields, 66 records)
\gd File |5 Edt ¥ Generate
|

$T|_TimeLabel |$T|_Year |$TI_Morth | $T|_Court | $TI_Future |$TS-Markst_1 |$TSLCIMarket 1
47 Mov2002 2002 1 1 0 10552 10365 <]
43 Dec2002 2002 12 1 0 10593 10408
43 Jan2003 2003 1 1 0 10853 10468
50 Feb2003 2003 2 1 0 10740 10553
51 Mar 2003 2003 3 1 0 10851 10864
52 Apr2003 2003 4 1 0 10803 10722
53 May2003 2003 5 1 0 11153 10968
54 Ln2003 2003 B 1 0 1178 10391
55 Jul 2003 w03 7 1 0 11382 11195
56 Aug2003 2003 8 1 0 11408 11221
57 Sep2003 2003 @ 1 0 11827 11440
58 Oct2003 2003 10 1 0 11735 11608
59 Mov2003 2003 1 1 0 11869 11882
€0 Dec2003 2003 12 1 0 11793 11607
g1 Jan2004 2004 1 0 11888 11500
62 Feb2004 2004 2 1 0 11896 1710
B3 Mar 2004 2004 3 1 0 11998 11810
B4 Apra004 2004 4 o 1 12278 12056
B5 May2004 2004 5 o . 12918 12100
£6 Wn2004 2004 B o . 12553 12167 ~

(41 me————— [+

Figure 198. Table showing new forecast

1. Attach a Table node to the new Time Series model nugget on the canvas.

2. Open the Table node and click Run.

The new model still forecasts three months ahead because you're reusing the stored settings.

However, this time it forecasts April through June because the estimation period (specified on the

Time Intervals node) now ends in March instead of January.
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Figure 199. Specifying fields to plot

3. Attach a Time Plot graph node to the Time Series model nugget.

This time we'll use the time plot display designed especially for time series models.

ok

the list.
6. Click Run.

On the Plot tab, choose the Selected Time Series models option.
At the Series list, click the field selector button, select the $TS-Market_1 field and click OK to add it to

Now you have a graph that shows the actual sales for Market_1 up to March 2004, together with the
forecast (Predicted) sales and the confidence interval (indicated by the blue shaded area) up to June 2004.

As in the first example, the forecast values follow the actual data closely throughout the time period,

indicating once again that you have a good model.
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Figure 200. Forecast extended to June

Summary
You have learned how to apply saved models to extend your previous forecasts when more current data
becomes available, and you have done this without rebuilding your models. Of course, if there is reason
to think that a model has changed, you should rebuild it.
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Chapter 15. Forecasting Catalog Sales (Time Series)

A catalog company is interested in forecasting monthly sales of its men's clothing line, based on their
sales data for the last 10 years.

This example uses the stream named catalog_forecast.str, which references the data file named
catalog_seasfac.sav. These files are available from the Demos directory of any IBM SPSS Modeler
installation. This can be accessed from the IBM SPSS Modeler program group on the Windows Start
menu. The catalog_forecast.str file is in the streams directory.

We've seen in an earlier example how you can let the Expert Modeler decide which is the most
appropriate model for your time series. Now it's time to take a closer look at the two methods that are
available when choosing a model yourself--exponential smoothing and ARIMA.

To help you decide on an appropriate model, it's a good idea to plot the time series first. Visual
inspection of a time series can often be a powerful guide in helping you choose. In particular, you need
to ask yourself:

* Does the series have an overall trend? If so, does the trend appear constant or does it appear to be
dying out with time?

* Does the series show seasonality? If so, do the seasonal fluctuations seem to grow with time or do they
appear constant over successive periods?

Creating the Stream

1. Create a new stream and add a Statistics File source node pointing to catalog_seasfac.sav.

@—-—. — (D

catalog_seasfac.sav Time Igtervals F  men
+

men [men §TS-men]

Figure 201. Forecasting catalog sales
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Figure 202. Specifying the target field

2. Open the IBM SPSS Statistics File source node and select the Types tab.
Click Read Values, then OK.

Click the Role column for the men field and set the role to Target.

Set the role for all the other fields to None, and click OK.

ok~ w

FPeriodicity: 12

Vol st et Aorsters.
Titme Interval:  |[Manths i

©) Start labeling from first record @) Build from data

Field:

Meww field name extension:  |$TI Add ez @ Prefiz © Suffix

Figure 203. Setting the time interval
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Select Build from data.
Set Field to date, and click OK.
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Figure 204. Plotting the time series

10. Attach a Time Plot node to the Time Intervals node.
11. On the Plot tab, add men to the Series list.

12. Deselect the Normalize check box.

13. Click Run.

Attach a Time Intervals node to the IBM SPSS Statistics File source node.
Open the Time Intervals node and set Time Interval to Months.
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Examining the Data

40000
30000

g

€ 20000

10000

e bonmonoend T booooooooooo oo

I | I | I I
1988-01-01 1990-01-01 1992-01-01 1994-01-01 1996-01-01 1998-01-01
Record number

Figure 205. Actual sales of men's clothing

The series shows a general upward trend; that is, the series values tend to increase over time. The
upward trend is seemingly constant, which indicates a linear trend.

The series also has a distinct seasonal pattern with annual highs in December, as indicated by the vertical
lines on the graph. The seasonal variations appear to grow with the upward series trend, which suggests
multiplicative rather than additive seasonality.

1. Click OK to close the plot.

Now that you've identified the characteristics of the series, you're ready to try modeling it. The
exponential smoothing method is useful for forecasting series that exhibit trend, seasonality, or both. As
we've seen, your data exhibit both characteristics.

Exponential Smoothing

Building a best-fit exponential smoothing model involves determining the model type—whether the
model needs to include trend, seasonality, or both—and then obtaining the best-fit parameters for the
chosen model.

The plot of men's clothing sales over time suggested a model with both a linear trend component and a
multiplicative seasonality component. This implies a Winters model. First, however, we will explore a
simple model (no trend and no seasonality) and then a Holt model (incorporates linear trend but no
seasonality). This will give you practice in identifying when a model is not a good fit to the data, an
essential skill in successful model building.
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Figure 206. Specifying exponential smoothing

We'll start with a simple exponential smoothing model.
1. Attach a Time Series node to the Time Intervals node.

2. On the Model tab, set Method to Exponential Smoothing.

3. Click Run to create the model nugget.
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Figure 207. Plotting the Time Series model

4. Attach a Time Plot node to the model nugget.

5. On the Plot tab, add men and $TS-men to the Series list.
6. Deselect the Display series in separate panels and Normalize check boxes.
7. Click Run.
e — N R — E—
E men
: : : : : : ——§TS-men

MO e b e e
20000
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e boooooooond e e
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Figure 208. Simple exponential smoothing model

The men plot represents the actual data, while $TS-men denotes the time series model.

Although the simple model does, in fact, exhibit a gradual (and rather ponderous) upward trend, it
takes no account of seasonality. You can safely reject this model.

8. Click OK to close the time plot window.
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Figure 209. Selecting Holt's model

Let's try Holt's linear model. This should at least model the trend better than the simple model,
although it too is unlikely to capture the seasonality.

9. Reopen the Time Series node.
10. On the Model tab, with Exponential Smoothing still selected as the method, click Criteria.
11. On the Exponential Smoothing Criteria dialog box, choose Holts linear trend.
12. Click OK to close the dialog box.
13. Click Run to re-create the model nugget.
14. Re-open the Time Plot node and click Run.
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Figure 210. Holt's linear trend model

Holt's model displays a smoother upward trend than the simple model but it still takes no account
of the seasonality, so you can discard this one too.

15. Close the time plot window.

You may recall that the initial plot of men's clothing sales over time suggested a model incorporating

a linear trend and multiplicative seasonality. A more suitable candidate, therefore, might be Winters'
model.
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Figure 211. Selecting Winters' model

16. Reopen the Time Series node.

17. On the Model tab, with Exponential Smoothing still selected as the method, click Criteria.
18. On the Exponential Smoothing Criteria dialog box, choose Winters multiplicative.

19. Click OK to close the dialog box.

20. Click Run to re-create the model nugget.

21. Open the Time Plot node and click Run.
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Figure 212. Winters' multiplicative model

This looks better--the model reflects both the trend and the seasonality of the data.

The dataset covers a period of 10 years and includes 10 seasonal peaks occurring in December of each
year. The 10 peaks present in the predicted results match up well with the 10 annual peaks in the real
data.

However, the results also underscore the limitations of the Exponential Smoothing procedure. Looking at
both the upward and downward spikes, there is significant structure that is not accounted for.
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If you are primarily interested in modeling a long-term trend with seasonal variation, then exponential
smoothing may be a good choice. To model a more complex structure such as this one, we need to
consider using the ARIMA procedure.

ARIMA

The ARIMA procedure allows you to create an autoregressive integrated moving-average (ARIMA) model
suitable for finely tuned modeling of time series. ARIMA models provide more sophisticated methods for
modeling trend and seasonal components than do exponential smoothing models, and they allow the
added benefit of including predictor variables in the model.

Continuing the example of the catalog company that wants to develop a forecasting model, we have seen
how the company has collected data on monthly sales of men's clothing along with several series that
might be used to explain some of the variation in sales. Possible predictors include the number of
catalogs mailed and the number of pages in the catalog, the number of phone lines open for ordering, the
amount spent on print advertising, and the number of customer service representatives.

Are any of these predictors useful for forecasting? Is a model with predictors really better than one
without? Using the ARIMA procedure, we can create a forecasting model with predictors, and see if there
is a significant difference in predictive ability over the exponential smoothing model with no predictors.

The ARIMA method enables you to fine-tune the model by specifying orders of autoregression,
differencing, and moving average, as well as seasonal counterparts to these components. Determining the
best values for these components manually can be a time-consuming process involving a good deal of
trial and error, so for this example, we'll let the Expert Modeler choose an ARIMA model for us.

We'll try to build a better model by treating some of the other variables in the dataset as predictor
variables. The ones that seem most useful to include as predictors are the number of catalogs mailed
(mail), the number of pages in the catalog (page), the number of phone lines open for ordering (phone), the
amount spent on print advertising (print), and the number of customer service representatives (service).
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[P‘ Ereview_] [ B Refresh]

FCLEQ _DEMOS/catalog_seasfac sav

Data | Fiter | TYPe= | Annotations

Tl

[ h'__ﬁes_ld \-’alues_ I Clear Yalues I Clear &ll Values ]

Field Measurement Yalues Miz=ing Check Role
[ cate & Continuous [0000-12... Mone © More &
{V} men f Continuous [3245.18,... Maone '@ Target
@ WOmen f Continuaus [1857649... Mone & Nane
{@}jewel f Continuous [5983.55,... Maone & Mone
L% mail & Continuous (1147 15... Mane N Input
{} page f Continuous [&1,114] Mone “ Irupoat
phone ﬁ Cortinuous [17,59] Marne N It
2 print & Continuous [18061 2, ... Mane N Input
{} service ﬁ Cortinuous [1568] Marne N It
{2 VEAR_ @b Nominal 1959,194... Mone © Mone  [=

@ view current fields  © View unused field zettings

=

Figure 213. Setting the predictor fields

1. Open the IBM SPSS Statistics File source node.
2. On the Types tab, set the Role for mail, page, phone, print, and service to Input.
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3. Ensure that the role for men is set to Target and that all the remaining fields are set to None.

4. Click OK.
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Figure 214. Choosing the Expert Modeler

5. Open the Time Series node.
6. On the Model tab, set Method to Expert Modeler and click Criteria.
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Figure 215. Choosing only ARIMA models

7. On the Expert Modeler Criteria dialog box, choose the ARIMA models only option and ensure that

Expert Modeler considers seasonal models is checked.

8. Click OK to close the dialog box.

9. Click Run on the Model tab to re-create the model nugget.
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Figure 216. Expert Modeler chooses two predictors

10. Open the model nugget.

170

0303

Sig. | ‘

Notice how the Expert Modeler has chosen only two of the five specified predictors as being

significant to the model.
11. Click OK to close the model nugget.
12. Open the Time Plot node and click Run.
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Figure 217. ARIMA model with predictors specified

This model improves on the previous one by capturing the large downward spike as well, making it
the best fit so far.

We could try refining the model even further, but any improvements from this point on are likely to
be minimal. We've established that the ARIMA model with predictors is preferable, so let's use the
model we have just built. For the purposes of this example, we'll forecast sales for the coming year.

13. Click OK to close the time plot window.
14. Open the Time Intervals node and select the Forecast tab.
15. Select the Extend records into the future checkbox and set its value to 12.

The use of predictors when forecasting requires you to specify estimated values for those fields in
the forecast period, so that the modeler can more accurately forecast the target field.
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Figure 218. Specifying future values for predictor fields

16.

17.

18.

19.
20.
21.

In the Future Values to use in Forecasting group, click the field selector button to the right of the
Values column.

On the Select Fields dialog box, select mail through service and click OK.

In the real world, you would specify the future values manually at this point, since these five
predictors all relate to items that are under your control. For the purposes of this example, we'll use
one of the predefined functions, to save having to specify 12 values for each predictor. (When you're

more familiar with this example, you might want to try experimenting with different future values
to see what effect they have on the model.)

For each field in turn, click the Values field to display the list of possible values and choose Mean of

recent points. This option calculates the mean of the last three data points for this field and uses that
as the estimated value in each case.

Click OK.

Open the Time Series node and click Run to re-create the model nugget.
Open the Time Plot node and click Run.

The forecast for 1999 looks good--as expected, there's a return to normal sales levels following the

December peak, and a steady upward trend in the second half of the year, with sales in general
significantly above those for the previous year.

Chapter 15. Forecasting Catalog Sales (Time Series) 189



oo P EE e

: men
| ——§TS-men
30000 e

200007

10000

e bsoooaed i e b

I I I 1 1 I 1
1988-01-01 1990-01-01 1992-01-01 1994-01-01 1996-01-01 1998-01-01 2000-01-01
Record number

Figure 219. Sales forecast with predictors specified

Summary

You have successfully modeled a complex time series, incorporating not only an upward trend but also
seasonal and other variations. You have also seen how, through trial and error, you can get closer and
closer to an accurate model, which you have then used to forecast future sales.

In practice, you would need to reapply the model as your actual sales data are updated--for example,
every month or every quarter--and produce updated forecasts. See the topic [“Reapplying a Time Series|
Model” on page 168 for more information.
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Chapter 16. Making Offers to Customers (Self-Learning)

The Self-Learning Response Model (SLRM) node generates and enables the updating of a model that
allows you to predict which offers are most appropriate for customers and the probability of the offers
being accepted. These sorts of models are most beneficial in customer relationship management, such as
marketing applications or call centers.

This example is based on a fictional banking company. The marketing department wants to achieve more
profitable results in future campaigns by matching the right offer of financial services to each customer.
Specifically, the example uses a Self-Learning Response Model to identify the characteristics of customers
who are most likely to respond favorably based on previous offers and responses and to promote the best
current offer based on the results.

This example uses the stream pm_selflearn.str, which references the data files pm_customer_trainl.sav,
pm_customer_train2.sav, and pm_customer_train3.sav. These files are available from the Demos folder of any
IBM SPSS Modeler installation. This can be accessed from the IBM SPSS Modeler program group on the
Windows Start menu. The pm_selflearn.str file is in the streams folder.

Existing Data
The company has historical data tracking the offers made to customers in past campaigns, along with the

responses to those offers. These data also include demographic and financial information that can be used
to predict response rates for different customers.

[ Table (31 fields. 21.927 records) =JoEed
A Fle | Edt ) Generate ' o
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il 7 2 0 Frullf a Frlls Frullf 1 s
2 13 2 a FnullF a g Frul§ 2
3 13 2 0 Frullf 0 Frlls Frllg 3
4 16 2 1 2006-07-05 00:00:00 0 g 183 TE1
B 23 2 0 Frullf 0 Frlls Frullf 4
=} 24 2 0 Frulls 0 Frulls Frullg 5
7 30 2 ] Frullf 0 Frully Frulg B
g 30 3 0 Frulls 0 Frulls Frullg 7
i8] 33 2 ] Frullg a Frullg Frllg 5
10 42 3 0 FrallE 0 Fnung Frl§ 9
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15 74 2 a FnllF a g Frl§ 13
16 74 3 0 Fral 0 FrulF Fral§ 14
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18 g2 2 0 FralF 0 FrulF Fral§ 16
15 a9 3 ] FrallE i} g Frl§ 17
20 549 2 ] FrullF a Frulld Frllg 18 Ed
CT——— B

Figure 220. Responses to previous offers
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Building the Stream

1. Add a Statistics File source node pointing to pm_customer_trainl.sav, located in the Demos folder of
your IBM SPSS Modeler installation.

'1 — —

. 1 2 | -E> {rc.:-]"\’ \;ﬂ i
) i \Z +_’ ) — \.__—L-Il/'f e e '\__+—I'J_-"I e \,\,-:,n-k‘ ::,

pm_customer_traint s.. Filler Type Reclassify campaign

Figure 221. SLRM sample stream

2. Add a Filler node and select campaign as the Fill in field.
3. Select a Replace type of Always.
4. In the Replace with text box, enter to_string(campaign) and click OK.

Filler

k™

Settings

|
anmstetions

Fillin fields:

f Campaign

Replace: Aleays X

Replace with:

to_stringl campaign)

Figure 222. Derive a campaign field

5. Add a Type node, and set the Role to None for the customer_id, response_date, purchase_date,
product_id, Rowid, and X_random fields.
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Figure 223. Changing the Type node settings

6. Set the Role to Target for the campaign and response fields. These are the fields on which you want to
base your predictions.

Set the Measurement to Flag for the response field.
7. Click Read Values, then OK.

Because the campaign field data show as a list of numbers (1, 2, 3, and 4), you can reclassify the
fields to have more meaningful titles.

8. Add a Reclassify node to the Type node.
9. In the Reclassify into field, select Existing field.
10. In the Reclassify field list, select campaign.
11. Click the Get button; the campaign values are added to the Original value column.
12. In the New value column, enter the following campaign names in the first four rows:
* Mortgage
* Car loan
* Savings
* Pension
13. Click OK.
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Figure 224. Reclassify the campaign names

E ) | e

14. Attach an SLRM modeling node to the Reclassify node. On the Fields tab, select campaign for the
Target field, and response for the Target response field.
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Target field:
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@ Use type node settings ©) Use custom settings
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Figure 225. Select the target and target response

15. On the Settings tab, in the Maximum number of predictions per record field, reduce the number to 2.
This means that for each customer, there will be two offers identified that have the highest

probability of being accepted.

16. Ensure that Take account of model reliability is selected, and click Run.
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Figure 226. SLRM node settings

Browsing the Model
1. Open the model nugget. The Model tab initially shows the estimated the accuracy of the predictions
for each offer and the relative importance of each predictor in estimating the model.

To display the correlation of each predictor with the target variable, choose Association with
Response from the View list in the right-hand pane.

2. To switch between each of the four offers for which there are predictions, select the required offer
from the View list in the left-hand pane.
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Figure 227. SLRM model nugget

3. Close the model nugget window.

4. On the stream canvas, disconnect the IBM SPSS Statistics File source node pointing to
pm_customer_tminl.sav.

5. Add a Statistics File source node pointing to pm_customer_train2.sav, located in the Demos folder of

your IBM SPSS Modeler installation, and connect it to the Filler node.

Filler Type Reclgssify ,'campaign
*

[ . |

pm_customer_train2.s.. |
— |

£y |
campaign Table

N

pm_customer_train3.s..

Figure 228. Attaching second data source to SLRM stream
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6. On the Model tab of the SLRM node, select Continue training existing model.

Edc ampaign

Figlds | Modsl | Seftings || Annotstions
Model name: @ Auto © Custom

Eai Use partitioned data
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Target field values: @ Use all © Specify
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Set random seed: 876547
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Mumber of terations:

@ Display model evalustion

~

Figure 229. Continue training model
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7. Click Run to re-create the model nugget. To view its details, double-click the nugget on the canvas.
The Model tab now shows the revised estimates of the accuracy of the predictions for each offer.

8. Add a Statistics File source node pointing to pm_customer_train3.sav, located in the Demos folder of
your IBM SPSS Modeler installation, and connect it to the Filler node.

3 ik S o <>
a3 —- ) — 58 —

pm_customer_traint.s..

E)

Filler Type Reclassify ,'campaign
rd

F

Fl
-
+
r

) y —
o sy

carmpaign Tahle
pm_customer_train3d.s..
Figure 230. Attaching third data source to SLRM stream

9. Click Run to re-create the model nugget once more. To view its details, double-click the nugget on
the canvas.

10. The Model tab now shows the final estimated accuracy of the predictions for each offer.
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As you can see, the average accuracy fell slightly (from 86.9% to 85.4%) as you added the additional
data sources; however, this fluctuation is a minimal amount and may be attributed to slight

anomalies within the available data.
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Figure 231. Updated SLRM model nugget

11. Attach a Table node to the last (third) generated model and execute the Table node.

12. Scroll across to the right of the table. The predictions show which offers a customer is most likely to
accept and the confidence that they will accept, depending on each customer's details.

For example, in the first line of the table shown, there is only a 13.2% confidence rating (denoted by the
value 0.132 in the $SC-campaign-1 column) ) that a customer who previously took out a car loan will
accept a pension if offered one . However, the second and third lines show two more customers who also
took out a car loan; in their cases, there is a 95.7% confidence that they, and other customers with similar
histories, would open a savings account if offered one, and over 80% confidence that they would accept a

pension.
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11 ——

Figure 232. Model output - predicted offers and confidences

Explanations of the mathematical foundations of the modeling methods used in IBM SPSS Modeler are
listed in the IBM SPSS Modeler Algorithms Guide, available from the \Documentation directory of the
product DVD.

Note also that these results are based on the training data only. To assess how well the model generalizes

to other data in the real world, you would use a Partition node to hold out a subset of records for
purposes of testing and validation. .
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Chapter 17. Predicting Loan Defaulters (Bayesian Network)

Bayesian networks enable you to build a probability model by combining observed and recorded

evidence with "common-sense” real-world knowledge to establish the likelihood of occurrences by using

seemingly unlinked attributes.

This example uses the stream named bayes_bankloan.str, which references the data file named bankloan.sav.

These files are available from the Demos directory of any IBM SPSS Modeler installation and can be

accessed from the IBM SPSS Modeler program group on the Windows Start menu. The bayes_bankloan.str

file is in the streams directory.

For example, suppose a bank is concerned about the potential for loans not to be repaid. If previous loan
default data can be used to predict which potential customers are liable to have problems repaying loans,

these "bad risk" customers can either be declined a loan or offered alternative products.

This example focuses on using existing loan default data to predict potential future defaulters, and looks
at three different Bayesian network model types to establish which is better at predicting in this situation.

Building the Stream

1. Add a Statistics File source node pointing to bankloan.sav in the Demos folder.

!l'efo q’?fp .q'efo )

TAN \‘mafw /am,y—Fs e
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hankloan.sav Type Select TAN Markow Markoy-F5

Figure 233. Bayesian Network sample stream
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2. Add a Type node to the source node and set the role of the default field to Target. All other fields

should have their role set to Input.
3. Click the Read Values button to populate the Values column.
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Figure 234. Selecting the target field

Cases where the target has a null value are of no use when building the model. You can exclude
those cases to prevent them from being used in model evaluation.

4. Add a Select node to the Type node.
For Mode, select Discard.
6. In the Condition box, enter default = '$null$'.

o

.Selel::'t'. _ _ w

Seftings | | & r

defaut = "Frulld'

Conelition:

Figure 235. Discarding null targets

Because you can build several different types of Bayesian networks, it is worth comparing several to
see which model provides the best predictions. The first one to create is a Tree Augmented Naive
Bayes (TAN) model.

7. Attach a Bayesian Network node to the Select node.
8. On the Model tab, for Model name, select Custom and enter TAN in the text box.
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9. For Structure type, select TAN and click OK.

Mode! name: Auto @ custom  [TAN

@ Use partitioned data

E Euiled model for each split

-To zelect fields manually, choose "Uze custom settings" on the Fields tab-

X tn

|:| Continue training existing model
Structure type: @ Tan © Markov Blanket

|:| Include feature selection preprocessing step
Parameter learning method:

® Maimum likelihood @ Eaves adjustment for small cell counts

concel _2only

Figure 236. Creating a Tree Augmented Naive Bayes model

The second model type to build has a Markov Blanket structure.
10. Attach a second Bayesian Network node to the Select node.
11. On the Model tab, for Model name, select Custom and enter Markov in the text box.
12. For Structure type, select Markov Blanket and click OK.
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Figure 237. Creating a Markov Blanket model
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The third model type to build has a Markov Blanket structure and also uses feature selection
preprocessing to select the inputs that are significantly related to the target variable.

Attach a third Bayesian Network node to the Select node.

On the Model tab, for Model name, select Custom and enter Markov-FS in the text box.
For Structure type, select Markov Blanket.

Select Include feature selection preprocessing step and click OK.
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Figure 238. Creating a Markov Blanket model with Feature Selection preprocessing

Browsing the Model

1. Run the stream to create the model nuggets, which are added to the stream and to the Models palette
in the upper-right corner. To view their details, double-click on any of the model nuggets in the

stream.

The model nugget Model tab is split into two panes. The left pane contains a network graph of nodes
that displays the relationship between the target and its most important predictors, as well as the

relationship between the predictors.

The right pane shows either Predictor Importance, which indicates the relative importance of each
predictor in estimating the model, or Conditional Probabilities, which contains the conditional
probability value for each node value and each combination of values in its parent nodes.
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Figure 239. Viewing a Tree Augmented Naive Bayes model

2. Connect the TAN model nugget to the Markov nugget (choose Replace on the warning dialog).
3. Connect the Markov nugget to the Markov-FS nugget (choose Replace on the warning dialog).
4. Align the three nuggets with the Select node for ease of viewing.
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Figure 240. Aligning the nuggets in the stream
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5. To rename the model outputs for clarity on the Evaluation graph that you'll be creating, attach a Filter

node to the Markov-FS model nugget.

6. In the right Field column, rename $B-default as TAN, $B1-default as Markov, and $B2-default as

Markov-FS.
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Figure 241. Rename model field names

To compare the models' predicted accuracy, you can build a gains chart.

7. Attach an Evaluation graph node to the Filter node and execute the graph node using its default

settings.

The graph shows that each model type produces similar results; however, the Markov model is

slightly better.

7] Evaluation of [TAN Markov Markov-Fs] -

i=|[=1 %]

I File | Edt £ generste  oF View

100-fifiE SR T Enas ; :
E ; : ;| — N
B-priienantaahe W e e T T R --{ —Markov
¢ | —Markow-Fs

c BO-fEneE el R i L Ao it

" H i i i 1

© H i i | 1 ,

* aopt g g s e e P
2o e oo Lo —
el — R S R

i f f f i i
4] 20 40 60 80 100
Percentile
default=1

Figure 242. Evaluating model accuracy
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To check how well each model predicts, you could use an Analysis node instead of the Evaluation
graph. This shows the accuracy in terms of percentage for both correct and incorrect predictions.

8. Attach an Analysis node to the Filter node and execute the Analysis node using its default settings.

As with the Evaluation graph, this shows that the Markov model is slightly better at predicting correctly;
however, the Markov-FS model is only a few percentage points behind the Markov model. This may
mean it would be better to use the Markov-FS model since it uses fewer inputs to calculate its results,
thereby saving on data collection and entry time and processing time.
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Figure 243. Analyzing model accuracy

Explanations of the mathematical foundations of the modeling methods used in IBM SPSS Modeler are
listed in the IBM SPSS Modeler Algorithms Guide, available from the \Documentation directory of the
installation disk.

Note also that these results are based on the training data only. To assess how well the model generalizes

to other data in the real world, you would use a Partition node to hold out a subset of records for
purposes of testing and validation.
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Chapter 18. Retraining a Model on a Monthly Basis (Bayesian
Network)

Bayesian networks enable you to build a probability model by combining observed and recorded
evidence with "common-sense" real-world knowledge to establish the likelihood of occurrences by using
seemingly unlinked attributes.

This example uses the stream named bayes_churn_retrain.str, which references the data files named
telco_Jan.sav and telco_Feb.sav. These files are available from the Demos directory of any IBM SPSS Modeler
installation and can be accessed from the IBM SPSS Modeler program group on the Windows Start menu.
The bayes_churn_retrain.str file is in the streams directory.

For example, suppose that a telecommunications provider is concerned about the number of customers it
is losing to competitors (churn). If historic customer data can be used to predict which customers are
more likely to churn in the future, these customers can be targeted with incentives or other offers to
discourage them from transferring to another service provider.

This example focuses on using an existing month's churn data to predict which customers may be likely
to churn in the future and then adding the following month's data to refine and retrain the model.

Building the Stream

1. Add a Statistics File source node pointing to telco_Jan.sav in the Demos folder.
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Figure 244. Bayesian Network sample stream

Previous analysis has shown you that several data fields are of little importance when predicting
churn. These fields can be filtered from your data set to increase the speed of processing when you
are building and scoring models.

2. Add a Filter node to the Source node.

3. Exclude all fields except address, age, churn, custcat, ed, employ, gender, marital, reside, retire, and tenure.
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4. Click OK.
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Figure 245. Filtering unnecessary fields

5. Add a Type node to the Filter node.
6. Open the Type node and click the Read Values button to populate the Values column.

7. In order that the Evaluation node can assess which value is true and which is false, set the
measurement level for the churn field to Flag, and set its role to Target. Click OK.
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Figure 246. Selecting the target field

You can build several different types of Bayesian networks; however, for this example you are going
to build a Tree Augmented Naive Bayes (TAN) model. This creates a large network and ensures that
you have included all possible links between data variables, thereby building a robust initial model.
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8. Attach a Bayesian Network node to the Type node.
9. On the Model tab, for Model name, select Custom and enter Jan in the text box.
10. For Parameter learning method, select Bayes adjustment for small cell counts.

11. Click Run. The model nugget is added to the stream, and also to the Models palette in the
upper-right corner.

[] Jan
P

Figlds || Model | Expert | Analyze | Annotations

Mode! name: @ vt @ Custom |.Jan

Eﬂ Use partitioned dats

|_-E1 Euiled model for each split

rTo select fields manually, choose "Use custom settings" on the Fields tab

K &

|:i Continue training existing model
Structure type: @ Tan © Markov Blanket

7] Inciude feature selection preprocessing step
Parameter learning method:

@ Maimum likelihood @ Eaves adjustment for small cell counts

[_ Ok ] [b .Run] [ Canc_el_]

Figure 247. Creating a Tree Augmented Naive Bayes model

12. Add a Statistics File source node pointing to telco_Feb.sav in the Demos folder.

13. Attach this new source node to the Filter node (on the warning dialog, choose Replace to replace the
connection to the previous source node).

@& @& - - @

telcu_.Jan.sV Filter Type Jan-Feb

_

telco_Feb.sav
Figure 248. Adding the second month's data

14. On the Model tab of the Bayesian Network node, for Model name, select Custom and enter Jan-Feb
in the text box.

15. Select Continue training existing model.
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16. Click Run. The model nugget overwrites the existing one in the stream, but is also added to the
Models palette in the upper-right corner.

k4 Jan-Feb . ﬁ

Madel name: © auto @ Custom | Jan-Feb

@ Uze partitioned data

@ Builed model for each split

To select fields manually, choose "Use custom settings" on the Fields tak-

X ta

m Continue training existing maodel
Structure type: @ 1AM © Markov Blanket

|:| Inciude feature selection preprocessing step

Parameter learning method:

@) Maximum likelihood @ Bayes adjustment for small cell counts

| ok |[® runl| cancel | | apply || Resst

Figure 249. Retraining the model

Evaluating the Model

To compare the models, you must combine the two datasets.
1. Add an Append node and attach both the telco_Jan.sav and telco_Feb.sav source nodes to it.
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Figure 250. Append the two data sources

2. Copy the Filter and Type nodes from earlier in the stream and paste them onto the stream canvas.
3. Attach the Append node to the newly copied Filter node.

P o N x"ﬁ'\ N
om0 Y {' T Y f—s—r \
| > | -E>
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e ot s mae’
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f m Y / \I
(@) » (B>
h 4 b i

telco_Feb sav Append

g -G

-E>
= >~
Filter Type

Figure 251. Pasting the copied nodes into the stream

The nuggets for the two Bayesian Network models are located in the Models palette in the
upper-right corner.

4. Double-click the Jan model nugget to bring it into the stream, and attach it to the newly copied Type
node.

5. Attach the Jan-Feb model nugget already in the stream to the Jan model nugget.
6. Open the Jan model nugget.
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Figure 252. Adding the nuggets to the stream

The Bayesian Network model nugget Model tab is split into two columns. The left column contains a
network graph of nodes that displays the relationship between the target and its most important
predictors, as well as the relationship between the predictors.

The right column shows either Predictor Importance, which indicates the relative importance of each
predictor in estimating the model, or Conditional Probabilities, which contains the conditional
probability value for each node value and each combination of values in its parent nodes.
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Figure 253. Bayesian Network model showing predictor importance

To display the conditional probabilities for any node, click on the node in the left column. The right
column is updated to show the required details.

The conditional probabilities are shown for each bin that the data values have been divided into
relative to the node's parent and sibling nodes.
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Figure 254. Bayesian Network model showing conditional probabilities

7. To rename the model outputs for clarity, attach a Filter node to the Jan-Feb model nugget.

8. In the right Field column, rename $B-churn as Jan and $B1-churn as Jan-Feb.
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Figure 255. Rename model field names

To check how well each model predicts churn, use an Analysis node; this shows the accuracy in
terms of percentage for both correct and incorrect predictions.

9. Attach an Analysis node to the Filter node.
10. Open the Analysis node and click Run.
This shows that both models have a similar degree of accuracy when predicting churn.
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Figure 256. Analyzing model accuracy

As an alternative to the Analysis node, you can use an Evaluation graph to compare the models'

predicted accuracy by building a gains chart.

11. Attach an Evaluation graph node to the Filter node.

and execute the graph node using its default settings.

As with the Analysis node, the graph shows that each model type produces similar results; however, the
retrained model using both months' data is slightly better because it has a higher level of confidence in

its predictions.
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Figure 257. Evaluating model accuracy

Explanations of the mathematical foundations of the modeling methods used in IBM SPSS Modeler are
listed in the IBM SPSS Modeler Algorithms Guide, available from the \Documentation directory of the

installation disk.

Note also that these results are based on the training data only. To assess how well the model generalizes
to other data in the real world, you would use a Partition node to hold out a subset of records for

purposes of testing and validation.
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Chapter 19. Retail Sales Promotion (Neural Net/C&RT)

This example deals with data that describes retail product lines and the effects of promotion on sales.
(This data is fictitious.) Your goal in this example is to predict the effects of future sales promotions.
Similar to the condition monitoring example, the data mining process consists of the exploration, data

preparation, training, and test phases.

This example uses the streams named goodsplot.str and goodslearn.str, which reference the data files named
GOODS1n and GOODS2n. These files are available from the Demos directory of any IBM SPSS Modeler
installation. This can be accessed from the IBM SPSS Modeler program group on the Windows Start
menu. The stream goodsplot.str is in the streams folder, while the goodslearn.str file is in the streams
directory.

Examining the Data

Each record contains:

Class. Product type.

Cost. Unit price.

Promotion. Index of amount spent on a particular promotion.

Before. Revenue before promotion.

After. Revenue after promotion.

The stream goodsplot.str contains a simple stream to display the data in a table. The two revenue fields
(Before and After) are expressed in absolute terms; however, it seems likely that the increase in revenue
after the promotion (and presumably as a result of it) would be a more useful figure.

Promotions

M= X

|ad File |5 Eolt

Table || Annotations

B Generate

Clazs |Cost |Prom0tion|BefDre|Aﬂer |
1 Confection 23.930 1467 114357 122762
2 Cirink 78290 1745 123378 137087
3 Lucaury 51.890 1426 135246 141172
4 Confection 74180 1093 231359 244456
5 Confection 90,080 1965 235645 261940
5 Meat 58530 1486 148653 156232
T Meat 1001 ... 1245 123760 128441
g Lugoury 21010 1364 251072 268134
4 Lucaury 57.520 1585 287043 310857
10 Cirink 26.580 1833 240503 272053
11 Crink G5.230 1194 212406 2275356
12 Meat 7H.E20 1596 174022 1514583
13 Confection 41.330 1161 270651 253159
14 Meat 36820 1151 231281 235722
15 Meat 44 050 1482 178155 153954
16 Crink B4 520 1623 2478585 278031
17 Confection 51520 18963 148587 163555
18 Confection 90030 1462 215102 2286596
19 Lugoury o7.300 15842 248553 270052
20 Crink 11.020 1370 164354 176802

B =

Figure 258. Effects of promotion on product sales
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goodsplot.str also contains a node to derive this value, expressed as a percentage of the revenue before the
promotion, in a field called Increase and displays a table showing this field.

Promotions
lgd File = Edit ) Generate
| E— 1
| Tahile Ei_.i\ljnqtatigns_!
Class |Cost |Pr0mc|ti0n |Bef0re |Aﬂer |Increase |
1 Confection 23990 1467 114957 122762 6.739 =
2 Crink TE.2a0 1745 123378 137087 11.119
S Lucury §1.990 1426 133246 141172 4382 £
4 Confection 74180 1093 231359 244456 2647
5 Confection 90090 1963 235645 261940 11.157
(5] hleat 69.830 1486 145555 136232 4.933
T Meat 1001 ... 1248 123760 12844 3782
g Lucury 21010 1364 231072 268134 6.796
4 Loy a7.320 1583 267043 310857 8296
10 Crink 26.580 1835 240505 272863 13.313
11 Drink 65230 1194 212406 227836 7.264
12 Meat 79520 1596 174022 151459 4291
13 Confection 41.390 1161 270631 283189 4.640
14 Meat 36620 1151 231281 233722 1820
15 Meat 44,050 1482 178155 185934 4376
16 Crink 4620 1623 247853 27031 12461
17 Confection 51820 1969 148587 165588 11.44
18 Confection 90030 1462 213102 228696 6.320
19 Loy a7.300 1842 248055 270052 9396
20 Crink 11.020 1370 164854 176502 7163 ]

Figure 259. Increase in revenue after promotion

In addition, the stream displays a histogram of the increase and a scatterplot of the increase against the
promotion costs expended, overlaid with the category of product involved.

10
Increase

Figure 260. Histogram of increase in revenue

The scatterplot shows that for each class of product, an almost linear relationship exists between the
increase in revenue and the cost of promotion. Therefore, it seems likely that a decision tree or neural
network could predict, with reasonable accuracy, the increase in revenue from the other available fields.
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Figure 261. Revenue increase versus promotional expenditure

Promotion

© Confection

Learning and Testing

The stream goodslearn.str trains a neural network and a decision tree to make this prediction of revenue
increase.
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Figure 262. Modeling stream goodslearn.str

Once you have executed the model nodes and generated the actual models, you can test the results of the

ﬁ '

Increase

g

Increase

learning process. You do this by connecting the decision tree and network in series between the Type
node and a new Analysis node, changing the input (data) file to GOODS2n, and executing the Analysis
node. From the output of this node, in particular from the linear correlation between the predicted
increase and the correct answer, you will find that the trained systems predict the increase in revenue
with a high degree of success.

Further exploration could focus on the cases where the trained systems make relatively large errors; these

could be identified by plotting the predicted increase in revenue against the actual increase. Outliers on
this graph could be selected using IBM SPSS Modeler's interactive graphics, and from their properties, it
might be possible to tune the data description or learning process to improve accuracy.
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Chapter 20. Condition Monitoring (Neural Net/C5.0)

This example concerns monitoring status information from a machine and the problem of recognizing
and predicting fault states. The data is created from a fictitious simulation and consists of a number of
concatenated series measured over time. Each record is a snapshot report on the machine in terms of the
following:

* Time. An integer.

* Power. An integer.

¢ Temperature. An integer.

* Pressure. 0 if normal, 1 for a momentary pressure warning.

* Uptime. Time since last serviced.

* Status. Normally 0, changes to error code on error (101, 202, or 303).

*  Outcome. The error code that appears in this time series, or 0 if no error occurs. (These codes are
available only with the benefit of hindsight.)

This example uses the streams named condplot.str and condlearn.str, which reference the data files named
COND1n and COND2n. These files are available from the Demos directory of any IBM SPSS Modeler
installation. This can be accessed from the IBM SPSS Modeler program group on the Windows Start
menu. The condplot.str and condlearn.str files are in the streams directory.

For each time series, there is a series of records from a period of normal operation followed by a period
leading to the fault, as shown in the following table:

Time Power Temperature Pressure Uptime Status Outcome
0 1059 259 0 404 0 0
1 1059 259 0 404 0 0
51 1059 259 0 404 0 0
52 1059 259 0 404 0 0
53 1007 259 0 404 0 303
54 998 259 0 404 0 303
89 839 259 0 404 0 303
90 834 259 0 404 303 303
0 965 251 0 209 0 0
1 965 251 0 209 0 0
51 965 251 0 209 0 0
52 965 251 0 209 0 0
53 938 251 0 209 0 101
54 936 251 0 209 0 101
208 644 251 0 209 0 101
209 640 251 0 209 101 101
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The following process is common to most data mining projects:

* Examine the data to determine which attributes may be relevant to the prediction or recognition of the
states of interest.

* Retain those attributes (if already present), or derive and add them to the data, if necessary.
* Use the resultant data to train rules and neural nets.
* Test the trained systems using independent test data.

Examining the Data

The file condplot.str illustrates the first part of the process. It contains a stream that plots a number of
graphs. If the time series of temperature or power contains visible patterns, you could differentiate
between impending error conditions or possibly predict their occurrence. For both temperature and
power, the stream below plots the time series associated with the three different error codes on separate
graphs, yielding six graphs. Select nodes separate the data associated with the different error codes.

5

[T
imev.Te B

Time v. Power

o,

=}
=

_?)
Select 101
/ 1%
=1 Timew. Temperature
E) —» &>
. 1%

CONDTR Select 202
Time vw. Power
Select 303 Ih Time v. Temperature

Time v. Power
Figure 263. Condplot stream

The results of this stream are shown in this figure.
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Figure 264. Temperature and power over time
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The graphs clearly display patterns distinguishing 202 errors from 101 and 303 errors. The 202 errors
show rising temperature and fluctuating power over time; the other errors do not. However, patterns
distinguishing 101 from 303 errors are less clear. Both errors show even temperature and a drop in power,
but the drop in power seems steeper for 303 errors.

Based on these graphs, it appears that the presence and rate of change for both temperature and power,
as well as the presence and degree of fluctuation, are relevant to predicting and distinguishing faults.
These attributes should therefore be added to the data before applying the learning systems.

Data Preparation

Based on the results of exploring the data, the stream condlearn.str derives the relevant data and learns to

predict faults.
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Figure 265. Condlearn stream

The stream uses a number of Derive nodes to prepare the data for modeling.

Variable File node. Reads data file COND1n.

Derive Pressure Warnings. Counts the number of momentary pressure warnings. Reset when time
returns to 0.

Derive Templnc. Calculates momentary rate of temperature change using @DIFF1.
Derive PowerInc. Calculates momentary rate of power change using @DIFF1.

Derive PowerFlux. A flag, true if power varied in opposite directions in the last record and this one;
that is, for a power peak or trough.

Derive PowerState. A state that starts as Stable and switches to Fluctuating when two successive power
fluxes are detected. Switches back to Stable only when there hasn't been a power flux for five time
intervals or when Time is reset.

PowerChange. Average of Powerlnc over the last five time intervals.

TempChange. Average of Templnc over the last five time intervals.

Discard Initial (select). Discards the first record of each time series to avoid large (incorrect) jumps in
Power and Temperature at boundaries.

Discard fields. Cuts records down to Uptime, Status, Outcome, Pressure Warnings, PowerState,
PowerChange, and TempChange.

Type. Defines the role of Outcome as Target (the field to predict). In addition, defines the measurement
level of Outcome as Nominal, Pressure Warnings as Continuous, and PowerState as Flag.

Learning

Running the stream in condlearn.str trains the C5.0 rule and neural network (net). The network may take
some time to train, but training can be interrupted early to save a net that produces reasonable results.
Once the learning is complete, the Models tab at the upper right of the managers window flashes to alert
you that two new nuggets were created: one represents the neural net and one represents the rule.
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Figure 266. Models manager with model nuggets

The model nuggets are also added to the existing stream, enabling us to test the system or export the
results of the model. In this example, we will test the results of the model.

Testing

The model nuggets are added to the stream, both of them connected to the Type node.

1. Reposition the nuggets as shown, so that the Type node connects to the neural net nugget, which
connects to the C5.0 nugget.

2. Attach an Analysis node to the C5.0 nugget.

3. Edit the original source node to read the file COND2n (instead of COND1n), as COND2n contains
unseen test data.

— ] — —
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Figure 267. Testing the trained network

4. Open the Analysis node and click Run.

Doing so yields figures reflecting the accuracy of the trained network and rule.
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Chapter 21. Classifying Telecommunications Customers
(Discriminant Analysis)

Discriminant analysis is a statistical technique for classifying records based on values of input fields. It is
analogous to linear regression but takes a categorical target field instead of a numeric one.

For example, suppose a telecommunications provider has segmented its customer base by service usage
patterns, categorizing the customers into four groups. If demographic data can be used to predict group
membership, you can customize offers for individual prospective customers.

This example uses the stream named telco_custcat_discriminant.str, which references the data file named
telco.sav. These files are available from the Demos directory of any IBM SPSS Modeler installation. This
can be accessed from the IBM SPSS Modeler program group on the Windows Start menu. The
telco_custcat_discriminant.str file is in the streams directory.

The example focuses on using demographic data to predict usage patterns. The target field custcat has
four possible values which correspond to the four customer groups, as follows:

Value Label

1 Basic Service
2 E-Service

3 Plus Service
4 Total Service

Creating the Stream

1. First, set the stream properties to show variable and value labels in the output. From the menus,
choose:
File > Stream Properties... > Options > General

2. Make sure that Display field and value labels in output is selected and click OK.
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Figure 268. Stream properties

3. Add a Statistics File source node pointing to telco.sav in the Demos folder.

—
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S

— ,—-»E

telco.say Type Demographic . custcat

* /y
custecat x §0-custcat

custeat \ |’

S

13 Fields
Figure 269. Sample stream to classify customers using discriminant analysis

a. Add a Type node and click Read Values, making sure that all measurement levels are set correctly.
For example, most fields with values 0 and 1 can be regarded as flags.
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Figure 270. Setting the measurement level for multiple fields

Tip: To change properties for multiple fields with similar values (such as 0/1), click the Values

column header to sort fields by value, and then hold down the shift key while using the mouse or
arrow keys to select all the fields you want to change. You can then right-click on the selection to

change the measurement level or other attributes of the selected fields.

Notice that gender is more correctly considered as a field with a set of two values, instead of a flag,
so leave its Measurement value as Nominal.

b. Set the role for the custcat field to Target. All other fields should have their role set to Input.
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Figure 271. Setting field role

Since this example focuses on demographics, use a Filter node to include only the relevant fields
(region, age, marital, address, income, ed, employ, retire, gender, reside, and custcat). Other fields can be
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excluded for the purpose of this analysis.

£d Demographic <]

@ i 3= (ml

Fields: 42 in, 31 filtered, 0 renamed, 11 out

|| Figld | Fitter | B Field |
redion — redion e
tenure > tenure

age —_— age

marital —_— marital

address —_— address

income e income

ed —_— ed

employ —_— employ

retire —_— retire

gender —_— gender =]

@ view current fields  © View unuszed field seftings

ok carca

Figure 272. Filtering on demographic fields

(Alternatively, you could change the role to None for these fields rather than exclude them, or select
the fields you want to use in the modeling node.)

4. In the Discriminant node, click the Model tab and select the Stepwise method.

[ custeat

@

hadel name: @ aute © custom

Uze partitioned data

E Euildd model for each split

ethos

Figure 273. Choosing model options

5. On the Expert tab, set the mode to Expert and click Output.

6. Select Summary table, Territorial map, and Summary of Steps in the Advanced Output dialog box,
then click OK.
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ﬂ Discriminant: Advanced Qutput

Statistics
Descriptives: Matrices:
i__l Means Ei Within-groups correlstion
i__I Univariste ANOYAS |_j Within-group covariance
EI Box's M |-j Separate-groups covariance
Function Coefficients: [T] Total covariance
D Fisher's
[ Unstandardized
Clazsification
|__| Casewize results Plats:
1 : (8] Territarial map
@ Summary takble D Combined-groups
i__| Leave-one-out classification |_-j Separate-groups

Stepwvize
La Summary of Steps

I:I F for pairwise distances

(6] (cance | [ e |

Figure 274. Choosing output options

Examining the Model

1. Click Run to create the model, which is added to the stream and to the Models palette in the
upper-right corner. To view its details, double-click on the model nugget in the stream.

The Summary tab shows (among other things) the target and the complete list of inputs (predictor
fields) submitted for consideration.
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Figure 275. Model summary showing target and input fields

For details of the discriminant analysis results:
2. Click the Advanced tab.

3. Click the "Launch in external browser" button (just below the Model tab) to view the results in your
Web browser.

Analyzing Output of Using Discriminant Analysis to Classify
Telecommunications Customers

Stepwise Discriminant Analysis

min. Wilks'

Step Tolerance | Taolerance | F to Enter Lambda
0 Age inyears 1.000 1.000 7821 878

Marital status 1.000 1.000 3.500 8490

Vears at current address 1.000 1.000 8.433 875

Household income in

Winitisards 1.000 1.000 G689 880

Lewel of education 1.000 1.000 61.454 844

Retired 1.000 1.000 3.008 991

Wears with current

employer 1.000 1.000 16.976 851

Gender 1.000 1.000 373 .599

Mumber of people in

househald 1.000 1.000 3476 888

Figure 276. Variables not in the analysis, step 0

When you have a lot of predictors, the stepwise method can be useful by automatically selecting the
"best" variables to use in the model. The stepwise method starts with a model that doesn't include any of
the predictors. At each step, the predictor with the largest F fo Enter value that exceeds the entry criteria

234  1BM SPSS Modeler 17.1 Applications Guide



(by default, 3.84) is added to the model.

hin. Wilks'
Step Tolerance | Tolerance F to Enter Lambda
3 Ageinyears a3a Rl 252 95
darital status 605 593 1.507 792
‘Years at current address TTE JT 34814 787
Eﬂﬂ:ﬂﬂs EEIED 688 57 a7 794
Retirad ;T BE0 353 7495
Gender 8497 431 345 795

Figure 277. Variables not in the analysis, step 3

The variables left out of the analysis at the last step all have F fo Enter values smaller than 3.84, so no
more are added.

Wilks'

Step Tolerance | F to Remove Lamhbda
1 Level of education 1.000 61.454
2 Level of education 953 59.108 451

fears with current

emplayer 453 14.933 844
3 Level of education Aas1 G0.046 940

Years with current

emplaver a34 15.824 834

Mumber of peaple

in househald 474 484 807

Figure 278. Variables in the analysis

This table displays statistics for the variables that are in the analysis at each step. Tolerance is the
proportion of a variable's variance not accounted for by other independent variables in the equation. A
variable with very low tolerance contributes little information to a model and can cause computational
problems.

F to Remove values are useful for describing what happens if a variable is removed from the current
model (given that the other variables remain). F to Remove for the entering variable is the same as F to
Enter at the previous step (shown in the Variables Not in the Analysis table).

A Note of Caution Concerning Stepwise Methods

Stepwise methods are convenient, but have their limitations. Be aware that because stepwise methods
select models based solely upon statistical merit, it may choose predictors that have no practical
significance. If you have some experience with the data and have expectations about which predictors are
important, you should use that knowledge and eschew stepwise methods. If, however, you have many
predictors and no idea where to start, running a stepwise analysis and adjusting the selected model is
better than no model at all.

Checking Model Fit

Canonical
Function | Eigenvalue | % ofvariance | Cumulative % | Caorrelation
1 1498 a0.2 80.2 407
2 048 194 99.6 214
3 001 4 100.0 031

Figure 279. Eigenvalues
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Nearly all of the variance explained by the model is due to the first two discriminant functions. Three
functions are fit automatically, but due to its minuscule eigenvalue, you can fairly safely ignore the third.

Wilks!
Test of Functionis) Lamhbda Chi-square df Sig.
1 thraugh 3 T96 227345 9 .ono
2 through 3 853 47 486 4 .ono
3 Rell] 424 1 335

Figure 280. Wilks' lambda

Wilks' lambda agrees that only the first two functions are useful. For each set of functions, this tests the
hypothesis that the means of the functions listed are equal across groups. The test of function 3 has a
significance value greater than 0.10, so this function contributes little to the model.

Structure Matrix

Function
1 2 3

Level of education HEE* -.080 -.244
‘fears with current i

employer -182 964 - 1493
Age inyearsa -162 599 -.285
Househald incame in .

thuusandsa 109 814 -.140
Years at current address @ -1581 304* -214
Retirada -108 3o =137
Gendera .oog 0a4 .00y
Mumber of people in L
hausehald 232 nar Re Lt
Marital status? 132 134 BO0*

Pooled within-groups correlations hetween discriminating
variables and standardized cananical discriminant functions
Variahles ordered by absolute size of carrelation within function.

* Largest absolute correlation hetween each variable and
any discriminant function

2. This variable not used in the analysis.
Figure 281. Structure matrix

When there is more than one discriminant function, an asterisk(*) marks each variable's largest absolute
correlation with one of the canonical functions. Within each function, these marked variables are then
ordered by the size of the correlation.

* Level of education is most strongly correlated with the first function, and it is the only variable most
strongly correlated with this function.

*  Years with current employer, Age in years, Household income in thousands, Years at current address, Retired,
and Gender are most strongly correlated with the second function, although Gender and Retired are more
weakly correlated than the others. The other variables mark this function as a "stability" function.

*  Number of people in household and Marital status are most strongly correlated with the third discriminant
function, but this is a useless function, so these are nearly useless predictors.
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Territorial Map

Canonical Discriminant
Function 2

=3.0 =2.0 -1.0 .0 1.0 2.0 3.0
| | | | | | |
[ [ | | | [ |
34
T
324
3z24
3z 24
* 3z 24
3z z4
o4 JF Jf 333332 vz4 + JF JF 4
3333333111112 24
33333331111111 + 12 24
33333331111111 1z z4
33331111111 12 z4
H 12 z4
-1.0 4 JF Jf JF 1224 JF JF 4
124
14
| | | | | | |
[ [ | [ [ [ |
-3.0 -2.0 -1.0 .0 1.0 2l 3.0

Canonical Discriminant Function 1
Figure 282. Territorial map

The territorial map helps you to study the relationships between the groups and the discriminant
functions. Combined with the structure matrix results, it gives a graphical interpretation of the
relationship between predictors and groups. The first function, shown on the horizontal axis, separates
group 4 (Total service customers) from the others. Since Level of education is strongly positively correlated
with the first function, this suggests that your Total service customers are, in general, the most highly
educated. The second function separates groups 1 and 3 (Basic service and Plus service customers). Plus
service customers tend to have been working longer and are older than Basic service customers. E-service
customers are not separated well from the others, although the map suggests that they tend to be well
educated with a moderate amount of work experience.

In general, the closeness of the group centroids, marked with asterisks (*), to the territorial lines suggests
that the separation between all groups is not very strong.

Only the first two discriminant functions are plotted, but since the third function was found to be rather
insignificant, the territorial map offers a comprehensive view of the discriminant model.
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Classification Results

Predicted Group Membership

Customer category | Basic serice | E-service | Plus service | Total service Total
COriginal  Count  Basic service 125 11 &1 69 266
E-zervice 449 15 a8 95 217
Flus service 102 14 112 a3 281
Total service 40 16 37 143 236
% Basic service 47.0 4.1 229 259 100.0
E-zemvice 226 6.4 267 43.8 100.0
Flus service 363 a0 389 1849 100.0
Tatal service 16.9 B.a 157 B0.6 100.0

a. 39.9% of original arouped cases correctly classified.
Figure 283. Classification results

From Wilks' lambda, you know that your model is doing better than guessing, but you need to turn to
the classification results to determine how much better. Given the observed data, the "null" model (that is,
one without predictors) would classify all customers into the modal group, Plus service. Thus, the null
model would be correct 281/1000 = 28.1% of the time. Your model gets 11.4% more or 39.5% of the
customers. In particular, your model excels at identifying Total service customers. However, it does an
exceptionally poor job of classifying E-service customers. You may need to find another predictor in order
to separate these customers.

Summary

You have created a discriminant model that classifies customers into one of four predefined "service
usage" groups, based on demographic information from each customer. Using the structure matrix and
territorial map, you identified which variables are most useful for segmenting your customer base. Lastly,
the classification results show that the model does poorly at classifying E-service customers. More research
is required to determine another predictor variable that better classifies these customers, but depending
on what you are looking to predict, the model may be perfectly adequate for your needs. For example, if
you are not concerned with identifying E-service customers the model may be accurate enough for you.
This may be the case where the E-service is a loss-leader which brings in little profit. If, for example,
your highest return on investment comes from Plus service or Total service customers, the model may give
you the information you need.

Also note that these results are based on the training data only. To assess how well the model generalizes
to other data, you can use a Partition node to hold out a subset of records for purposes of testing and
validation.

Explanations of the mathematical foundations of the modeling methods used in IBM SPSS Modeler are

listed in the IBM SPSS Modeler Algorithms Guide. This is available from the \Documentation directory of
the installation disk.
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Chapter 22. Analyzing Interval-Censored Survival Data
(Generalized Linear Models)

When analyzing survival data with interval censoring—that is, when the exact time of the event of
interest is not known but is known only to have occurred within a given interval—then applying the Cox
model to the hazards of events in intervals results in a complementary log-log regression model.

Partial information from a study designed to compare the efficacy of two therapies for preventing the
recurrence of ulcers is collected in ulcer_recurrence.sav. This dataset has been presented and analyzed
elsewhere '. Using generalized linear models, you can replicate the results for the complementary log-log
regression models.

This example uses the stream named ulcer_genlin.str, which references the data file ulcer_recurrence.sav.
The data file is in the Demos folder and the stream file is in the streams subfolder.

Creating the Stream

1. Add a Statistics File source node pointing to ulcer_recurrence.sav in the Demos folder.

{ result

b .-"" =
— EN' Treatrient-only

ulcer_recurrence.sav Field Reurder\‘
e 4

Treatment-only precur Tahle

— =
—_— s —

Figure 284. Sample stream to predict ulcer recurrence

2. On the Filter tab of the source node, filter out id and time.

1. Collett, D. 2003. Modelling survival data in medical research, 2 ed. Boca Raton: Chapman & Hall/CRC.
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(J ulcer_recurrence.sav

FCLEC DEMOS/lcer_recurrence.sav

Fields: 6 in, 2 fitered, O renamed, 4 out

[ Field | Fiter | Field
id > id -
age — age

duration — duration

treatment — treatment

time e time

result — result

@ view current fields  © View unused field zeftings

Figure 285. Filter unwanted fields

]

3. On the Types tab of the source node, set the role for the result field to Target and set its
measurement level to Flag. A result of 1 indicates that the ulcer has recurred. All other fields should
have their role set to Input.

4. Click Read Values to instantiate the data.

4 ulcer_recurrence.sav ﬂ’

FCLEC DEMOS/lcer_recurrence.sav

| Field | Mesuement | \Values | Mssing | Check Rok
{} age f Continuous o [2308] Mone _\ Input
{} duration {l Oriliral | 1,2 | Mone _\ InpLt
{}treatment &3 Momiral | o1 | Mone _\ Input
{} resut 8 Flag 1m Mone @ Tarvet

@ view current fields  © View unused field zeftings

(Lo J [cancat =l

Figure 286. Setting field role

5. Add a Field Reorder node and specify duration, treatment, and age as the order of inputs. This
determines the order in which fields are entered in the model and will help you try to replicate
Collett's results.

240 1BM SPSS Modeler 17.1 Applications Guide



Field Reorder

F. by
\-'\ET.LJ’}
ST
Rearder 1' i |
|lanolstionsy

b —

@ Custom Order Automatic Sort
Type |Field |St0rage
------------------- [ other fields |
I{l duration {} Integer
‘f} treatment {} Irteger
‘f age {} Integer

Maote: Fields added dowwn stream of this node are not reardered.

Figure 287. Reordering fields so they are entered into the model as desired

6. Attach a GenLin node to the source node; on the GenLin node, click the Model tab.

7. Select First (Lowest) as the reference category for the target. This indicates that the second category
is the event of interest, and its effect on the model is in the interpretation of parameter estimates. A
continuous predictor with a positive coefficient indicates increased probability of recurrence with
increasing values of the predictor; categories of a nominal predictor with larger coefficients indicate

increased probability of recurrence with respect to other categories of the set.
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E result
|

e

Fieis| Mol Exprt Ansyze | Ao |
Model name: @ autn © Custom

@ Use partitioned data

@ Euiled model for each split

ocel type: @) Main effects only ©) Main effects and all two-way interactions

Offaet:
@ variable

Offaet field: I vé

@ Fixed value

i
00/

Baze category for flag target |First (Lovwest) =

[&] Include intercept in model

[ Ok ][.’ Run” Cancel]

Figure 288. Choosing model options

8. Click the Expert tab and select Expert to activate the expert modeling options.
9. Select Binomial as the distribution and Complementary log-log as the link function.

10. Select Fixed value as the method for estimating the scale parameter and leave the default value of
1.0.

11. Select Descending as the category order for factors. This indicates that the first category of each
factor will be its reference category; the effect of this selection on the model is in the interpretation of
parameter estimates.
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ﬂ result

Figlds || Modsl | Expert  Analyze | Annotations
mode:  © Simple @ Expert

Target Field Distribution and Link Function

The distribution that you choose determines which link functions are available.

Distribution: iBiania| vi Parameters

@ -
e
-
. ; | = &
Link function; |Commiplementary log-log | -
Method and iterstion seftings are not available it Distribution = Marmal and Link
Function = ldentity.
Parameter Estimation
| - | ]
Methad: |Hyyhorict ol Maximum Fizher scaoring terations:

Scale parameter method: |Fi><l3f>i valle | Yalue:

Covariance matrix; @ Model-based estimator (&) Robust estimstar

—_—
Singularity tolerance: ME-OO7 ™ |

Value order for categorical inputs;  © Ascending @ Descending © Use data arder

s

[ox (B )

Figure 289. Choosing expert options

12. Run the stream to create the model nugget, which is added to the stream canvas, and also to the
Models palette in the upper right corner. To view the model details, right-click the nugget and
choose Edit or Browse.

Tests of Model Effects

Type ll
Wizl
Source Chi-Sguare df Sig.
(Intercept) 536 1 g4
durstion o3 1 855
treatmert 382 1 837
age 358 il 250

Dependent Yariable: Result
Model: (Irtercept), duration, treatment, age

Figure 290. Tests of model effects for main-effects model

None of the model effects is statistically significant; however, any observable differences in the treatment
effects are of clinical interest, so we will fit a reduced model with just the treatment as a model term.
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Fitting the Treatment-Only Model

1. On the Fields tab of the GenLin node, click Use custom settings.
2. Select result as the target.
3. Select treatment as the sole input.

P P e

© Use type node settings ® Use custom zettings
Target: & i -
Inputs: | g treatmert E

parten [
Spilits: @

[C] Use weight figld ] B
[T] Target field represents number of events ocourring in @ set of trials
@ wariable
Trisle field: ] A
@ Fixed value
s
Mumber of trials; 105

Figure 291. Choosing field options

4. Run the stream and open the resulting model nugget.

On the model nugget, select the Advanced tab and scroll to the bottom.
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Parameter Estimates

93% Wiald
Confidence Interval Hypothesis Test
hizld

Parameter B Std. Error Lower Upper Chi-Sguare of i,
(Irtercept) -1 .442 Ao12 -2.425 -480 8.282 1 004
[treatmert=1] 378 E285 -.855 1610 361 1 S48
[treatment=0] 03

(Scale) 1t

Dependent ariable: Result
Maodel: (IMtercept), treatment

A. Set to zero because this parameter is redundant.

b. Fixed st the displayed value.
Figure 292. Parameter estimates for treatment-only model

The treatment effect (the difference of the linear predictor between the two treatment levels; that is, the
coefficient for [treatment=1]) is still not statistically significant, but only suggestive that treatment A
[treatment=0] may be better than B [treatment=1] because the parameter estimate for treatment B is larger
than that for A, and is thus associated with an increased probability of recurrence in the first 12 months.
The linear predictor, (intercept + treatment effect) is an estimate of log(-log(1-P(recury, ), where
P(recur;, ,) is the probability of recurrence at 12 months for treatment t(=A or B). These predicted
probabilities are generated for each observation in the dataset.

Predicted Recurrence and Survival Probabilities

[] Derive
=
—»

i

Derive as: Conditional

| Sefting= | Annotations

Mode: @ single © Muttinle

Derive field:

precur

Derive a=: | Conditional

Field type: |L7’ <Detautt=
If:

| |

Then:

Elze:

s

Figure 293. Derive node settings options

Chapter 22. Analyzing Interval-Censored Survival Data (Generalized Linear Models) 245



1. For each patient, the model scores the predicted result and the probability of that predicted result. In
order to see the predicted recurrence probabilities, copy the generated model to the palette and
attach a Derive node.

2. In the Settings tab, type precur as the derive field.
3. Choose to derive it as Conditional.
4. Click the calculator button to open the Expression Builder for the If condition.

[~
ﬂ Expression Builder - Derive : If
'§G-rezult '|
General Functions ';E Fields >
Function Return Type Field Storage
iz_integer( TEM) Eoolean 8 result Irteger =
iz_real(ITEM) Boolean :El duration Integer
i5_number(ITEM) Eoolean a) treatment Irteger
iz_stringlITEM) Boolean ﬁ age Integer
iz_clatelITEM) Eoolean 8 FG-result Irteger
iz_time( TEM) Boolean ﬁ FGP-result Real
iz_fitmestamp(ITEM) Eoolean f FGP-0 Real
i=_catetimelITEM) Boolean ﬁ FGP-1 Real
to_intecer(ITER) Irteger f FERP-result Real =

is_integer(ITEM)
Returns a value of true if ITEM type is an integer. Ctherwize, returns a value of false.

@ Check expression before saving

Figure 294. Derive node: Expression Builder for If condition

5. Insert the $G-result field into the expression.
6. Click OK.

The derive field precur will take the value of the Then expression when $G-result equals 1 and the
value of the Else expression when it is 0.

246 1BM SPSS Modeler 17.1 Applications Guide



u Expression Builder - Derive : Then

'$GP—result'|

General Functions

Function
iz_integer(TEM)
iz _real(TEM)
iz_numkber(TEM)
i _string(ITEM)
is_date(ITEM)
iz_time(ITEM)
iz_timestamp(ITEM)
iz_clatetime(I TEM)
to_integer(I TER)

Return
Boolean
Boolean
Boolean
Boolean
Boolean
Boolean
Boaolean
Boolean
Integer

is_integer(ITEM)

m Check expression before saving

b
Type Field Storage
8 result Integer -
d:l duratian Integer
65 treatment Integer
& age Irteger
& FiG-result Integer
& FGP-result Real
& 36RO Real
& 36P Real
& FERP-result Real oo

Returns & value of true if ITEM type is an integer. Otherwize, returns & value of falze.

Figure 295. Derive node: Expression Builder for Then expression

7. Click the calculator button to open the Expression Builder for the Then expression.

8. Insert the $GP-result field into the expression.

9. Click OK.

off check Help
)

= Mlicvacnfk CFFica Dickhova Mananar

n Expression Builder - Derive : Else

1-1§GP-resulr!|

General Functions

Function
iz_integer(TEM)
iz _real(ITEM)
iz_number(TEM)
iz _string(ITEM)
iz _dste(ITEM)
is_time(ITEM)
iz_timestamp(ITEM)
is_dlatetime( TEM)
to_integer(I TER)

Return
Boolean
Boalzan
Boolean
Boolean
Boolean
Boolean
Boolean
Boolean
Integer

is_integer(ITEM)

m Check expression before saving

1| ¥R Fieids -
Type Field Storage

8 result Integer =

il duration Irteger

éb treatment Integer

f age Irteger

& FiG-result Inteqer

f FCP-rezult Real

& 36RO Real

& e Resl

& FGRP-rezult Real o

Returns & walue of true if ITEM type is an integer. Otherwise, returns & value of falze.

Figure 296. Derive node: Expression Builder for Else expression

10. Click the calculator button to open the Expression Builder for the Else expression.
11. Type 1- in the expression and then insert the $§GP-result field into the expression.

12. Click OK.
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[ ]

Derive az: Condtional

seings | Anncsts

Mode: (@ Single (@) Muittiple

Derive field:

|precur

Derive as:

Field type: | 4 <Defauts | ¥

If:

|'$G-result' | @

Ther

|'$GP-resuIt' | @

Elze:

[1-3GP-resut | (@)
Lo J ey st

Figure 297. Derive node settings options

13. Attach a table node to the Derive node and execute it.
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[E Table (10 fields, 43 records) #1

@
@
X

laa File = Ecit

Table || Anntations

’@ Generate

©
M

b

resuft |dura1i0n |trea1merrt |age |$G-resuﬂ |$GP-resuIt $GP-0 FGP-1 |
1 1 2 1 45 0 0708 0.708 0.292
2 0 1 1 730 0708 0.708 0.292
2 0 1 1 540 0708 0.708 0.292
4 0 2 1 580 0708 0.708 0.292
5 0 1 0 560 0.7se 0.759 0.211
B 0 2 0 43 0 0733 0.733 0.211
7 0 1 1 M0 0708 0.708 0.292
3 0 1 0 0 0733 0.733 0.211
g 0 1 1 23 0 0.7os 0.708 0.292
10 1 1 1 70 0708 0.708 0.292
11 0 1 1 3/ 0 0.7os 0.708 0.292
12 0 2 1 TE 0 0708 0.708 0.292
13 0 2 0 3B 0 n.7se 0.759 0.211
14 1 1 0 270 0733 0.733 0.211
15 1 1 1 47 0 0.7os 0.708 0.292
16 0 1 0 540 0733 0.733 0.211
17 1 1 1 3B 0 0.7os 0.708 0.292
18 1 2 1 270 0708 0.708 0.292
19 0 2 0 550 n.7se 0.759 0.211
20 0 1 1 7SO0 0708 0.708 0.292
o —

[

Figure 298. Predicted probabilities

There is an estimated 0.211 probability that patients assigned to treatment A will experience a recurrence

in the first 12 months; 0.292 for treatment B. Note that 1-P(recur,, ,) is the survivor probability at 12
months, which may be of more interest to survival analysts.

Modeling the Recurrence Probability by Period

A problem with the model as it stands is that it ignores the information gathered at the first examination;
that is, that many patients did not experience a recurrence in the first six months. A "better" model would
model a binary response that records whether or not the event occurred during each interval. Fitting this
model requires a reconstruction of the original dataset, which can be found in ulcer_recurrence_recoded.sav.

This file contains two additional variables:

* Period, which records whether the case corresponds to the first examination period or the second.

* Result by period, which records whether there was a recurrence for the given patient during the given

period.

Each original case (patient) contributes one case per interval in which it remains in the risk set. Thus, for

example, patient 1 contributes two cases; one for the first examination period in which no recurrence

occurred, and one for the second examination period, in which a recurrence was recorded. Patient 10, on
the other hand, contributes a single case because a recurrence was recorded in the first period. Patients

16, 28, and 34 dropped out of the study after six months, and thus contribute only a single case to the

new dataset.

1. Add a Statistics File source node pointing to ulcer_recurrence_recoded.sav in the Demos folder.
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—b— ’/";iod—]’eatment

L}
ulcer_recurrence_rec.. Field Reurder\ e )

Feriod-Treatment precur Table

Figure 299. Sample stream to predict ulcer recurrence

2. On the Filter tab of the source node, filter out id, time, and result.

@! ulcer_recurrence_recoded.sav

Fields: 8 in, 3 fittered, O renamed, 5 out

_ Field | Filter Il Field
itd e itd

age — age

duration —_— duration

treatment —_— treatment

time > time

resUtt S>> resutt

period —_— period

resuft? — result?

@ Viewr currert fields  © Wiew unused field zettings

o[ cancel] G 6

Figure 300. Filter unwanted fields

3. On the Types tab of the source node, set the role for the result2 field to Target and set its
measurement level to Flag. All other fields should have their role set to Input.
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) ulcer_recurrence_recoded.sav ﬁ

FCLEC _DEMOSlcer _recurrence_recoded sav

| Fisd | Messurement | \alues | Missing | Check | Role
_{} e ‘f Continuous [2378] | Mone “ Input
{} duration {l Orddinal 12 | Mone “ Input
{}treatment &)_Nominal 01 | Mone “ Inputt
{} period {l Ordinal 1,2 | Mone “w Infost
{} resultt2 8 Flag mo | Tone _@_Target

@ view current fields @ View unused field settings

Figure 301. Setting field role

4. Add a Field Reorder node and specify period, duration, treatment, and age as the order of inputs.
Making period the first input (and not including the intercept term in the model) will allow you to fit
a full set of dummy variables to capture the period effects.

{ iaririenrren X

@ Custom Order © Automatic Sort
Type |Field |Storage | @
------------------- [ other fields |
H:l period O Irteger ?
{l curation {) Integer
&) treatment {} Irteger +
ﬁ e {)Integer
+
3+

: Clear Unuzed

Mote: Fields added dovwn stream of this node are not reardered.

Figure 302. Reordering fields so they are entered into the model as desired

5. On the GenLin node, click the Model tab.
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P e poven e

Madel name: @ suto © Custom

@ Use partitioned data

|8 Euile madel for each spit

ockel type: ® Main effects only ©) Main effects and all two-way interactions

Offeet:

@ variahle

Otfet fel: A

(@) Fixed value

s
“allg: 005

Base category for flag target: |FIFSL[LOVWES]

Iﬂ Include intercept in model

Figure 303. Choosing model options

6. Select First (Lowest) as the reference category for the target. This indicates that the second category
is the event of interest, and its effect on the model is in the interpretation of parameter estimates.

7. Deselect Include intercept in model.
8. Click the Expert tab and select Expert to activate the expert modeling options.
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I_-'iglds Moqe_l | Expert ',&nalvze Annmqrigns
Mole: Simple @ Expert

Target Field Distribution and Link Function

The distribution that you choose determines which link functions are available.

Distribution: iBiania| vi Parameters

[ |
Link function; |Complementary log-log b i

Method and iterstion seftings are not available it Distribution = Marmal and Link
Function = ldentity.
Parameter Estimation

- |

Scale parameter method: |Fi><l3f>i valle | Yalue:
Covariance matriz: @ Model-based estimator (&) Robust estimstar
[Foemmee|
Singularity tolerance: {1 E-007 ¥ |

Value order for categorical inputs;  © Ascending @ Descending © Use data arder

[_ Ok, ][b Run

e [=]
Methad: |Hyyhorict ok I Maximum Fizher scaoring terations:

ﬂ result

“.I* 4-F

A

s

Figure 304. Choosing expert options

9. Select Binomial as the distribution and Complementary log-log as the link function.

10. Select Fixed value as the method for estimating the scale parameter and leave the default value of

1.0.

11. Select Descending as the category order for factors. This indicates that the first category of each

factor will be its reference category; the effect of this selection on the model is in the interpretation of

parameter estimates.

12. Run the stream to create the model nugget, which is added to the stream canvas, and also to the
Models palette in the upper right corner. To view the model details, right-click the nugget and

choose Edit or Browse.
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Tests of Model Effects

Type lll
Wizl
SOUrceE Chi-Sguare ioff Sig).
petio 464 1 496
duration .noa 1 988
treatment M7 1 732
age 314 1 575

Dependent ‘ariable: Result by period
Model: period, duration, trestment, age

Figure 305. Tests of model effects for main-effects model

None of the model effects is statistically significant; however, any observable differences in the period
and treatment effects are of clinical interest, so we will fit a reduced model with just those model terms.

Fitting the Reduced Model

1. On the Fields tab of the GenLin node, click Use custom settings.
2. Select result? as the target.
3. Select period and treatment as the inputs.
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ﬂ Period-Treatment
(Fields Model  Expert Analyze  Annotations
D Uze type node settings @ Use custom seftings
Target: | 8 . _result2 [vg ]
IrpLts: d:l period
&3 treatment
b4
Pattition: [vE ]
Spilits:
>
[T Use weight field | =
|j Target field reprezents number of events occurring in a set of trisls
@
Fe
! e
() ) () o

Figure 306. Choosing field options

4. Execute the node and browse the generated model, and then copy the generated model to the palette,
attach a table node, and execute it.

Parameter Estimates

95 Wiald
Canfidence Interval Hypothesis Test
Stel. Wzl

Parameter =] Errar Loset Lpper Chi-Souare of Sig.
[period=2] -1.794 As792 -2.929 -.659 9597 1 ooz
[period=1] -2.208 5512 -3.365 -1.047 13926 1 noo
[treatment=1] 1393 £278 -1.033 1.426 a7 1 J56
[treatment=0] 0®

(Scale) 10

Dependent % ariable: Result by period
Maodel: period, trestment

A, Setto zero because this parameter is redundant.
h. Fixed at the displayed value.

Figure 307. Parameter estimates for treatment-only model
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The treatment effect is still not statistically significant but only suggestive that treatment A may be better
than B because the parameter estimate for treatment B is associated with an increased probability of
recurrence in the first 12 months. The period values are statistically significantly different from 0, but this
is because of the fact that an intercept term is not fit. The period effect (the difference between the values
of the linear predictor for [period=1] and [period=2]) is not statistically significant, as can be seen in the
tests of model effects. The linear predictor (period effect + treatment effect) is an estimate of
log(-log(1-P(recur,, ,)), where P(recur, ) is the probability of recurrence at the period p(=1 or 2,
representing six months or 12 months) given treatment t(=A or B). These predicted probabilities are
generated for each observation in the dataset.

Predicted Recurrence and Survival Probabilities

u Derive
(=
-

i

Derive as: Conditional

| Sefting= | Annctations

Mode: @ single ©) muttiple

Derive figld:

|precur

Derive as: |Cond'rtional !

Field type: | 4% <Defautt=

If:

| @

Then:

Elze:

s

Figure 308. Derive node settings options

1. For each patient, the model scores the predicted result and the probability of that predicted result. In
order to see the predicted recurrence probabilities, copy the generated model to the palette and
attach a Derive node.

2. In the Settings tab, type precur as the derive field.
3. Choose to derive it as Conditional.

4. Click the calculator button to open the Expression Builder for the If condition.
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E Expression Builder - precur : If

' G-resuled '|
General Functions
Function Return
iz_integer([TEM) Boolean
iz_real{ I TERM) Boolean
iz_numkber(TEM) Boolean
i _string(ITEM) Eoolean
iz_date([TEM) Boolean
iz_time(I TEM) Eoolean
iz_timestamp(ITEM) Boolean
iz _datetitme TEM) Eoolean
to_integer(I TER) Integer

Field= o
Type Field Storage
8 result2 Integer =
{l period Irteger
{l duration Integer
a) treatment Irteger
& age Integer
E:HG-resultZ Integer
& FEP-result2 Real
& §5GP0 Real
& 3GP Real =
.

is_integer(ITEM)

@ Check expression before saving

Returns & walue of true if ITEM type is an integer. Otherwize, returns & value of falze.

Figure 309. Derive node: Expression Builder for If condition

5. Insert the $G-result2 field into the expression.

6. Click OK.

The derive field precur will take the value of the Then expression when $G-result2 equals 1 and the
value of the Else expression when it is 0.

Expression Builder - precur : Then

&

'§GP-resulty
General Functions

Function Return
iz_integer(TEM) Boolean
iz _real(TEM) Eoolean
iz_nurmkber(TEM) Boolean
i _string(ITEM) Eoolean
iz_date(TEM) Boolean
iz_time(I TEM) Eoolean
iz_timestamp(ITEM) Boolean
iz _datetitme TEM) Eoolean
to_integer(I TER) Integer

is_integer(ITEM)

@ Check expression before saving

-
Field Storage

results Integer =
period Irteger

duration Integer

treatment Irteger

age Integer

FG-result2 Irteger

Resl

FGP-0 Real

$GP-1 Resl o

Returns & walue of true if ITEM type is an integer. Otherwize, returns & value of falze.

Figure 310. Derive node: Expression Builder for Then expression

7. Click the calculator button to open the Expression Builder for the Then expression.

8. Insert the $GP-result? field into the expression.

9. Click OK.
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' Expfession Builder - -precur : Else .

1-'4GP-resultz |

General Functions ! ¥
Function | Return Type | Field | Storage

iz_integer( TEM) Boolean 8 resutt? Inteaer o

iz_teal{TEM) Boolean ;[l period Int et

iz_number (I TEM) Boolean {l duration Integer

iz _string(ITEM) Eoolean &) treatment Irteger

iz_clate([TEM) Boolean f age Integer

i _fitne( TEM) Eoolean 5 8 FG-result2 Irteger

iz_timestamp(I TEM) Boolesn and) o | &7 Real

iz _clatetitme(ITEM) Eoolean ﬁ FGP-0 Real

to_integer(ITER) Integer - ‘yi FEP-1 Real =

is_integer(ITEM)
Returns & value of true if ITEM type is an integer. Otherwize, returns & value of falze.

m Check expression before saving

Figure 311. Derive node: Expression Builder for Else expression

10. Click the calculator button to open the Expression Builder for the Else expression.
11. Type 1- in the expression and then insert the $GP-result2 field into the expression.
12. Click OK.

' precur
@ s el

5>

Derive az: Condtional

Mode: (@ Single @) Muittiple

Derive field:

|precur

Derive as: | Condtional ™
Field type; g:Defaunb £ of

If:

|'$G-res:ult2' |

Ther

|'$GP-resuIt2' |

Elze:

|1 SGPresutz’ |

Figure 312. Derive node settings options
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13. Attach a table node to the Derive node and execute it.

[ Table (11 fields, 78 records) #3 =<
(o File |3 Edit &) Generate m
— .

Tahle é!__.&.nnqtations_
resuft2 |peri0d |durati0n |treatment |age |$G-resu|t2 |$GP-resuﬂ2 $GP-0 |$GP-1

1 0 1 2 1 4 0 04875 04875 0125 s

2 1 P 1 4 o 0817 0817 0183

g 0 1 1 1 73 Db 0475 04875 0125

4 0 2 1 7m0 0817 0817 0183

5 0 1 1 1 s4 o 0475 04875 0125

B 0 2 1 54 o 0817 0817 0183

7 0 1 2 1 0] 0873 0873 0123

8 0 : 1 55 0 0817 0817 0183

g 0 1 1 o 0] 0.896 0.896 0104

10 0 2 o 56 0 0.847 0.847 0153

11 0 1 2 0 43 o 0.898 0.898 0104

12 0 : o 43 o 0.847 0.847 0153

13 0 1 1 1 S0 0873 0873 0123

14 0 2 1 Db 0817 0817 0183

15 0 1 1 0 FYIG) 0.898 0.898 0104

16 0 2 o G 0.847 0.847 0153

17 0 1 1 1 3 0 0873 0873 0123

18 0 2 1 3 0817 0817 0183

19 1 1 1 1 ETa0) 0873 0873 0123

20 0 1 1 1 3 o 0875 0.675 0125 =)
[ ot s s —— F

Figure 313. Predicted probabilities

Table 3. Estimated recurrence probabilities

Treatment 6 months 12 months
A 0.104 0.153
B 0.125 0.183

From the estimated recurrence probabilities, the survival probability through 12 months can be estimated
as 1-(P(recur, ) + P(recur, )?(1-P(recur, ))); thus, for each treatment:

A:1 - (0.104 + 0.153*0.896) = 0.759
B:1 - (0.125 + 0.183%*0.875) = 0.715

which again shows nonstatistically significant support for A as the better treatment.

Summary

Using Generalized Linear Models, you have fit a series of complementary log-log regression models for
interval-censored survival data. While there is some support for choosing treatment A, achieving a
statistically significant result may require a larger study. However, there are some further avenues to
explore with the existing data.

* It may be worthwhile to refit the model with interaction effects, particularly between Period and
Treatment group.

Explanations of the mathematical foundations of the modeling methods used in IBM SPSS Modeler are
listed in the IBM SPSS Modeler Algorithms Guide.
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Related Procedures

The Generalized Linear Models procedure is a powerful tool for fitting a variety of models.

* The Generalized Estimating Equations procedure extends the generalized linear model to allow
repeated measurements.

* The Linear Mixed Models procedure allows you to fit models for scale dependent variables with a
random component and/or repeated measurements.

Recommended Readings

See the following texts for more information on generalized linear models:

Cameron, A. C., and P. K. Trivedi. 1998. Regression Analysis of Count Data. Cambridge: Cambridge
University Press. Dobson, A. J. 2002. An Introduction to Generalized Linear Models, 2 ed. Boca Raton, FL:
Chapman & Hall/CRC. Hardin, J]. W., and ]. M. Hilbe. 2003. Generalized Linear Models and Extension.
Station, TX: Stata Press. McCullagh, P, and J. A. Nelder. 1989. Generalized Linear Models, 2nd ed. London:

Chapman & Hall.
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Chapter 23. Using Poisson Regression to Analyze Ship
Damage Rates (Generalized Linear Models)

A generalized linear model can be used to fit a Poisson regression for the analysis of count data. For
example, a dataset presented and analyzed elsewhere * concerns damage to cargo ships caused by waves.
The incident counts can be modeled as occurring at a Poisson rate given the values of the predictors, and
the resulting model can help you determine which ship types are most prone to damage.

This example uses the stream ships_genlin.str, which references the data file ships.sav. The data file is in
the Demos folder and the stream file is in the streams subfolder.

Modeling the raw cell counts can be misleading in this situation because the Aggregate months of service
varies by ship type. Variables like this that measure the amount of "exposure" to risk are handled within
the generalized linear model as offset variables. Moreover, a Poisson regression assumes that the log of
the dependent variable is linear in the predictors. Thus, to use generalized linear models to fit a Poisson
regression to the accident rates, you need to use Logarithm of aggregate months of service.

Fitting an "Overdispersed" Poisson Regression

1. Add a Statistics File source node pointing to ships.sav in the Demos folder.

ships.say

MHegative Binomial

Figure 314. Sample stream to analyze damage rates

2. On the Filter tab of the source node, exclude the field months_service. The log-transformed values of
this variable are contained in log_months_service, which will be used in the analysis.

2. McCullagh, P., and J. A. Nelder. 1989. Generalized Linear Models, 2nd ed. London: Chapman & Hall.
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() ships.sav

©) (=0

FCLED_DEMOS/ships . sav

Fields: 6in, 1 fitered, O renamed, 5 out

Field | Filter ' Field
type | e type
conatruction —_— conatruction
operation —_— operation
marths_service 3 maorths_service
log_months_service —_— log_months_service
damage_incidents —_— damage_incidents

@ view current fields  © View unused field zeftings

Lox )

Figure 315. Filtering an unneeded field

[eont

(Alternatively, you could change the role to None for this field on the Types tab rather than exclude
it, or select the fields you want to use in the modeling node.)

3. On the Types tab of the source node, set the role for the damage_incidents field to Target. All other
fields should have their role set to Input.

4. Click Read Values to instantiate the data.

Fiele | Measzurement | Walues Mlizsing Check | Role
{}type ‘?) Mominal 12345 Mone “w Input
{3 construction 7l Ordinal B0,65,70,75 Nane “ Input
{} operation {l Orddinal E0,7S Mone N Input
@ log_morths... f Continuous [3.506662... Mone & Mone
{} damage_inc... y Continuous [0,55] Mone @ Target

@ view currert fields  (©) view unuzed field settings

ok cancal

Figure 316. Setting field role

5. Attach a Genlin node to the source node; on the Genlin node, click the Model tab.
6. Select log_months_service as the offset variable.
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Model name: © auto @ custom Cverdispersed Poizzon

Uze partitioned data

Build madel for each splt

Mocel type: @ Main effects only © Main effects and all two-way interactions

Offzet:

@ variakle

Cffzet field:

@) Fixed value

&
salue: 0.0/

Base category for flag target:

Include intercept in model

Figure 317. Choosing model options

7. Click the Expert tab and select Expert to activate the expert modeling options.
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ﬁ Overdispersed Poisson

;%\

Figlds || Model  Expert | Analyze = Annotations

mode:  ©) Simple

Target Field Distribution and Link Function

The distribution that you choose determines which link functions are available.

Diztribution: iPDiSSUn vi Parameters

Link function; [Log

Method and terstion seftings are not available it Distribution = Marmal and Link
Function = ldentity.
Parameter Estimation

Soale parameter method: |Pearson Chi-zquate i I
Covariance matrix; @ Model-based estimator (&) Robust estimstar

Singularity tolerance: !1 E-012

Value order for categorical inputs: © Ascending @ Descending ©) Use data arder

(Lo J (B run ][ cancel

.ih 4-|>

i

e =]
tethad: |Hytarict ol I Mazximum Fizher scoring iterations:

.
-

oot

Figure 318. Choosing expert options

8. Select Poisson as the distribution for the response and Log as the link function.

9. Select Pearson Chi-Square as the method for estimating the scale parameter. The scale parameter is
usually assumed to be 1 in a Poisson regression, but McCullagh and Nelder use the Pearson
chi-square estimate to obtain more conservative variance estimates and significance levels.

10. Select Descending as the category order for factors. This indicates that the first category of each
factor will be its reference category; the effect of this selection on the model is in the interpretation of

parameter estimates.

11. Click Run to create the model nugget, which is added to the stream canvas, and also to the Models
palette in the upper right corner. To view the model details, right-click the nugget and choose Edit or

Browse, then click the Advanced tab.
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Goodness-of-Fit Statistics

Yalue df Walueldf
Deviance 383695 25 1.548
Scaled Deviance 22883 25
Pearson Chi-Square 42275 25 1.691
Scaled Pearson Chi-Soguare 25000 25
Log Likelihood @ -63.281
Akaike's Information
Critetion (&) 154562
Finite Sample Corrected AIC
(aIce) 162062
Bayesian Infarmation
Criterion (BIC) 168.299
Consistert 8IC (CAIC) 177299

Dependent “arisble: Mumber of damage incidents
Model (Intercept), type, construction, operation, offzet = log_months_

service
A. The full log likelihood function is displayed and used in
computing informsation criteria.

h. Information criteria are in small-is-hetter form.
Figure 319. Goodness-of-fit statistics

The goodness-of-fit statistics table provides measures that are useful for comparing competing models.
Additionally, the Value/df for the Deviance and Pearson Chi-Square statistics gives corresponding
estimates for the scale parameter. These values should be near 1.0 for a Poisson regression; the fact that
they are greater than 1.0 indicates that fitting the overdispersed model may be reasonable.

Omnibus Test

Likelihood Ratio
Chi-Sojuare df Sig.
107 633 g 000
Dependent Yariable: Mumber of damage incidents
Maodel: (Intercept), type, construction, operstion, offset = log_
months_service
a. Compares the fitted model against the intercept-only macel.

Figure 320. Omnibus test

The omnibus test is a likelihood-ratio chi-square test of the current model versus the null (in this case,
intercept) model. The significance value of less than 0.05 indicates that the current model outperforms the

null model.
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Tests of Model Effects

Type lll
sl
Source Chi-Square of Sig.
(Irtercept) 2138 657 1 oo
type 12.415 4 004
construction 17.242 3 0
operation £.249 1 1z

Dependent Wariable: Mumber of damage inciderts
Madel: (Intercept), type, construction, operation, offset =
log_months_service

Figure 321. Tests of model effects

Each term in the model is tested for whether it has any effect. Terms with significance values less than
0.05 have some discernible effect. Each of the main-effects terms contributes to the model.

Parameter Estimates

95% Wald
Confidence
Interyal Hypothesis Test
Std. Wizl

Parameter B Errar Lower Upper Chi-Sguare df Sig.
[Intercept) -6.406 2828 -6.960 -5.852 213235 1 000
[type=3] 326 3067 - 276 a7 1427 1 288
[type=4] -076 3774 -817 EES 040 1 A4
[type=3] - 687 A278 | 1526 RS 258 1 A08
[type=2] -.243 2309 -.996 -0 2536 1 ma
[type=1] 02 : g 5 : :
[con=truction=75] 453 3032 =141 1045 2236 1 135
[con=truction=710] 815 2205 386 1.251 13.743 1 000
[construction=63] £ar 1946 316 1.079 12835 1 jlui]
[construction=60] 0@ R . . . . .
[operation=75] 354 1535 a3 JLEE 6249 1 mz2
[oper ation=60] o2
(Scale) 1630

Dependent “ariable: Mumber of damage incidents
Model: (Intercept), type, construction, operation, offset = log_months_service

a. Set to zero because this parameter iz redundant.

b, Computed bazed on the Pearson chi-sguare.
Figure 322. Parameter estimates

The parameter estimates table summarizes the effect of each predictor. While interpretation of the
coefficients in this model is difficult because of the nature of the link function, the signs of the coefficients
for covariates and relative values of the coefficients for factor levels can give important insights into the
effects of the predictors in the model.

* For covariates, positive (negative) coefficients indicate positive (inverse) relationships between
predictors and outcome. An increasing value of a covariate with a positive coefficient corresponds to
an increasing rate of damage incidents.

* For factors, a factor level with a greater coefficient indicates greater incidence of damage. The sign of a
coefficient for a factor level is dependent upon that factor level's effect relative to the reference
category.

You can make the following interpretations based on the parameter estimates:

* Ship type B [type=2] has a statistically significantly (p value of 0.019) lower damage rate (estimated
coefficient of —0.543) than type A [type=1], the reference category. Type C [type=3] actually has an

266 1BM SPSS Modeler 17.1 Applications Guide



estimated parameter lower than B, but the variability in C's estimate clouds the effect. See the
estimated marginal means for all relations between factor levels.

* Ships constructed between 1965-69 [construction=65] and 1970-74 [construction=70] have statistically
significantly (p values <0.001) higher damage rates (estimated coefficients of 0.697 and 0.818,
respectively) than those built between 1960-64 [construction=60], the reference category. See the
estimated marginal means for all relations between factor levels.

* Ships in operation between 1975-79 [operation=75] have statistically significantly (p value of 0.012)
higher damage rates (estimated coefficient of 0.384) than those in operation between 1960-1974
[operation=60].

Fitting Alternative Models

One problem with the "overdispersed" Poisson regression is that there is no formal way to test it versus
the "standard" Poisson regression. However, one suggested formal test to determine whether there is
overdispersion is to perform a likelihood ratio test between a "standard" Poisson regression and a
negative binomial regression with all other settings equal. If there is no overdispersion in the Poisson
regression, then the statistic ~2?(log-likelihood for Poisson model — log-likelihood for negative binomial
model) should have a mixture distribution with half its probability mass at 0 and the rest in a chi-square
distribution with 1 degree of freedom.

1. Select Fixed value as the method for estimating the scale parameter. By default, this value is 1.

D Hegative Binomial

Figlds | hodel | Expert| snalyze | Annotations
Mode: © Simple @ Expert

Target Field Distribution snd Link Function

The distribution that yvou choose determines which link functions are available.

Diistrikbaution: ;Negatiue hinamial v' Parameters

Parameter for negstive binomial:

@) Specify value e a
© Estimate

Link function: |Leg | -

Method and iterstion settings are not available if Distribution = Mormal and Link
Function = Identity .
Parameter Estimation

[ 3 | [
Method: |Hyboricl el Maximum Fisher scoring iterations: E
Scale parameter method: | Fixed value el Walle: ﬂ
Covariance matrix @) Model-bazed estimator £ Robust estimatar
Singularity tolerance: !1 E-007 ™ |

Walue order for categorical inputs: @ aszcending @ Descending © Use data order

[ 904 ][b _Run][ Canc_:el] Apply

Figure 323. Expert tab
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2. To fit the negative binomial regression, copy and paste the Genlin node, attach it to the source node,
open the new node and click the Expert tab.

3. Select Negative binomial as the distribution. Leave the default value of 1 for the ancillary parameter.

4. Run the stream and browse the Advanced tab on the newly-created model nuggets.

Goodness-of-Fit Statistics

Walle off Walueidf
Deviance 35.695 23 1.548
Scaled Deviance 386935 25
Pearzon Chi-Souare 42275 25 1.691
Scaled Pearson Chi-Sguare 42275 25
Log Likelihood 3 -65.281
Akaike's Information
Criterion (A1) 1okaE2
Fintte Sample Correctedd AIC
LAICE) 162.062
Bayesian Information
Criterion (BIC) 168299
Consistent 8I1C (CAIC) 177.299

Dependent Wariable: Mumber of damage incidents
Model: (Intercept), type, construction, operation, offset = log_months_
service

&. The full log likelihood function is displayved and used in
computing information criteria.

b. Information criteria are in small-iz-better farm.

Figure 324. Goodness-of-fit statistics for standard Poisson regression

The log-likelihood reported for the standard Poisson regression is —68.281. Compare this to the negative
binomial model.

“alue df Walueidt
Deviance 11145 25 445
Scaled Deviance 11145 25
Pearson Chi-Scuare 88315 25 353
Scaled Pearson Chi-Square aa15 25
Log Likelitood 3 83725
Akaike's Information
Criterion (A0 185490
Finte Sample Corrected AIC
(81C0) 192950
Biayesian Information
Criterion (BIC) 199,187
Consistert 815 (CAIC) 208187

Dependent Wariable: Mumber of damage inciderts
Mocel: (Intercept), type, construction, operation, offzet = log_months_
service

A. The full log likelihood function is displayved and used in
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b. Infarmation criteria are in small-is-better form.

Figure 325. Goodness-of-fit statistics for negative binomial regression

The log-likelihood reported for the negative binomial regression is —83.725. This is actually smaller than
the log-likelihood for the Poisson regression, which indicates (without the need for a likelihood ratio test)
that this negative binomial regression does not offer an improvement over the Poisson regression.

However, the chosen value of 1 for the ancillary parameter of the negative binomial distribution may not
be optimal for this dataset. Another way you could test for overdispersion is to fit a negative binomial
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model with ancillary parameter equal to 0 and request the Lagrange multiplier test on the Output dialog
of the Expert tab. If the test is not significant, overdispersion should not be a problem for this dataset.

Summary

Using Generalized Linear Models, you have fit three different models for count data. The negative
binomial regression was shown not to offer any improvement over the Poisson regression. The
overdispersed Poisson regression seems to offer a reasonable alternative to the standard Poisson model,
but there is not a formal test for choosing between them.

Explanations of the mathematical foundations of the modeling methods used in IBM SPSS Modeler are
listed in the IBM SPSS Modeler Algorithms Guide.

Related Procedures

The Generalized Linear Models procedure is a powerful tool for fitting a variety of models.
* The Generalized Estimating Equations procedure extends the generalized linear model to allow
repeated measurements.

* The Linear Mixed Models procedure allows you to fit models for scale dependent variables with a
random component and/or repeated measurements.

Recommended Readings

See the following texts for more information on generalized linear models:

Cameron, A. C., and P. K. Trivedi. 1998. Regression Analysis of Count Data. Cambridge: Cambridge
University Press. Dobson, A. ]. 2002. An Introduction to Generalized Linear Models, 2 ed. Boca Raton, FL:
Chapman & Hall/CRC. Hardin, J. W., and ]. M. Hilbe. 2003. Generalized Linear Models and Extension.
Station, TX: Stata Press. McCullagh, P., and J. A. Nelder. 1989. Generalized Linear Models, 2nd ed. London:
Chapman & Hall.
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Chapter 24. Fitting a Gamma Regression to Car Insurance
Claims (Generalized Linear Models)

A generalized linear model can be used to fit a Gamma regression for the analysis of positive range data.
For example, a dataset presented and analyzed elsewhere  concerns damage claims for cars. The average
claim amount can be modeled as having a gamma distribution, using an inverse link function to relate
the mean of the dependent variable to a linear combination of the predictors. In order to account for the
varying number of claims used to compute the average claim amounts, you specify Number of claims as
the scaling weight.

This example uses the stream named car-insurance_genlin.str, which references the data file named
car_insurance_claims.sav. The data file is in the Demos folder and the stream file is in the streams subfolder.

Creating the Stream

1. Add a Statistics File source node pointing to car_insurance_claims.sav in the Demos folder.

&) —»

car_insurance xlaims.. tlaimamnt
E
:

claimamt Tahle

Figure 326. Sample stream to predict car insurance claims

2. On the Types tab of the source node, set the role for the claimamt field to Target. All other fields
should have their role set to Input.

3. Click Read Values to instantiate the data.

3. McCullagh, P.,, and J. A. Nelder. 1989. Generalized Linear Models, 2nd ed. London: Chapman & Hall.
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{4 car_insurance_claims.sav

| Field [ Messurement | _\fgly_qs__“__@!i_s__sing | check | Roe |
{3 holderage ol Orelireal 12345, Morie ™ Input

{} wehiclagroup &) Mominal | 1254 Mone _\ Input

{} wehicleage {l Orlinal | 1234 | Mone _\ Input

{} claimamt y Continuous 11,830 Mone @ Target

_{} nclaims f Continuous | [0434] Mone _@ Mone

@ view current fields  © View unused field zeftings

ok cancal [epot ] ooet

Figure 327. Setting field role

4. Attach a Genlin node to the source node; in the Genlin node, click the Fields tab.
5. Select nclaims as the scale weight field.
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Figure 328. Choosing field options

6. Click the Expert tab and select Expert to activate the expert modeling options.
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[_ (o134 ][.' Run][ Canc_:ell] Apply

Figure 329. Choosing expert options

7. Select Gamma as the response distribution.

8. Select Power as the link function and type -1.0 as the exponent of the power function. This is an
inverse link.

9. Select Pearson chi-square as the method for estimating the scale parameter. This is the method used
by McCullagh and Nelder, so we follow it here in order to replicate their results.

10. Select Descending as the category order for factors. This indicates that the first category of each
factor will be its reference category; the effect of this selection on the model is in the interpretation of
parameter estimates.

11. Click Run to create the model nugget, which is added to the stream canvas, and also to the Models
palette in the upper-right corner. To view the model details, right-click the model nugget and choose
Edit or Browse, then select the Advanced tab.
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Parameter Estimates
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Figure 330. Parameter estimates

The omnibus test and tests of model effects (not shown) indicate that the model outperforms the null
model and that each of the main effects terms contribute to the model. The parameter estimates table
shows the same values obtained by McCullagh and Nelder for the factor levels and the scale parameter.

Summary

Using Generalized Linear Models, you have fit a gamma regression to the claims data. Note that while
the canonical link function for the gamma distribution was used in this model, a log link will also give
reasonable results. In general, it is difficult to impossible to directly compare models with different link
functions; however, the log link is a special case of the power link where the exponent is 0, thus you can
compare the deviances of a model with a log link and a model with a power link to determine which
gives the better fit (see, for example, section 11.3 of McCullagh and Nelder).

Explanations of the mathematical foundations of the modeling methods used in IBM SPSS Modeler are
listed in the IBM SPSS Modeler Algorithms Guide.

Related Procedures

The Generalized Linear Models procedure is a powerful tool for fitting a variety of models.

* The Generalized Estimating Equations procedure extends the generalized linear model to allow
repeated measurements.

* The Linear Mixed Models procedure allows you to fit models for scale dependent variables with a
random component and/or repeated measurements.

Recommended Readings

See the following texts for more information on generalized linear models:
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Cameron, A. C., and P. K. Trivedi. 1998. Regression Analysis of Count Data. Cambridge: Cambridge
University Press. Dobson, A. J. 2002. An Introduction to Generalized Linear Models, 2 ed. Boca Raton, FL:
Chapman & Hall/CRC. Hardin, J]. W., and ]. M. Hilbe. 2003. Generalized Linear Models and Extension.
Station, TX: Stata Press. McCullagh, P, and J. A. Nelder. 1989. Generalized Linear Models, 2nd ed. London:
Chapman & Hall.
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Chapter 25. Classifying Cell Samples (SVM)

Support Vector Machine (SVM) is a classification and regression technique that is particularly suitable for
wide datasets. A wide dataset is one with a large number of predictors, such as might be encountered in
the field of bioinformatics (the application of information technology to biochemical and biological data).

A medical researcher has obtained a dataset containing characteristics of a number of human cell samples
extracted from patients who were believed to be at risk of developing cancer. Analysis of the original
data showed that many of the characteristics differed significantly between benign and malignant
samples. The researcher wants to develop an SVM model that can use the values of these cell
characteristics in samples from other patients to give an early indication of whether their samples might
be benign or malignant.

This example uses the stream named svm_cancer.str, available in the Demos folder under the streams
subfolder. The data file is cell_samples.data. See the topic [“Demos Folder” on page 4| for more information.

The example is based on a dataset that is publicly available from the UCI Machine Learning Repository .
The dataset consists of several hundred human cell sample records, each of which contains the values of
a set of cell characteristics. The fields in each record are:

Field name Description

ID Patient identifier

Clump Clump thickness
UnifSize Uniformity of cell size
UnifShape Uniformity of cell shape
MargAdh Marginal adhesion
SingEpiSize Single epithelial cell size
BareNuc Bare nuclei

BlandChrom Bland chromatin
NormNucl Normal nucleoli

Mit Mitoses

Class Benign or malignant

For the purposes of this example, we're using a dataset that has a relatively small number of predictors in

each record.
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Creating the Stream

-
& -
3%
3

/class-rbf

- \ ’ i
— (8 2 (i
cell_samples.data Type "' class-paly
¥ ,
— clasz-rbf clasg-paly Analysis
T ; 1
Table _— —
BEEE EEE
Tahle Tahle

Figure 331. Sample stream to show SVM modeling

1. Create a new stream and add a Var File source node pointing to cell_samples.data in the Demos folder
of your IBM SPSS Modeler installation.

Let's take a look at the data in the source file.
2. Add a Table node to the stream.
3. Attach the Table node to the Var File node and run the stream.

278 IBM SPSS Modeler 17.1 Applications Guide



Table (11 fields, 699 records)

lad File | Edit &) Generate

Tahle
ifSize | UnitShape |Margsdh | SingEpiSize |Baretuc | BlandChrom | ormiual bt | class |
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20 1 1 2 1 3 1 12 =

[l —————————————————— |

Figure 332. Source data for SVM

The ID field contains the patient identifiers. The characteristics of the cell samples from each patient
are contained in fields Clump to Mit. The values are graded from 1 to 10, with 1 being the closest to

benign.

The Class field contains the diagnosis, as confirmed by separate medical procedures, as to whether

the samples are benign (value = 2) or malignant (value = 4).
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Figure 333. Type node settings

4. Add a Type node and attach it to the Var File node.
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5. Open the Type node.
We want the model to predict the value of Class (that is, benign (=2) or malignant (=4)). As this field
can have one of only two possible values, we need to change its measurement level to reflect this.
6. In the Measurement column for the Class field (the last one in the list), click the value Continuous
and change it to Flag.
7. Click Read Values.
8. In the Role column, set the role for ID (the patient identifier) to None, as this will not be used either
as a predictor or a target for the model.
9. Set the role for the target, Class, to Target and leave the role of all the other fields (the predictors) as
Input.
10. Click OK.
The SVM node offers a choice of kernel functions for performing its processing. As there's no easy
way of knowing which function performs best with any given dataset, we'll choose different
functions in turn and compare the results. Let's start with the default, RBF (Radial Basis Function).
D class-rbf

P
ot
e
R

Figids || Model | Expert | Analyze | Arnnotations
Model name: @ o @ Custom |c|ass-rbf
|_:_{1| Uze partitioned data

@ Builed model for each split

rTo select figlds manually, choose "Use custom settings" on the Fields takb

X |in

[ a8 ][b Run][ Cancel] ﬁpply

Figure 334. Model tab settings

11. From the Modeling palette, attach an SVM node to the Type node.

12.

280

Open the SVM node. On the Model tab, click the Custom option for Model name and type class-rbf
in the adjacent text field.
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Figure 335. Default Expert tab settings

13. On the Expert tab, set the Mode to Expert for readability but leave all the default options as they
are. Note that Kernel type is set to RBF by default. All the options are greyed out in Simple mode.

[ Class i)
| D]

~hdadel Evaluation

@ éCaIcuIate variable impartance

~Propensity Scores (valid anly for flag targets)
D Calculate raw propensity scares
Calculate adjusted propensity scores

Based on @ Testing partition @ ‘validation partition

Figure 336. Analyze tab settings

14. On the Analyze tab, select the Calculate variable importance check box.

15. Click Run. The model nugget is placed in the stream, and in the Models palette at the top right of
the screen.

16. Double-click the model nugget in the stream.
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Examining the Data
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Figure 337. Predictor Importance graph

On the Model tab, the Predictor Importance graph shows the relative effect of the various fields on the
prediction. This shows us that BareNuc has easily the greatest effect, while UnifShape and Clump are also
quite significant.

1. Click OK.
2. Attach a Table node to the class-rbf model nugget.
3. Open the Table node and click Run.
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Figure 338. Fields added for prediction and confidence value

4. The model has created two extra fields. Scroll the table output to the right to see them:

New field name

Description

$S-Class

Value for Class predicted by the model.

$SP-Class

Propensity score for this prediction (the likelihood of this prediction being true, a
value from 0.0 to 1.0).

Just by looking at the table, we can see that the propensity scores (in the $SP-Class column) for most of

the records are reasonably high.

However, there are some significant exceptions; for example, the record for patient 1041801 at line 13,
where the value of 0.514 is unacceptably low. Also, comparing Class with $S-Class, it's clear that this

model has made a number of incorrect predictions, even where the propensity score was relatively high

(for example, lines 2 and 4).

Let's see if we can do better by choosing a different function type.
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Trying a Different Function
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Figure 339. Setting a new name for the model
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1. Close the Table output window.

2. Attach a second SVM modeling node to the Type node.

3. Open the new SVM node.

4. On the Model tab, choose Custom and type class-poly as the model name.

£ class-poly
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Figure 340. Expert tab settings for Polynomial

oot || peee

5. On the Expert tab, set Mode to Expert.
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Set Kernel type to Polynomial and click Run. The class-poly model nugget is added to the stream,
and also to the Models palette at the top right of the screen.

Connect the class-rbf model nugget to the class-poly model nugget (choose Replace at the warning

dialog).

Attach a Table node to the class-poly nugget.
Open the Table node and click Run.

Comparing the Results
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Figure 341. Fields added for Polynomial function

1.

Scroll the table output to the right to see the newly added fields.
The generated fields for the Polynomial function type are named $51-Class and $SP1-Class.

The results for Polynomial look much better. Many of the propensity scores are 0.995 or better, which

is very encouraging.

2. To confirm the improvement in the model, attach an Analysis node to the class-poly model nugget.

Open the Analysis node and click Run.
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Figure 342. Analysis node

This technique with the Analysis node enables you to compare two or more model nuggets of the same
type. The output from the Analysis node shows that the RBF function correctly predicts 97.85% of the
cases, which is still quite good. However, the output shows that the Polynomial function has correctly
predicted the diagnosis in every single case. In practice you are unlikely to see 100% accuracy, but you
can use the Analysis node to help determine whether the model is acceptably accurate for your particular
application.

In fact, neither of the other function types (Sigmoid and Linear) performs as well as Polynomial on this
particular dataset. However, with a different dataset, the results could easily be different, so it's always
worth trying the full range of options.

Summary

You have used different types of SVM kernel functions to predict a classification from a number of
attributes. You have seen how different kernels give different results for the same dataset and how you
can measure the improvement of one model over another.
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Chapter 26. Using Cox Regression to Model Customer Time to

Churn
As part of its efforts to reduce customer churn, a telecommunications company is interested in modeling
the "time to churn” in order to determine the factors that are associated with customers who are quick to
switch to another service. To this end, a random sample of customers is selected and their time spent as
customers, whether they are still active customers, and various other fields are pulled from the database.

This example uses the stream telco_coxreg.str, which references the data file telco.sav. The data file is in the
Demos folder and the stream file is in the streams subfolder. See the topic [“Demos Folder” on page 4 for

more information.

Building a Suitable Model

Add a Statistics File source node pointing to telco.sav in the Demos folder.

1.
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Figure 343. Sample stream to analyze time to churn

2. On the Filter tab of the source node, exclude the fields region, income, longten through wireten, and

loglong through logwire.
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Figure 344. Filtering unneeded fields

(Alternatively, you could change the role to None for these fields on the Types tab rather than
exclude it, or select the fields you want to use in the modeling node.)

3. On the Types tab of the source node, set the role for the churn field to Target and set its
measurement level to Flag. All other fields should have their role set to Input.

4. Click Read Values to instantiate the data.
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Figure 345. Setting field role

5. Attach a Cox node to the source node; in the Fields tab, select tenure as the survival time variable.
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Figure 346. Choosing field options

6. Click the Model tab.

7. Select Stepwise as the variable selection method.
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Usze partitioned data

Builed model for each split

Methocl Stepwise |

haoclel type: @ Main eftects © Custom

fdadel terms:

Figure 347. Choosing model options

8. Click the Expert tab and select Expert to activate the expert modeling options.
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9. Click Output.

Ed Cox Regression: Advanced Qutput
Statistics
Dizplay: @ At each step © At last step

|t| Cl for expiBEl |:| Correlation of estimates

|_j Display baseline function
Flots

[ Survival [ Hazard ] Log minus log - [C] One minus survival

Plot & separate line for each walue:

Yalue to use for plots:

L Field | Walue © |
f tenure hlean B
f age hdean

&5 marital Mean

f address hiean

d:l ed Mlean

f employ Mean

&5 refire flean

@0 gender tean Ed

(o) (canca) (en)

Figure 348. Choosing advanced output options

10. Select Survival and Hazard as plots to produce, then click OK.

11. Click Run to create the model nugget, which is added to the stream, and to the Models palette in the
upper right corner. To view its details, double-click the nugget on the stream. First, look at the
Advanced output tab.

Censored Cases

il Percent

Cases available in Eventd 274 2749
analysis Censared 726 72.6%

Total 1000 100.0%
Cases dropped Cases with missing 0 0%

values :

Cases with negative

time u 0%

Censored cases before

the earliest eventin a i] 0%

stratum

Total i] 0%
Total 1000 100.0%

a. Dependent Yariahle: Months with service

Figure 349. Case processing summary

The status variable identifies whether the event has occurred for a given case. If the event has not
occurred, the case is said to be censored. Censored cases are not used in the computation of the
regression coefficients but are used to compute the baseline hazard. The case processing summary shows
that 726 cases are censored. These are customers who have not churned.
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Categorical Variable Codings

Freguency (110 )] )] (4
rnarital? D=Unrnarried 505 1
1=hlarried 495 ]
ed? ‘Iszr?clltélnutcnmplete high 204 1 0 0 a
2=High school degree 87 i] 1 0 0
3=8ome college 209 i] 0 1 0
4=College degree 234 i] 0 0 1
gzgroeset—undergraduate BE 0 0 0 0
retire? 00=Mo 953 1
1.00=Yes 47 ]
tenideard O=male 483 1
1=Female 517 ]
tollfree® D=Mo 526 1
1=Yes 474 ]
equip? 0=Mo F14 1
1=Yes 380 ]
callcard® | O=Mo 322 1
1=Yes G748 ]
wirelessd | O=Mo 704 1
1="es 296 ]
rultling? | 0=Mo 525 1
1=Yes 475 ]
voiced O=ro {apel ] 1
1="es 304 a
pager? 0=ro 739 1
1="es 261 a
internet? 0=Mo £32 1
1="es 368 0
callid? 0=man 519 1
1="es 481 ]
calhwait? 0=Mo 515 1
1="es 485 ]
farward? O=ka 507 1
1="es 443 i
confard O=ro 498 1
1=Yes 502 ]
ehill? 0=MNn 629 1
1="es 371 ]
custcatd 1=Basic senice 266 1 1] a
?=E-senice T i] 1 1]
3=Flus senice 281 i 0 1
4=Tuotal serice 230 ] 0 1]

Figure 350. Categorical variable codings

The categorical variable codings are a useful reference for interpreting the regression coefficients for

categorical covariates, particularly dichotomous variables. By default, the reference category is the "last"

category. Thus, for example, even though Married customers have variable values of 1 in the data file,
they are coded as 0 for the purposes of the regression.
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Variable Selection

Ovwerall (score) Change From Previous Step Change From Previous Block

-2 Log

Likelihoo Zhi- Chi- Zhi-
Step d Souare df Sid. Souare df Sl Souare df Sl
12 3392536 | 162.303 1 o0 | 133.828 1 000 | 133.828 1 000
a2 3087314 | 249392 2 oo | 305232 1 000 | 439.050 i .00o
38 3027.085 | 328428 3 non f0.2249 1 000 | 4992749 3 .0oo
44 2890780 | 3471497 4 .non 36.284 1 000 | 535574 4 000
5% 2873790 | 362673 g .0ag 17.000 1 000 | 852874 ] .0oo
i 2058 7OE | ATE140 F .0on 14.984 1 000 | 567.568 3 000
79 2845503 | 3B4.7IT T .0on 13.283 1 000 | 530.861 T 000
g 2836993 | #17.34 g .0ag g.510 1 004 | 589.371 g .0oo
gl 2826000 | 423911 4 .0on 10.954 1 001 F00.364 4 000
10 2817.551 428.078 10 .0an g.448 1 004 | 608813 10 .0oo
11k 2813.308 | 436.537 11 .0ag 4.243 1 039 | B13.056 11 .0oo
12! 2808.078 | 440158 12 .0an 5.230 1 022 | B18.288 12 000

a. Yariahle(s) Entered at Step Mumber 1: calleard

h. Yariahle(s) Entered at Step Number 2: longman

c. Wariahle(s) Entered at Step Mumher 3: equip

d. Yariahle(s) Entered at Step Mumber 4. employ

e Wariahle(s) Entered at Step Mumber 5 multline

f. Wariableds) Entered at Step Number 6 vaice

. Wariahle(s) Entered at Step Mumber 7 address

h. Wariahle(s) Entered at Step Mumber 8 equipman

i. Wariable(s) Entered at Step Mumber 9: ehill

i. Wariableis) Entered at Step Mumber 10: callid

k. Wariahle(s) Entered at Step Mumber 11: internet

|. ¥ariableis) Entered at Step Number 12: reside

m. Beginning Block Mumber 0, initial Log Likelihood function: -2 Log likelihood: 3526 364
n. Beginning Block Mumhber 1. Method = Forward Stepwise (Likelihood Ratia)

Figure 351. Omnibus tests

The model-building process employs a forward stepwise algorithm. The omnibus tests are measures of
how well the model performs. The chi-square change from previous step is the difference between the -2
log-likelihood of the model at the previous step and the current step. If the step was to add a variable,
the inclusion makes sense if the significance of the change is less than 0.05. If the step was to remove a
variable, the exclusion makes sense if the significance of the change is greater than 0.10. In twelve steps,
twelve variables are added to the model.

B SE Wald df Sy, Exp(B)

Step 12 | address -.035 .009 14.543 1 .0ao 66
ermplay -.051 010 25767 1 000 950
reside =103 046 5.037 1 025 402
equip -1.948 3 26.180 1 .0ao 143
callcard T 51 26.451 1 000 2175
longmon -.233 022 [ 115619 1 000 782
equiprnon -.042 011 158.377 1 .0ao 959
multline B12 145 17.854 1 000 1.844
voice =801 1487 10197 1 001 B06
internet -.362 160 5.114 1 024 697
callid - 464 148 9.740 1 002 628
ehill -.389 156 B.557 1 010 AT

Figure 352. Variables in the equation (step 12 only)

The final model includes address, employ, reside, equip, callcard, longmon, equipmon, multline, voice, internet,
callid, and ebill. To understand the effects of individual predictors, look at Exp(B), which can be
interpreted as the predicted change in the hazard for a unit increase in the predictor.

* The value of Exp(B) for address means that the churn hazard is reduced by 100%—(100%70.966)=3.4%
for each year a customer has lived at the same address. The churn hazard for a customer who has
lived at the same address for five years is reduced by 100%—(100%70.966°)=15.88%.
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* The value of Exp(B) for callcard means that the churn hazard for a customer who does not subscribe to
the calling card service is 2.175 times that of a customer with the service. Recall from the categorical
variable codings that No = 1 for the regression.

* The value of Exp(B) for internet means that the churn hazard for a customer who does not subscribe to

the internet service is 0.697 times that of a customer with the service. This is somewhat worrisome
because it suggests that customers with the service are leaving the company faster than customers

without the service.

Scare df Sid.
Step 12 | age 122 1 726
marital h48 1 A4
income 1.476 1 224
ed f.328 4 AVE
edi1) 007 1 934
ed(Z) 203 1 a2
ed(3) B35 1 361
ed(4) 8773 1 016
retire 013 1 908
gender 214 1 644
tallfree 3.243 1 072
wireless Nl 1 414
tallmoaon .0an 1 887
cardman 3163 1 075
Wirermon 1.084 1 245
pager 1.808 1 174
calkwait 2BR 1 BB
farward 2.2 1 138
confer 2.568 1 104
custeat BG4 3 B34
custeat(1) AR 1 485
custoat(?) 4a0 1 A02
custcat() .019 1 ReLEd]

Figure 353. Variables not in the model (step 12 only)

Variables left out of the model all have score statistics with significance values greater than 0.05.
However, the significance values for tollfree and cardmon, while not less than 0.05, are fairly close. They
may be interesting to pursue in further studies.
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Covariate Means

Mean
age 41,684
marital 505
address 11.651
incame 77.535
ed(1) .204
ed(Z) .287
ed(3) .209
edid) 234
employ 10.987
retire 53
dender 4483
reside 2.3
tollfree 576
eguip B4
callcard 327
wireless 704
langman 11723
tollmon 13.274
Equiprman 14.220
cardman 13781
wireman 11.584
multline 525
vaice BAR
pader 738
internet Faz
callid 519
callwait 515
forward 507
confer 498
ehill 29
custcat{1) 66
custcat(Z) M7
custoat{) 281

Figure 354. Covariate means

This table displays the average value of each predictor variable. This table is a useful reference when
looking at the survival plots, which are constructed for the mean values. Note, however, that the
"average" customer doesn't actually exist when you look at the means of indicator variables for
categorical predictors. Even with all scale predictors, you are unlikely to find a customer whose covariate
values are all close to the mean. If you want to see the survival curve for a particular case, you can
change the covariate values at which the survival curve is plotted in the Plots dialog box. If you want to
see the survival curve for a particular case, you can change the covariate values at which the survival
curve is plotted in the Plots group of the Advanced Output dialog.

294  1BM SPSS Modeler 17.1 Applications Guide



Survival Curve

0.8

[=]
i
1

Cum Survival
o
i
1

0.0

T T T
40 60

(=
(5]
=1

Months with service

Figure 355. Survival curve for "average" customer

The basic survival curve is a visual display of the model-predicted time to churn for the "average"
customer. The horizontal axis shows the time to event. The vertical axis shows the probability of survival.
Thus, any point on the survival curve shows the probability that the "average" customer will remain a
customer past that time. Past 55 months, the survival curve becomes less smooth. There are fewer

customers who have been with the company for that long, so there is less information available, and thus
the curve is blocky.
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Figure 356. Hazard curve for "average" customer
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The basic hazard curve is a visual display of the cumulative model-predicted potential to churn for the
"average" customer. The horizontal axis shows the time to event. The vertical axis shows the cumulative
hazard, equal to the negative log of the survival probability. Past 55 months, the hazard curve, like the
survival curve, becomes less smooth, for the same reason.

Evaluation
The stepwise selection methods guarantee that your model will have only "statistically significant"
predictors, but it does not guarantee that the model is actually good at predicting the target. To do this,

you need to analyze scored records.

u Evaluation

3= (]

L; File ) Generate

COX

Setings | Advanced | Summary | Annotations

Predict survival at future times specified as:

1p

%) Regular intervals

4 p

@ Time field |§ tenure

& s

Past survival time: |

(¥ append all probakilties

[I Calculate cumulstive hazard function

Al

Figure 357. Cox nugget: Settings tab

1. Place the model nugget on the canvas and attach it to the source node, open the nugget and click the
Settings tab.

2. Select Time field and specify tenure. Each record will be scored at its length of tenure.

3. Select Append all probabilities.
This creates scores using 0.5 as the cutoff for whether a customer churns; if their propensity to churn

is greater than 0.5, they are scored as a churner. There is nothing magical about this number, and a
different cutoff may yield more desirable results. For one way to think about choosing a cutoff, use

an Evaluation node.
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Figure 358. Evaluation node: Plot tab

4. Attach an Evaluation node to the model nugget; on the Plot tab, select Include best line.
5. Click the Options tab.
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Figure 359. Evaluation node: Options tab

6. Select User defined score and type '$CP-1-1' as the expression. This is a model-generated field that
corresponds to the propensity to churn.

7. Click Run.

100 E ’
: ¢ | $BEST-churn
L | %C-churn

80 -+

60

% Gain

I

0 20 40 1Y) 80 100
Percentile
churn =1

Figure 360. Gains chart
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The cumulative gains chart shows the percentage of the overall number of cases in a given category
"gained" by targeting a percentage of the total number of cases. For example, one point on the curve
is at (10%, 15%), meaning that if you score a dataset with the model and sort all of the cases by
predicted propensity to churn, you would expect the top 10% to contain approximately 15% of all of
the cases that actually take the category 1 (churners). Likewise, the top 60% contains approximately
79.2% of the churners. If you select 100% of the scored dataset, you obtain all of the churners in the
dataset.

The diagonal line is the "baseline" curve; if you select 20% of the records from the scored dataset at
random, you would expect to "gain" approximately 20% of all of the records that actually take the
category 1. The farther above the baseline a curve lies, the greater the gain. The "best" line shows the
curve for a "perfect” model that assigns a higher churn propensity score to every churner than every
non-churner. You can use the cumulative gains chart to help choose a classification cutoff by
choosing a percentage that corresponds to a desirable gain, and then mapping that percentage to the
appropriate cutoff value.

What constitutes a "desirable" gain depends on the cost of Type I and Type II errors. That is, what is
the cost of classifying a churner as a non-churner (Type I)? What is the cost of classifying a
non-churner as a churner (Type II)? If customer retention is the primary concern, then you want to
lower your Type I error; on the cumulative gains chart, this might correspond to increased customer
care for customers in the top 60% of predicted propensity of 1, which captures 79.2% of the possible
churners but costs time and resources that could be spent acquiring new customers. If lowering the
cost of maintaining your current customer base is the priority, then you want to lower your Type II
error. On the chart, this might correspond to increased customer care for the top 20%, which
captures 32.5% of the churners. Usually, both are important concerns, so you have to choose a
decision rule for classifying customers that gives the best mix of sensitivity and specificity.

4>

Seftings || Optimization | Annotations

E Sort

Sort by

Fisld Order | s

FCP-1-1 ¥ Descending
X
,}“.-.
+

Default sort order: () Azcending ®@ Descending

-

Figure 361. Sort node: Settings tab

8. Say that you have decided that 45.6% is a desirable gain, which corresponds to taking the top 30% of
records. To find an appropriate classification cutoff, attach a Sort node to the model nugget.

9. On the Settings tab, choose to sort by $CP-1-1 in descending order and click OK.
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Figure 362. Table

10. Attach a Table node to the Sort node.
11. Open the Table node and click Run.

Scrolling down the output, you see that the value of $CP-1-1 is 0.248 for the 300th record. Using 0.248 as
a classification cutoff should result in approximately 30% of the customers scored as churners, capturing
approximately 45% of the actual total churners.

Tracking the Expected Number of Customers Retained

Once satisfied with a model, you want to track the expected number of customers in the dataset that are
retained over the next two years. The null values, which are customers whose total tenure (future time +
tenure) falls beyond the range of survival times in the data used to train the model, present an interesting
challenge. One way to deal with them is to create two sets of predictions, one in which null values are
assumed to have churned, and another in which they are assumed to have been retained. In this way you
can establish upper and lower bounds on the expected number of customers retained.
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Figure 363. Cox nugget: Settings tab

1. Double-click the model nugget in the Models palette (or copy and paste the nugget on the stream
canvas) and attach the new nugget to the Source node.

2. Open the nugget to the Settings tab.

3. Make sure Regular Intervals is selected, and specify 1.0 as the time interval and 24 as the number
of periods to score. This specifies that each record will be scored for each of the following 24

months.

4. Select tenure as the field to specify the past survival time. The scoring algorithm will take into
account the length of each customer's time as a customer of the company.

5. Select Append all probabilities.
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Figure 364. Aggregate node: Settings tab

6. Attach an Aggregate node to the model nugget; on the Settings tab, deselect Mean as a default
mode.

7. Select $CP-0-1 through $CP-0-24, the fields of form $CP-0-n, as the fields to aggregate. This is easiest
if, on the Select Fields dialog, you sort the fields by Name (that is, alphabetical order).

8. Deselect Include record count in field.
9. Click OK. This node creates the "lower bound" predictions.
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Figure 365. Filler node: Settings tab

10. Attach a Filler node to the Coxreg nugget to which we just attached the Aggregate node; on the

Settings tab, select $CP-0-1 through $CP-0-24, the fields of form $CP-0-n, as the fields to fill in. This

is easiest if, on the Select Fields dialog, you sort the fields by Name (that is, alphabetical order).

11. Choose to replace Null values with the value 1.

12. Click OK.
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Figure 366. Aggregate node: Settings tab

13. Attach an Aggregate node to the Filler node; on the Settings tab, deselect Mean as a default mode.

14. Select $CP-0-1 through $CP-0-24, the fields of form $CP-0-n, as the fields to aggregate. This is easiest
if, on the Select Fields dialog, you sort the fields by Name (that is, alphabetical order).

15. Deselect Include record count in field.
16. Click OK. This node creates the "upper bound" predictions.
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Figure 367. Filter node: Settings tab

17. Attach an Append node to the two Aggregate nodes, then attach a Filter node to the Append node.

18. On the Settings tab of the Filter node, rename the fields to 1 through 24. Through the use of a
Transpose node, these field names will become values for the x-axis in charts downstream.
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Figure 368. Transpose node: Settings tab
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19. Attach a Transpose node to the Filter node.
20. Type 2 as the number of new fields.

o o

Fields: 3in, Ofiltered, 3 renamed, 3 out

T
E

Field — [ Fitter [ Field
b _ . T i—
Fieldt L —>  LowerEstimats
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@ Viewr currert fields  © Wiew unused field settings

Lon o

Figure 369. Filter node: Filter tab

21. Attach a Filter node to the Transpose node.

22. On the Settings tab of the Filter node, rename ID to Months, Field1 to Lower Estimate, and Field2 to
Upper Estimate.

W field:

f Upper Estitate

v fislds: fLower Estimate

Cverlay

Mortalize

Ovetlay function v =

When number of records greater than: 2000 g

@ Ein © Sample @ Use all data

Figure 370. Multiplot node: Plot tab
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23. Attach a Multiplot node to the Filter node.

24. On the Plot tab, Months as the X field, Lower Estimate and Upper Estimate as the Y fields.
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Figure 371. Multiplot node: Appearance tab

25. Click the Appearance tab.

26. Type Number of Customers as the title.

27. Type Estimates the number of customers retained as the caption.
28. Click Run.
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Figure 372. Multiplot estimating the number of customers retained
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The upper and lower bounds on the estimated number of customers retained are plotted. The
difference between the two lines is the number of customers scored as null, and therefore whose
status is highly uncertain. Over time, the number of these customers increases. After 12 months, you
can expect to retain between 601 and 735 of the original customers in the dataset; after 24 months,
between 288 and 597.
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Figure 373. Derive node: Settings tab

29. To get another look at how uncertain the estimates of the number of customers retained are, attach a
Derive node to the Filter node.

30. On the Settings tab of the Derive node, type Unknown % as the derive field.
31. Select Continuous as the field type.

32. Type (100 * ('Upper Estimate' - 'Lower Estimate')) / 'Lower Estimate' as the formula.
Unknown % is the number of customers "in doubt" as a percentage of the lower estimate.

33. Click OK.
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Figure 374. Plot node: Plot tab

34. Attach a Plot node to the Derive node.

35. On the Plot tab of the Plot node, select Months as the X field and Unknown % as the Y field.

36. Click the Appearance tab.
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Figure 375. Plot node: Appearance tab

37. Type Unpredictable Customers as % of Predictable Customers as the title.
38. Execute the node.

Unpredictable Customers as % of Predictable Customers
120 e e e R e B e

1007~

oo
T

Unknown %
o
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|
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e
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Figure 376. Plot of unpredictable customers

Through the first year, the percentage of unpredictable customers increases at a fairly linear rate, but the

rate of increase explodes during the second year until, by month 23, the number of customers with null
values outnumber the expected number of customers retained.
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Scoring

Once satisfied with a model, you want to score customers to identify the individuals most likely to churn
within the next year, by quarter.

Ed Scoring

>

Cox

L;l- Filg @ Generate

Seftings | Advenced | Summary | Annotations

Predict survival at future times specified as:

]
@ Regular intervals Time interval: n
; ] ]
Mumber of time periods to score: =]
Tithe field | 8

Past survival time: W.tenu_re ['EJ

i_a Append all probabilties

|:I Calculste cumulative hazard function

Apply

Figure 377. Coxreg nugget: Settings tab

1. Attach a third model nugget to the Source node and open the model nugget.

2. Make sure Regular Intervals is selected, and specify 3.0 as the time interval and 4 as the number of
periods to score. This specifies that each record will be scored for the following four quarters.

3. Select tenure as the field to specify the past survival time. The scoring algorithm will take into
account the length of each customer's time as a customer of the company.

4. Select Append all probabilities. These extra fields will make it easier to sort the records for viewing
in a table.
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Figure 378. Select node: Settings tab

5. Attach a Select node to the model nugget; on the Settings tab, type churn=0 as the condition. This
removes customers who have already churned from the results table.
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Figure 379. Derive node: Settings tab

6. Attach a Derive node to the Select node; on the Settings tab, select Multiple as the mode.
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7. Choose to derive from $CP-1-1 through $CP-1-4, the fields of form $CP-1-n, and type _churn as the
suffix to add. This is easiest if, on the Select Fields dialog, you sort the fields by Name (that is,
alphabetical order).

8. Choose to derive the field as a Conditional.

9. Select Flag as the measurement level.

10. Type GFIELD>0.248 as the If condition. Recall that this was the classification cutoff identified during
Evaluation.

11. Type 1 as the Then expression.

12. Type 0 as the Else expression.

13. Click OK.
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Field Order |
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FCP-1-1 ¥ Deszcending
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FCP1-3 ¥ Deszcending =]

Default sort order: @ Azcending @ Descending
o

Figure 380. Sort node: Settings tab

14. Attach a Sort node to the Derive node; on the Settings tab, choose to sort by $CP-1-1_churn through
$CP-1-4-churn and then $CP-1-1 through $CP-1-4, all in descending order. Customers who are
predicted to churn will appear at the top.
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Figure 381. Field Reorder node: Reorder tab

=

15. Attach a Field Reorder node to the Sort node; on the Reorder tab, choose to place $CP-1-1_churn
through $CP-1-4 in front of the other fields. This simply makes the results table easier to read, and
so is optional. You will need to use the buttons to move the fields into the position shown in the

figure.
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Figure 382. Table showing customer scores
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16. Attach a Table node to the Field Reorder node and execute it.

264 customers are expected to churn by the end of the year, 184 by the end of the third quarter, 103 by
the second, and 31 in the first. Note that given two customers, the one with a higher propensity to churn
in the first quarter does not necessarily have a higher propensity to churn in later quarters; for example,
see records 256 and 260. This is likely due to the shape of the hazard function for the months following
the customer's current tenure; for example, customers who joined because of a promotion might be more
likely to switch early on than customers who joined because of a personal recommendation, but if they
do not then they may actually be more loyal for their remaining tenure. You may want to re-sort the
customers to obtain different views of the customers most likely to churn.

[ Table (50 fields, 726 records) =JoEd
juh Fie | ZEdt ) cenerste  [1gE) @m i m
| Table || Annctations
$CP-1-1_churn [$CP-1-1 [$CP-1-2_churn [$CP1-2  [$CP-1-3_churn |$CP1-3 | $CPA-4_churn [$CP-1-4  [tenur
o7 0 Frly a Frug a Fnully [t} Fnully 7
705 ] Frullf 1} FrulF 0 Frully a Frullf 71
709 ] Frullg ] Frulg ] Frlls 0 Frllh 71
0 ] Frullf 1} FrulF 0 Frully a Frullf 72
ikl ] Frullg ] Frulg ] Frlls 0 Frllh 71
T2 ] Frullf 1} FrulF 0 Frully a Frullf 72
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T4 ] Frullf 1} FrulF 0 Frully a Frullf 72
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720 o Frull§ 1} FrulF 1} Frully a Frullf 72
T2 ] Frullg ] Frulg ] Frlls 0 Frllh 72
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Figure 383. Table showing customers with null values

At the bottom of the table are customers with predicted null values. These are customers whose total
tenure (future time + tenure) falls beyond the range of survival times in the data used to train the model.

Summary

Using Cox regression, you have found an acceptable model for the time to churn, plotted the expected
number of customers retained over the next two years, and identified the individual customers most
likely to churn in the next year. Note that while this is an acceptable model, it may not be the best model.
Ideally you should at least compare this model, obtained using the Forward stepwise method, with one
created using the Backward stepwise method.

Explanations of the mathematical foundations of the modeling methods used in IBM SPSS Modeler are
listed in the IBM SPSS Modeler Algorithms Guide.
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Chapter 27. Market Basket Analysis (Rule Induction/C5.0)

This example deals with fictitious data describing the contents of supermarket baskets (that is, collections
of items bought together) plus the associated personal data of the purchaser, which might be acquired
through a loyalty card scheme. The goal is to discover groups of customers who buy similar products
and can be characterized demographically, such as by age, income, and so on.

This example illustrates two phases of data mining:
* Association rule modeling and a web display revealing links between items purchased
* (5.0 rule induction profiling the purchasers of identified product groups

Note: This application does not make direct use of predictive modeling, so there is no accuracy
measurement for the resulting models and no associated training/test distinction in the data mining
process.

This example uses the stream named baskrule, which references the data file named BASKETS1n. These
files are available from the Demos directory of any IBM SPSS Modeler installation. This can be accessed
from the IBM SPSS Modeler program group on the Windows Start menu. The baskrule file is in the streams
directory.

Accessing the Data

Using a Variable File node, connect to the dataset BASKETS1n, selecting to read field names from the file.
Connect a Type node to the data source, and then connect the node to a Table node. Set the measurement
level of the field cardid to Typeless (because each loyalty card ID occurs only once in the dataset and can
therefore be of no use in modeling). Select Nominal as the measurement level for the field sex (this is to
ensure that the Apriori modeling algorithm will not treat sex as a flag).

—O ==

—_— | [EE
BASKETS1n tvpe table

—> —> —>
—> —> —>
= Gy "

ﬁ @ healthy wine_chocs beer_belns_pia{a
11 Fields g
11 fields = ' @
. -E-> —_— o
. -A> D
5.00
% y type ‘be’er_beans_pia{a
11 fields i .’

5.0

heer_heans_pizza
Figure 384. baskrule stream

Now run the stream to instantiate the Type node and display the table. The dataset contains 18 fields,
with each record representing a basket.
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The 18 fields are presented in the following headings.

Basket summary:

* cardid. Loyalty card identifier for customer purchasing this basket.
* walue. Total purchase price of basket.

* pmethod. Method of payment for basket.

Personal details of cardholder:

*  sex

*  homeown. Whether or not cardholder is a homeowner.
* income

> age

Basket contents—flags for presence of product categories:
> fruitveg

* freshmeat

s dairy

* cannedveg

* cannedmeat

*  frozenmeal

*  Dbeer

*  wine

* softdrink
* fish

* confectionery

Discovering Affinities in Basket Contents

First, you need to acquire an overall picture of affinities (associations) in the basket contents using
Apriori to produce association rules. Select the fields to be used in this modeling process by editing the
Type node and setting the role of all of the product categories to Both and all other roles to None. (Both
means that the field can be either an input or an output of the resultant model.)

Note: You can set options for multiple fields using Shift-click to select the fields before specifying an

option from the columns.
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Figure 385. Selecting fields for modeling

Once you have specified fields for modeling, attach an Apriori node to the Type node, edit it, select the
option Only true values for flags, and click run on the Apriori node. The result, a model on the Models
tab at the upper right of the managers window, contains association rules that you can view by using the
context menu and selecting Browse.
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Figure 386. Association rules

These rules show a variety of associations between frozen meals, canned vegetables, and beer. The
presence of two-way association rules, such as:

frozenmeal -> beer
beer -> frozenmeal
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suggests that a web display (which shows only two-way associations) might highlight some of the
patterns in this data.

Attach a Web node to the Type node, edit the Web node, select all of the basket contents fields, select
Show true flags only, and click run on the Web node.
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Figure 387. Web display of product associations

Because most combinations of product categories occur in several baskets, the strong links on this web
are too numerous to show the groups of customers suggested by the model.
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Figure 388. Restricted web display

1. To specify weak and strong connections, click the yellow double arrow button on the toolbar. This
expands the dialog box showing the web output summary and controls.

2. Select Size shows strong/normal/weak.
3. Set weak links below 90.
4. Set strong links above 100.

In the resulting display, three groups of customers stand out:

* Those who buy fish and fruits and vegetables, who might be called "healthy eaters"
* Those who buy wine and confectionery

* Those who buy beer, frozen meals, and canned vegetables ("beer, beans, and pizza")

Profiling the Customer Groups

You have now identified three groups of customers based on the types of products they buy, but you
would also like to know who these customers are--that is, their demographic profile. This can be
achieved by tagging each customer with a flag for each of these groups and using rule induction (C5.0) to
build rule-based profiles of these flags.

First, you must derive a flag for each group. This can be automatically generated using the web display

that you just created. Using the right mouse button, click the link between fruitveg and fish to highlight it,
then right-click and select Generate Derive Node For Link.
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Figure 389. Deriving a flag for each customer group

Edit the resulting Derive node to change the Derive field name to healthy. Repeat the exercise with the
link from wine to confectionery, naming the resultant Derive field wine_chocs.

For the third group (involving three links), first make sure that no links are selected. Then select all three
links in the cannedveg, beer, and frozenmeal triangle by holding down the shift key while you click the left
mouse button. (Be sure you are in Interactive mode rather than Edit mode.) Then from the web display
menus choose:

Generate > Derive Node ("And")
Change the name of the resultant Derive field to beer_beans_pizza.

To profile these customer groups, connect the existing Type node to these three Derive nodes in series,
and then attach another Type node. In the new Type node, set the role of all fields to None, except for
value, pmethod, sex, homeown, income, and age, which should be set to Input, and the relevant customer
group (for example, beer_beans_pizza), which should be set to Target. Attach a C5.0 node, set the Output
type to Rule set, and click run on the node. The resultant model (for beer_beans_pizza) contains a clear
demographic profile for this customer group:

Rule 1 for T:

if sex = M

and income <= 16,900
then T

The same method can be applied to the other customer group flags by selecting them as the output in the
second Type node. A wider range of alternative profiles can be generated by using Apriori instead of C5.0
in this context; Apriori can also be used to profile all of the customer group flags simultaneously because
it is not restricted to a single output field.
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Summary

This example reveals how IBM SPSS Modeler can be used to discover affinities, or links, in a database,

both by modeling (using Apriori) and by visualization (using a web display). These links correspond to
groupings of cases in the data, and these groups can be investigated in detail and profiled by modeling
(using C5.0 rule sets).

In the retail domain, such customer groupings might, for example, be used to target special offers to

improve the response rates to direct mailings or to customize the range of products stocked by a branch
to match the demands of its demographic base.
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Chapter 28. Assessing New Vehicle Offerings (KNN)

Nearest Neighbor Analysis is a method for classifying cases based on their similarity to other cases. In
machine learning, it was developed as a way to recognize patterns of data without requiring an exact
match to any stored patterns, or cases. Similar cases are near each other and dissimilar cases are distant
from each other. Thus, the distance between two cases is a measure of their dissimilarity.

Cases that are near each other are said to be “neighbors.” When a new case (holdout) is presented, its
distance from each of the cases in the model is computed. The classifications of the most similar cases —
the nearest neighbors — are tallied and the new case is placed into the category that contains the greatest
number of nearest neighbors.

You can specify the number of nearest neighbors to examine; this value is called k. The pictures show
how a new case would be classified using two different values of k. When k = 5, the new case is placed
in category 1 because a majority of the nearest neighbors belong to category 1. However, when k = 9, the
new case is placed in category 0 because a majority of the nearest neighbors belong to category 0.

Nearest neighbor analysis can also be used to compute values for a continuous target. In this situation,
the average or median target value of the nearest neighbors is used to obtain the predicted value for the
new case.

An automobile manufacturer has developed prototypes for two new vehicles, a car and a truck. Before
introducing the new models into its range, the manufacturer wants to determine which existing vehicles
on the market are most like the prototypes--that is, which vehicles are their "nearest neighbors", and
therefore which models they will be competing against.

The manufacturer has collected data about the existing models under a number of categories, and has
added the details of its prototypes. The categories under which the models are to be compared include
price in thousands (price), engine size (engine_s), horsepower (horsepow), wheelbase (wheelbas), width
(width), length (length), curb weight (curb_wgt), fuel capacity (fuel_cap) and fuel efficiency (mpg).

This example uses the stream named car_sales_knn.str, available in the Demos folder under the streams
subfolder. The data file is car_sales_knn_mod.sav. See the topic [“Demos Folder” on page 4 for more
information.

Creating the Stream

—» @) —» (e

car_sales_knn_mod. sa.. Tyne Mo Targets
+
1
R
’
= =
o 4
Tahble Mo Targets

Figure 390. Sample stream for KNN modeling
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Create a new stream and add a Statistics File source node pointing to car_sales_knn_mod.sav in the Demos
folder of your IBM SPSS Modeler installation.

First, let's see what data the manufacturer has collected.

1. Attach a Table node to the Statistics File source node.
2. Open the Table node and click Run.
[ Table (16 fields. 159 records) . |[=] 3
| File 5 Edt £ Generate
| Table || Annctations

manufact |model |sales |resale |type |pric:e |engine_s harzepow | wheelbas |Widlh |
140 Toyota (Celca 33260 15445 00. 16.. 1800 140000 (02400 6.3 |=|
141 Toyota  Tacoma 84087 9575 1.0..11.. 2400 142000 103300 66.5.
142 Toyota  Sienna 65118 §nul§ 10.. 22 3000 194000 114200 [73.4.
143 Toyota  RAW4 25108 13325 1.0..16.. 2000 127000 (34900  66.7..
144 Toyota  4Run.. BE.411 1942510, 22 2700 150000 105300 [B6.5.
145 Toyota  Land.. 9535 34080 10.. 5. 4700 230000 (12200 [76.4..
145 Vaksw .. Galf 9761 1142500 14.. 2000 115000 |98900 6.3
147 Woksw .. Jefta  @3721 1324000, 16.. 2000 115000 (38800 6.
143 Valkswe .. Passat 51102 16725 00..21.. 1800 150000 106400 |BG.5.
149 Volkew .. Cebrio 9589 16575 00..19.. 2000 115000 97400  B6.7.
150 Vaksw.. GTl 5506 13760 00..17.. 2000 115000 |98900  |6&.3.
151 Voksw . Beefle 40463 $nul§ 00 15.. 2000 115000 |9&900 670
152 Valvo 540 16957 §nul§ 00..23.. 1900 160000 1100500 676
153 Wolvo w40 3545 §nul§ 0024 1800 160000 [00S00 BT
154 Valvo 570 15245 §nul§ 00, 27.. 2400 163000 104900 693
155 Wolvo  WPOD 17531 §nul§ 00 28 2400 163000 04900 B9
156 Voo  (C70 (3493 $nul§ 00..45.. 2300 236000 104900 715
157 Wolvo S0 18963 §nul§ 00 36.. 2900 201000 [09g00 721
158 newC.. $nulls Fnuls $n.. 21... 1500 76000 106300 E79..
159 newT . Fnulls Snuls $no 34 3500 1ETODD 109800 752 (%

S — [+]

Figure 391. Source data for cars and trucks

326

The details for the two prototypes, named newCar and newTruck, have been added at the end of the
file.

We can see from the source data that the manufacturer is using the classification of "truck" (value of
1 in the type column) rather loosely to mean any non-automobile type of vehicle.

The last column, partition, is necessary in order that the two prototypes can be designated as
holdouts when we come to identify their nearest neighbors. In this way, their data will not influence
the calculations, as it is the rest of the market that we want to consider. Setting the partition value of
the two holdout records to 1, while all the other records have a 0 in this field, enables us to use this
field later when we come to set the focal records--the records for which we want to calculate the
nearest neighbors.

Leave the table output window open for now, as we'll be referring to it later.
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Figure 392. Type node settings

3. Add a Type node to the stream.
4. Attach the Type node to the Statistics File source node.
5. Open the Type node.

We want to make the comparison only on the fields price through mpg, so we'll leave the role for all

these fields set to Input.

Click Read Values to read the data values into the stream.
Click OK.

© o N
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Set the role for all the other fields (manufact through type, plus Insales) to None.

Set the measurement level for the last field, partition, to Flag. Make sure that its role is set to Input.
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Figure 393. Choosing to identify the nearest neighbors

10. Attach a KNN node to the Type node.
11. Open the KNN node.

We're not going to be predicting a target field this time, because we just want to find the nearest
neighbors for our two prototypes.

12. On the Objectives tab, choose Only identify the nearest neighbors.
13. Click the Settings tab.
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Figure 394. Using the patrtition field to identify the focal records

Now we can use the partition field to identify the focal records--the records for which we want to

identify the nearest neighbors. By using a flag field, we ensure that records where the value of this
field is set to 1 become our focal records.

As we've seen, the only records that have a value of 1 in this field are newCar and newTruck, so these
will be our focal records.

14.

On the Model panel of the Settings tab, select the Identify focal record check box.

15. From the drop-down list for this field, choose partition.
16. Click the Run button.
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Examining the Output
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Figure 395. The Model Viewer window

A model nugget has been created on the stream canvas and in the Models palette. Open either of the
nuggets to see the Model Viewer display, which has a two-panel window:
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The first panel displays an overview of the model called the main view. The main view for the Nearest

Neighbor model is known as the predictor space.

The second panel displays one of two types of views:
An auxiliary model view shows more information about the model, but is not focused on the model

itself.

A linked view is a view that shows details about one feature of the model when you drill down on

part of the main view.

IBM SPSS Modeler 17.1 Applications Guide



Predictor Space

Predictor Space
Built Model: 3 selected predictors, K =3

Focal
) e @®nNo
L S R ®ves
T e ) E - | E
i S Type
6 ! \ e
& "ty @ Training
:5— - | : & Holdout
= I
£ 4 - ;
= '
o 1
& i 2
: i =]
il I M
174 5
7
Q

8o . : oo 10
L 8n 300 2
ho"’&;%"@%w 400 m‘“wwer

This chart is a lower-dimensional projection of the predictor space,
which contains a total of 9 predictors.

Figure 396. Predictor space chart

The predictor space chart is an interactive 3-D graph that plots data points for three features (actually the
first three input fields of the source data), representing price, engine size and horsepower.

Our two focal records are highlighted in red, with lines connecting them to their k nearest neighbors.

By clicking and dragging the chart, you can rotate it to get a better view of the distribution of points in
the predictor space. Click the Reset button to return it to the default view.
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Figure 397. Peers chart

The default auxiliary view is the peers chart, which highlights the two focal records selected in the
predictor space and their k nearest neighbors on each of six features--the first six input fields of the
source data.

The vehicles are represented by their record numbers in the source data. This is where we need the
output from the Table node to help identify them.

If the Table node output is still available:
1. Click the Outputs tab of the manager pane at the top right of the main IBM SPSS Modeler window.
2. Double-click the entry Table (16 fields, 159 records).
If the table output is no longer available:
3. On the main IBM SPSS Modeler window, open the Table node.
4. Click Run.
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Figure 398. Identifying records by record number

Scrolling down to the bottom of the table, we can see that newCar and newTruck are the last two

records in the data, numbers 158 and 159 respectively.
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Figure 399. Comparing features on the peers chart

From this we can see on the peers chart, for example, that newTruck (159) has a bigger engine size
than any of its nearest neighbors, while newCar (158) has a smaller engine than any of ifs nearest

neighbors.

For each of the six features, you can move the mouse over the individual dots to see the actual value

of each feature for that particular case.
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But which vehicles are the nearest neighbors for newCar and newTruck?

The peers chart is a little bit crowded, so let's change to a simpler view.
5. Click the View drop-down list at the bottom of the peers chart (the entry that currently says Peers).
6. Select Neighbor and Distance Table.

Neighbor and Distance Table

k Nearest Neighbors and Distances

Displayed for Initial Focal Records

Nearest Neighbors Nearest Distar
Focal Record
2 3 1 2
158 13 130 58 0.878 0.990
159 105 92 101 0.580 0634

Figure 400. Neighbor and distance table

That's better. Now we can see the three models to which each of our two prototypes are closest in the
market.

For newCar (focal record 158) they are the Saturn SC (131), the Saturn SL (130), and the Honda Civic (58).

No great surprises there--all three are medium-size saloon cars, so newCar should fit in well, particularly
with its excellent fuel efficiency.

For newTruck (focal record 159), the nearest neighbors are the Nissan Quest (105), the Mercury Villager
(92), and the Mercedes M-Class (101).

As we saw earlier, these are not necessarily trucks in the traditional sense, but simply vehicles that are
classed as not being automobiles. Looking at the Table node output for its nearest neighbors, we can see
that newTruck is relatively expensive, as well as being one of the heaviest of its type. However, fuel
efficiency is again better than its closest rivals, so this should count in its favor.

Summary

We've seen how you can use nearest-neighbor analysis to compare a wide-ranging set of features in cases
from a particular data set. We've also calculated, for two very different holdout records, the cases that
most closely resemble those holdouts.

334 1BM SPSS Modeler 17.1 Applications Guide



Chapter 29. Uncovering causal relationships in business
metrics (TCM)

A business tracks various key performance indicators that describe the financial state of the business over
time, and they also track a number of metrics that they can control. They are interested in using temporal
causal modeling to uncover causal relationships between the controllable metrics and the key
performance indicators. They would also like to know about any causal relationships among the key
performance indicators.

The data file tcm_kpi.sav contains weekly data on the key performance indicators and the controllable
metrics. Data for the key performance indicators is stored in fields with the prefix KPI. Data for the
controllable metrics is stored in fields with the prefix Lever.

Creating the stream

L -@- T

-E-> L 2kls

+ _‘_’ 4 A 5
tcm_ti.sau Type TGM

EEEE T

Table TCM
Figure 401. Sample stream for TCM modeling

1. Create a new stream and add a Statistics File source node pointing to tcm_kpi.sav in the Demos folder
of your IBM SPSS Modeler installation.

2. Attach a Table node to the Statistics File source node.

3. Open the Table node and click Run to take a look at the data. It contains weekly data on the key
performance indicators and the controllable metrics. Data for the key performance indicators is stored
in fields with the prefix KPI, and data for the controllable metrics is stored in fields with the prefix
Lever.
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Figure 402. Source data for key performance indicators and controllable metrics

4. Add a Type node to the stream.
5. Attach the Type node to the Statistics File source node.

Running the analysis

1. Attach a TCM node to the Type node, then open the TCM node and go to the Observations section of
the Fields tab.
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Figure 403. Temporal Causal Modeling, observations

2. Select date from the Date/time field and select Weeks from the Time interval field.

3. Click Time Series and select Use predefined roles.

In the sample data set tcm_kpi.sav, the fields Leverl through Lever5 have the role of Input and KPI_1
through KPI_25 have the role of Both. When Use predefined roles is selected, fields with a role of
Input are treated as candidate inputs and fields with a role of Both are treated as both candidate

inputs and targets for temporal causal modeling.

The temporal causal modeling procedure determines the best inputs for each target from the set of
candidate inputs. In this example, the candidate inputs are the fields Leverl through Lever5 and the

fields KPI_1 through KPI_25.
4. Click Run.

Chapter 29. Uncovering causal relationships in business metrics (TCM)
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Overall Model Quality Chart

The Overall Model Quality output item, which is generated by default, displays a bar chart and an
associated dot plot of the model fit for all models. There is a separate model for each target series. The
model fit is measured by the chosen fit statistic. This example uses the default fit statistic, which is R
Square.

The Overall Model Quality item contains interactive features. To enable the features, activate the item by
double-clicking the Overall Model Quality chart in the Viewer.

Interactive Output - Overall Model Quality | = e

File Edit Help
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Figure 404. Overall Model Quality

Clicking a bar in the bar chart filters the dot plot so that it displays only the models that are associated
with the selected bar. Hovering over a dot in the dot plot displays a tooltip that contains the name of the
associated series and the value of the fit statistic. You can find the model for a particular target series in
the dot plot by specifying the series name in the Find model for target box.
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Overall Model System

The Overall Model System output item, which is generated by default, displays a graphical
representation of the causal relations between series in the model system. By default, relations for the top
10 models are shown, as determined by the value of the R Square fit statistic. The number of top models
(also referred to as best-fitting models) and the fit statistic are specified on the Series to Display settings
(on the Build Options tab) of the Temporal Causal Modeling dialog.

The Overall Model System item contains interactive features. To enable the features, activate the item by
double-clicking the Overall Model System chart in the Viewer. In this example, it is most important to see
the relations between all series in the system. In the interactive output, select All series from the
Highlight relations for drop-down list.
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File Edit View Help
Highlight relations fol o1 Hide links with significance value greater than:
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Figure 405. Overall Model System, view for all series

All lines that connect a particular target to its inputs have the same color, and the arrow on each line
points from an input to the target of that input. For example, Lever3 is an input to KPI_19.

The thickness of each line indicates the significance of the causal relation, where thicker lines represent a
more significant relation. By default, causal relations with a significance value greater than 0.05 are
hidden. At the 0.05 level, only Leverl, Lever3, Lever4, and Lever5 have significant causal relations with the
key performance indicator fields. You can change the threshold significance level by entering a value in
the field that is labeled Hide links with significance value greater than.

In addition to uncovering causal relations between Lever fields and key performance indicator fields, the
analysis also uncovered relations among the key performance indicator fields. For example, KPI_10 was
selected as an input to the model for KPI_2.

Chapter 29. Uncovering causal relationships in business metrics (TCM) 339



You can filter the view to show only the relations for a single series. For example, to view only the
relations for KPI_19, click the label for KPI_19, right-click, and select Highlight relations for series.
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Highlight relations far ;Single series = ‘ Series name: |KPI_19 .o Hide links with significance value greater than
1 I
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Figure 406. Overall Model System, view for single series

This view shows the inputs to KPI_19 that have a significance value less than or equal to 0.05. It also
shows that, at the 0.05 significance level, KPI_19 was selected as an input to both KPI_18 and KPI_7.

In addition to displaying the relations for the selected series, the output item also contains information
about any outliers that were detected for the series. Click the Series with Outliers tab.

Series with Outliers for KPI_19

Series Time Observed Value
KPI_19 | 2008-10-12 7,358,201 .68
2009-04-05 2.10E+007
2010-09-19 6,492 167.97

Figure 407. Outliers for KPI_19

Three outliers were detected for KPI_19. Given the model system, which contains all of the discovered
connections, it is possible to go beyond outlier detection and determine the series that most likely causes
a particular outlier. This type of analysis is referred to as outlier root cause analysis and is covered in a
later topic in this case study.

Impact Diagrams

You can obtain a complete view of all relations that are associated with a particular series by generating
an impact diagram. Click the label for KPI_19 in the Overall Model System chart, right-click, and select
Create Impact Diagram.

340 1BM SPSS Modeler 17.1 Applications Guide



Interactive Qutput - Impact Diagram i@

Eile Edit \View Help

Series ofinterest: |KPI_19 ¥ | Show: Mumber of levels to display:

Impact Diagram

-

-

N

M,

-

6
Lo LU
it

-
2

<

Figure 408. Impact Diagram of effects

When an impact diagram is created from the Overall Model System, as in this example, it initially shows
the series that are affected by the selected series. By default, impact diagrams show three levels of effects,
where the first level is just the series of interest. Each additional level shows more indirect effects of the
series of interest. You can change the value of the Number of levels to display to show more or fewer
levels of effects. The impact diagram for this example shows that KPI_19 is a direct input to both KPI_18
and KPI_7, but it indirectly affects a number of series through its effect on series KPI_7. As in the overall
model system, the thickness of the lines indicates the significance of the causal relations.

The chart that is displayed in each node of the impact diagram shows the last L+1 values of the
associated series at the end of the estimation period and any forecast values, where L is the number of
lag terms that are included in each model. You can obtain a detailed sequence chart of these values by
single-clicking the associated node.

Double-clicking a node sets the associated series as the series of interest, and regenerates the impact
diagram based on that series. You can also specify a series name in the Series of interest box to select a

different series of interest.

Impact diagrams can also show the series that affect the series of interest. These series are referred to as
causes. To see the series that affect KPI_19, select Causes of series from the Show drop-down.
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Figure 409. Impact Diagram of causes

This view shows that the model for KPI_19 has four inputs and that Lever3 has the most significant
causal connection with KPI_19. It also shows series that indirectly affect KPI_19 through their effects on
KPI_7 and KPI_17. The same concept of levels that was discussed for effects also applies to causes.
Likewise, you can change the value of the Number of levels to display to show more or fewer levels of
causes.

Determining root causes of outliers

Given a temporal causal model system, it is possible to go beyond outlier detection and determine the
series that most likely causes a particular outlier. This process is referred to as outlier root cause analysis
and must be requested on a series by series basis. The analysis requires a temporal causal model system
and the data that was used to build the system. In this example, the active dataset is the data that was
used to build the model system.

To run outlier root cause analysis:

1. In the TCM dialog, go to the Build Options tab and then click Series to Display in the Select an item
list.
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Figure 410. Temporal Causal Model Series to Display

2. Move KPI_19 to the Fields to display list.
3. Click Output options in the Select an item list on the Options tab.
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Figure 411. Temporal Causal Model Output Options

4. Deselect Overall model system, Same as for targets, R square, and Series transformations.

Click Run.

N oo
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Select Outlier root cause analysis and keep the existing settings for Output and Causal levels.

Double-click the Outlier Root Cause Analysis chart for KPI_19 in the Viewer to activate it.
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Figure 412. Outlier Root Cause Analysis for KPI_19

The results of the analysis are summarized in the Outliers table. The table shows that root causes were
found for the outliers at 2009-04-05 and 2010-09-19, but no root cause was found for the outlier at
2008-10-12. Clicking a row in the Outliers table highlights the path to the root cause series, as shown here
for the outlier at 2009-04-05. This action also highlights the selected outlier in the sequence chart. You can
also click the icon for an outlier directly in the sequence chart to highlight the path to the root cause
series for that outlier.

For the outlier at 2009-04-05, the root cause is Lever3. The diagram shows that Lever3 is a direct input to
KPI_19, but that it also indirectly influences KPI_19 through its effect on other series that affect KPI_19.
One of the configurable parameters for outlier root cause analysis is the number of causal levels to search
for root causes. By default, three levels are searched. Occurrences of the root cause series are displayed
up to the specified number of causal levels. In this example, Lever3 occurs at both the first causal level
and the third causal level.

Each node in the highlighted path for an outlier contains a chart whose time range depends on the level
at which the node occurs. For nodes in the first causal level, the range is T-1 to T-L where T is the time at
which the outlier occurs and L is the number of lag terms that are included in each model. For nodes in
the second causal level, the range is T-2 to T-L-1; and for the third level the range is T-3 to T-L-2. You can
obtain a detailed sequence chart of these values by single-clicking the associated node.
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Running scenarios

Given a temporal causal model system, you can run user-defined scenarios. A scenario is defined by a
time series, that is referred to as the root series, and a set of user-defined values for that series over a
specified time range. The specified values are then used to generate predictions for the time series that
are affected by the root series. The analysis requires a temporal causal model system and the data that
was used to build the system. In this example, the active dataset is the data that was used to build the

model system.

To run scenarios:
1. In the TCM output dialog, click the Scenario Analysis button.
2. In the Temporal Causal Model Scenarios dialog, click Define Scenario Period.

o

I\} Scenario Period @

Model Sy=tem Estimation Period

Date |
Start 2008-09-07
End 2010-10-24

Time interval: Weeks

Time Period for Scenarios

(Z) Specify by start, end and predict through times

Date
Start of scenario values yyyy-Mi-dd
End of scenario values yyyy-Mi-dd
Predict through yyyy-MM-dd

@ Specify by time intervals relative to end of estimation period

Starting interval of scenario values:
Ending interval of scenario values: D
[ |

Intervals to predict past end of scenario values: ﬂ

.i.q. The end of the estimation period is time interval 0. Time intervals prior to the end of the
estimation period have negative values and intervals after the end of the estimation period

=
have positive values.

[Cunﬂnue][ Cancel ][ ] Help]

Figure 413. Scenario Period

3. Select Specify by time intervals relative to end of estimation period.
4. Enter -3 for the starting interval and enter 0 for the ending interval.
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These settings specify that each scenario is based on values that are specified for the last four time
intervals in the estimation period. For this example, the last four time intervals means the last four
weeks. The time range over which the scenario values are specified is referred to as the scenario
period.

5. Enter 4 for the intervals to predict past the end of the scenarios values.

This setting specifies that predictions are generated for four time intervals beyond the end of the
scenario period.

6. Click Continue.
7. Click Add Scenario on the Scenarios tab.
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Figure 414. Scenario Definition

8. Move Lever3 to the Root Field box to examine how specified values of Lever3 in the scenario period
affect predictions of the other series that are causally affected by Lever3.

9. Enter Lever3 25pct for the scenario ID.

10. Select Specify expression for scenario values for root field and enter Lever3*1.25 for the
expression.

This setting specifies that the values for Lever3 in the scenario period are 25% larger than the
observed values. For more complex expressions, you can use the Expression Builder by clicking the
calculator icon.

11. Click Continue.
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12. Repeat steps 10 - 14 to define a scenario that has Lever3 for the root field, Lever3_50pct for the

scenario ID, and Lever3x1.5 for the expression.

\) Temporal Causal Model Scenarios

Scenarios | Options

Scenario Period

-
L)
:‘._ The time period over which scenarios are carried out must be defined before scenarios can be created.

Define Scenario Period

Scenarios:
Scenario ID Root field Scenario values
Lever3_25pct Leverd Lever3*1.25
Lever3_50pct Lever3 Lever3*1.5

[ Run ][ Reset ][ Cancel ][9 Help]

Figure 415. Scenarios

13. Click the Options tab and enter 2 for the maximum level for affected targets.

14. Click Run.

15. Double-click the Impact Diagram chart for Lever3_50pct in the Viewer to activate it.
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KPI_1 0.44 0.66 0.78 0.86 0.87 0.83
KPI_15 2,344.83 1,650.98 2,031.42 1,846.30 1,761.74 1,692.52 1,736.83
KPI_7 4547110 34,211.70 36,880.87 35,546.03 32,341.09 29,899.71

KPI_9 88.26 112.99 §9.50 9216 102.76 90.95 105.39 —

Figure 416. Impact Diagram for Scenario: Lever3_50pct
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The Impact Diagram shows the series that are affected by the root series Lever3. Two levels of effects
are shown because you specified 2 for the maximum level for affected targets.

The Forecasted Values table includes the predictions for all of the series that are affected by Lever3,
up to the second level of effects. Predictions for target series in the first level of effects start at the
first time period after the beginning of the scenario period. In this example, predictions for target
series in the first level start at 2010-10-10. Predictions for target series in the second level of effects
start at the second time period after the beginning of the scenario period. In this example,
predictions for target series in the second level start at 2010-10-17. The staggered nature of the
predictions reflects the fact that the time series models are based on lagged values of the inputs.

Click the node for KPI_5 to generate a detailed sequence diagram.
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Figure 417. Sequence Diagram for KPI_5

The sequence chart shows the predicted values from the scenario, and it also shows the values of the
series in the absence of the scenario. When the scenario period contains times within the estimation

period, the observed values of the series are shown. For times beyond the end of the estimation

period, the original forecasts are shown.
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Notices

This information was developed for products and services offered worldwide.

IBM may not offer the products, services, or features discussed in this document in other countries.
Consult your local IBM representative for information on the products and services currently available in
your area. Any reference to an IBM product, program, or service is not intended to state or imply that
only that IBM product, program, or service may be used. Any functionally equivalent product, program,
or service that does not infringe any IBM intellectual property right may be used instead. However, it is
the user's responsibility to evaluate and verify the operation of any non-IBM product, program, or
service.

IBM may have patents or pending patent applications covering subject matter described in this
document. The furnishing of this document does not grant you any license to these patents. You can send
license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
US.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property
Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.

1623-14, Shimotsuruma, Yamato-shi
Kanagawa 242-8502 Japan

The following paragraph does not apply to the United Kingdom or any other country where such
provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION
PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some
states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this
statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in
any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of

the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without
incurring any obligation to you.
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Licensees of this program who want to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this
one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Software Group
ATTN: Licensing
200 W. Madison St.
Chicago, IL; 60606
US.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases,
payment of a fee.

The licensed program described in this document and all licensed material available for it are provided
by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or
any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the
results obtained in other operating environments may vary significantly. Some measurements may have
been made on development-level systems and there is no guarantee that these measurements will be the
same on generally available systems. Furthermore, some measurements may have been estimated through
extrapolation. Actual results may vary. Users of this document should verify the applicable data for their
specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their
published announcements or other publicly available sources. IBM has not tested those products and
cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM
products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of
those products.

All statements regarding IBM's future direction or intent are subject to change or withdrawal without
notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To illustrate
them as completely as possible, the examples include the names of individuals, companies, brands, and
products. All of these names are fictitious and any similarity to the names and addresses used by an
actual business enterprise is entirely coincidental.

If you are viewing this information softcopy, the photographs and color illustrations may not appear.

Trademarks

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of International Business
Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be
trademarks of IBM or other companies. A current list of IBM trademarks is available on the Web at
"Copyright and trademark information" at www.ibm.com/legal/copytrade.shtml.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo, Celeron, Intel Xeon,
Intel SpeedStep, Itanium, and Pentium are trademarks or registered trademarks of Intel Corporation or its
subsidiaries in the United States and other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the

United States, other countries, or both.
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UNIX is a registered trademark of The Open Group in the United States and other countries.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or
its affiliates.

Other product and service names might be trademarks of IBM or other companies.
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